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Basic Elements of 
Drawing1

Unit SPECiFiCS
This unit elaborately discusses the following topics:

•	 Drawing Instruments and supporting materials
•	 Convention of lines and their applications
•	 Engineering scale
•	 Dimensioning techniques
•	 Geometrical and tangency constructions

The understanding of these topics will be developed after reading the contents, completing the solved 
problems, activities, performing exercises and viewing the ICT and web resources mentioned in this 
unit.

At the end of the unit, summary is provided to recapitulate the topics covered and applications 
are mentioned so that the learner can correlate the presented knowledge with real life and industrial 
situations. Few activities are mentioned to create inquisitiveness and curiosity in the learner. Subjective 
and objective questions are provided for the reinforcement of the knowledge and a list of references 
and suggested readings is also provided for further learning. Video resources along with QR codes 
are mentioned for getting more information on various topics of interest which can be surfed or 
scanned through mobile phone for viewing. Practical with details are provided to horn the drawing 
and drafting skills.

RationalE
Engineering drawing is a language of engineers that enables them to visualize the ideas converting to 
realization by drawing them. It is a graphical language that communicates all the information about 
an object from an engineer, who designed it, to an artisan who will make it. In engineering drawing, 
the figures are drawn by using straight and curved lines to represent the surfaces, edges and centres 
of objects. Symbols,  dimensional values and text are added to these lines so that they collectively 
make the complete drawing description. The drafting is the preparation of these drawing manually  
or with the help of drawing instruments. 

The aim of this unit is to introduce you with some of the most common drawing equipment 
that you need for your drawing work. Besides owing a right type of drawing equipment, it is also 
important to understand the correct techniques of using and handling the instruments, line types, 
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dimensioning  methods and to prepare drawings to suitable engineering scales as recommended by 
the BIS.

The Bureau of Indian Standards (BIS) is the national standards body of India working under 
the support of Ministry of Consumer Affairs, Food and Public Distribution, Government of India. It 
is established by the Bureau of Indian Standards Act,1986 which came into effect on 23 December 
1986. It was formerly known as the Indian Standards Institutions(ISI). Bureau of Indian Standards 
"SP 46:2003 Engineering Drawing Practices for School and Colleges" provides you a set of rules and 
codes for engineering drawing. BIS has developed this standard code of practice to maintain uniform 
standard of engineering drawing throughout the country.

PRE-REqUiSitES
Before reading this unit the student is advised to revisit following:

•	 Maths: Coordinate and Plane geometry

Unit oUtComES
After reading the contents, completing the solved problems, activities, exercises and viewing the ICT 
& web resources mentioned in this unit, the students are expected to: 

U1-O1:  Use various drafting equipment and instruments for manual drafting
U1-O2:  Use different types of lines in technical drawing as per BIS Codes
U1-O3:  Use concept of engineering scale to solve engineering drawing problems
U1-O4:  Apply dimensions to technical drawing in accordance with BIS standards
U1-O5:  Construct the various geometrical shapes

Unit-1
outcome

EXPECtED maPPinG WitH CoURSE oUtComES
(1- Weak Correlation; 2- Medium Correlation; 3- Strong Correlation)

Co-1 Co-2 Co-3 Co-4 Co-5 Co-6

U1-o1 3 2 3 3 2 -

U1-o2 3 3 3 2 3 2

U1-o3 3 1 2 2 2 1

U1-o4 2 3 3 2 3 2

U1-o5 3 2 2 2 2 2

1.1 DRaWinG inStRUmEntS anD SUPPoRtinG matERialS

1.1.1 introduction
Drawing is a graphic language of engineers and technicians. Therefore, it should be taught as any other 
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language. Every language has its own rules. Similarly, in case of engineering drawing, it is necessary 
to use instruments correctly in order to get the required degree of accuracy.

The aim of this section is to introduce you with some of the most common drawing equipment 
that you need for your drawing work. Besides owing a right type of drawing equipment, it is also 
important to know the correct techniques of using and handling the instruments. The Bureau of 
Indian Standards (BIS) is the national standards body of India provides you a set of rules and standard 
code of practice to maintain the uniform standard of engineering drawing throughout the country. 

1.1.2  Drawing Equipment
Engineering drawing is a graphical language wherein information is recorded with the help of drawing 
equipment and instruments. A student has to be conversant with all drawing instruments, to enable 
him to select and use suitable instruments as per the situations. It is also important to follow certain 
rules and a code of practice for making a presentable and accurate drawing. Accuracy of drawings 
largely depend on the quality of instruments. Following is the list of common drawing equipment 
and instruments for preparing drawings.

1. Drawing board 
2. T-square 
3. Mini-drafter 
4. Pairs of set squares/triangles
5. Drawing instrument box containing: Divider; Compass with interchangeable pencil and pen 

legs; Bow pencil; Bow pen; Bow divider; Lengthening bar; Inking pen; Box of leads; Screw driver
6. Protractor (circular or semi-circular) 
7. Drawing pencil 
8. Drawing paper
9. Pencil pointer
10. Drawing clips 
11. Dusting cloth 
12. Rubber/Eraser
13. Erasing shield 
14. Roll-n-draw 

Drawing board 
Drawing Board is a flat, rectangular surface used for sketching, drawing, writing, etc. The surface of 
the board must be smooth and soft so that pencils can easily draw lines. The drawing board as 
shown in Fig.1.1 is required to prepared from best seasoned, good quality wood (white pine, masonite 
etc.) and are fitted with battens at back with brass round slots for expansion and contraction. The 
ebony edges are fitted on one edge and are saw cut to allow expansion and contraction. The left hand 
edge of the board is called the working edge because the T-square head slides against it, as shown in 
Fig.1.2. It is generally placed on drawing table at an angle of 200. The standard sizes of the drawing 
boards as recommended by BIS are shown in Table 1.1. 

The length of drawing boards varies from 1500 mm - 500 mm, width ranges from                                            

Use of drawing 
instruments -1
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1000 mm – 350 mm and thickness ranges from 25 mm – 15 mm. The drawing boards designated 
by D0 and D1 are used for drawing offices where as D2 is recommended for the engineering students.

T-square
The T-square shown in Fig.1.2 is composed of a long strip, called the blade, fastened rigidly at right 
angles to a shorter piece called the head. The upper edge of the blade and the inner edge of the head 
are working edges and must be straight. The blade should have transparent plastic edges and should 
be free of nicks along the working edge. Transparent edges are recommended, as they permit the 
draftsman to see the drawing in the vicinity of the lines being drawn. T-square are available from 
600 mm. size to 1500 mm and above.

     
        Fig.1.1: Drawing board              Fig.1.2: T-square  

Mini-drafter
The mini-drafter shown in Fig.1.3 is a device 
that replaces the T-square, triangles, scales and 
protractor. It consists of a fixed clamp (use to fix 
the device with the drawing board) and two sets of 
parallelogram of bars connected by pivot plate. The 
free end of the parallelogram of bars has a set of 
graduated acrylic or metallic scales held at 900 and 
attached to a protractor head with an index plate 
and a locking screw knob. The mini drafter has 

Parallelograms 
Bars

Pivot
Plate

index Plate

locking knoB

scale

Fixing clamP 
With screW

Protractor head

reFerance mark

Fig 1.3: Mini-drafter

S. no. Designation Dimension in mm.
(length x Width x thickness)

Recommended for use  
with drawing sheet

1 D0 1500 x 1000 x 25 A0

2 D1 1000 x 700 x 25 A1

3 D2 700 x 500 x 15 A2

4 D3 500 x 350 x 15 A3

table 1.1 Standard sizes of drawing boards
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the mechanism which keeps the two perpendicular arms along with the graduated scale can swivel to 
any angle and can move to any location in the drawing sheet with the help of parallelogram of bars.
Thus, a mini-drafter is used to draw horizontal, vertical or inclined parallel lines of desired length 
anywhere on the drawing sheet with considerable ease and saving time. The main purpose of the 
mini-drafter is to speed up the drawing work. 

Set-squares

The set-squares used are of two types: 45° triangle and 
30°- 60° triangle. They are also called triangles. The 
45° set-square shown in Fig.1.4(a) is a right angled 
in which acute angles measure 45°. The 30°- 60° 
set-square shown in Fig.1.4(b) is a right angled in 
which acute angles measure 30° and 60°. Set- squares 
are made of transparent plastic so that lines of the 
drawing can be seen through them. All straight lines 
except the horizontal lines can be drawn with the 
help of set square. Vertical or upright lines are drawn 
with the T-square and the set square.

Drawing instrument box
In technical drawing, accuracy, neatness and speed are essential. These objectives are not likely to be 
obtained with cheap or inferior drawing instruments. Therefore, student should get an advice from 
his drafting instructor or an experienced drafter. Nickel, Silver or chromium plated instruments are 
costly. The cost of instruments may be justified by its good quality of work. A typical drawing 
instrument set is shown in Fig.1.5.

Protractors
Protractors are used for measuring various angles. They are available in different shapes-circular or 
semi-circular. They are made of nickel silver, plastic or sheet metal. Fig.1.6 (a & b) shows a transparent 

Fig.1.4: (a) and (b) Set-square

Fig.1.5: Drawing instrument set
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circular and semi-circular protractor reading up to half a degree.

Pencils
The basic instrument is the graphite lead pencil. These are available in various hardness and grades. 
Good quality pencils should always be used as they contribute to a very large extent towards accuracy 
and appearance of a drawing work. Generally, pencils are available in eighteen grades as follows: -

For good and accurate work, proper mending of pencil and sharpening of lead is very essential. 
The lead of 3H and 2H pencil should be sharpened to a chisel point as shown in Fig.1.7. This enables 
to draw long thin lines of uniform thickness. The lead of HB pencil should be sharpened to a conical 
point as shown in Fig.1.8, which is used for lettering.

For sharpening a pencil, a small piece of sand-paper of zero grade, pasted upon a piece of wood, 
will be very useful for keeping the point in good condition. Pull and roll the pencil point on a sand-
paper block shown in Fig.1.9 to sharpen the pencil point.

Drawing paper 
Various grades and qualities of drawing paper are available now-a-days. Cartridge or machine mode 
paper is largely used for drawing purpose. Drawing paper has two surfaces viz., rough and smooth.    

type Designation Purpose

Hard grade 9H,8H,7H,6H,5H,4H   Fine line work

Medium grade
i) 3H, 2H, H 
ii) F, HB,  B

Line work, lettering and  arrowheads

Soft grade 2B, 3B, 4B, 5B, 6B, 7B Mechanical drafting, Architecture and art work

Fig: 1.6: (a) Circular and Fig 1.6: (b) Semi-circular protractor

Fig.1.7: Chisel point pencil Fig.1.8: Conical point pencil Fig.1.9: Sharpen the pencil point
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The smooth surface is the proper side to be used. The standard sizes of drawing papers as recommended 
by BIS and its special publications SP 46-2003 are shown in Table 1.2.

table 1.2: Standard sizes of drawing sheets (Main ISO-A Series - SP46-2003)

French curves
French curves serve as guide edges for irregular curves. They are available in various shapes and sizes. 
Fig.1.10 shows the common forms of French curves. The good ones are generally made of highly 
transparent plastic. Adjustable curves are also available. It has the same purpose as that of the French 
curve. The curve shown in Fig.1.11 consist of a core of lead, enclosed by a coil spring attached to a 
flexible strip. This can be bent for any desired curve. The curve edge may be set practically up to the 
line to be drawn, assuring great accuracy either with pencil or pen.

Drawing clamps 
If the drawing paper is of the same size as that of the drawing board, all the four drawing clamps 
can be used, otherwise, for smaller drawing papers drawing pins or cello-tape can be used. The use 
of drawing pins and cello-tape should be avoided as far as possible. Constant use of pins spoils the 
boards as well as drawing sheets.

Sheet Designation trimmed Size (mm) Untrimmed Size (mm)

A0 841 x1189 880 x 1230

A1 594 x 841 625  x 880

A2 420 x 594 450 x 625

A3 297 x 420 330 x 450

A4 210 x 297 240 x 330

A5 148 x 210 165 x 240

Fig 1.10: French or irregular curves Fig 1.11: Flexible curve 
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Dusting cloth
A complete drawing sheet would look more attractive if it is not dirty. A clean piece of flannel or 
towel can be used as a duster for cleaning the sheet after the lines have been erased by rubber.

Rubber eraser
A soft rubber of good quality which will not spoil the surface of the sheet should be used. Erasing 
should be done very lightly so as not to leave any impression on the drawing sheet.

Erasing shields
Various sizes of metallic and plastic erasing shields are available. It consists of various holders and 
lines through which small portions of work can be erased without damage to other parts.

Roll-n-draw
It consists of a roller, protector and a graduated scale shown in Fig.1.12. It is a handy ruling drawing 
instrument used to draw a set of lines in horizontal, vertical and inclined direction. It is also used 
for drawing angles and circles.

1.1.3 Use of Various Drawing Equipment and instruments

Use of T-square and set–square
1. Drawing horizontal lines

Refer Fig.1.13 to draw a horizontal line, press the head of T-square firmly against the working 
edge of the board with the left hand. Then slide the left hand to the position shown at (A) so 
as to press the blade tightly against the paper. Place the pencil in the direction of the line at 
an angle of approximately 60° with the paper and draw the line from left to right.

2. Drawing vertical lines
Use either the 45° triangle or the 30°-60° triangles to draw vertical lines shown in Fig.1.13. 
Place the triangle on the T-square with the vertical edge on the left shown in (B). With the 
left hand, press the head of the T-square against the board. Now slide the hand to the position 
shown where it holds both the T-square and the triangle firmly in position. Then draw the 
line upward, rotating pencil slowly between the thumb and forefinger.

3. Drawing parallel lines
Refer Fig.1.14 to draw a line parallel to a given line, move the triangle and T-square as a unit 
until the hypotenuse of the triangle lines up with the given line. Hold the T-square firmly 
in position and slide the triangle away from the line and draw the required line along the 
hypotenuse. 

Fig.1.12: Roll-n-Draw

Use of drawing 
instruments-2
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Fig 1.14: Draw a line parallel to a given line AB

4. Drawing perpendicular line
To draw a line perpendicular to a given line, move the T-square and triangle as shown in 
Fig.1.15.

Fig 1.13: Drawing horizontal and vertical lines
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Fig:1.15: Draw a line perpendicular to a given line AB (method-1) 

5. Drawing lines at 30°, 60° or 45°
To draw a line making 60° from the horizontal, arrange the triangle as shown in Fig.1.16. 
Angles of 30° and 45° may be drawn in a similar manner. 

Fig:1.16: Draw a line perpendicular to a given line AB (method-2)

6. Drawing slanting lines
Fig.1.17 shows the use of 45°, and 30°, 60° set-squares in drawing slanting lines with T-square.
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Fig.1.17: Drawing slanting lines with T-squares and set squares

Use of compass
Circles and arcs of circles are drawn with the help of the compass as shown in Fig.1.18. Compasses 
having the pencil and inking attachments are used for drawing circles of approximately 12 cm diameter. 
Their legs are kept straight. But if larger circles are to be drawn, bend the legs of the compass as 
shown in Fig.1.19, so that they will stand approximately perpendicular to the paper. Bending of the 
legs is essential in drawing ink circles as otherwise, both sides of the pen attachment will not touch 
the paper equally.
The following steps may be followed in using a compass for drawing a penciled circle:-

Step-1.   Draw the centre lines of the required circle and set off the required radius on any of them.
Step-2.  Put the needle point at the exact intersection of the centre lines.
Step-3.  Adjust the opening of the legs of the compass to the required radius already marked 

on the centre line.

Fig.1.18: Using the compass Fig.1.19: Bending the leg of the compass 
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Use of dividers
The dividers are similar to the compass in construction and are made in square, flat and round 
cross-section. Many dividers are made with a spring and thumb-screw in one leg, so that minute 
adjustments in the setting can be made by turning the small thumb-screw.

The dividers can be put to the following uses: -
1. Dividing distances in to a number of equal parts.
2. Transferring distances or far setting off series of equal distance.

The dividers are used for spaces of approximately 25mm or more. For less than 25mm spaces use 
the bow dividers. Never use the large dividers for small spaces when the bow dividers can be used. 

Use of french curve
To draw a mechanical line over the freehand line with the aid of the irregular curve, it is only necessary 
to match the various segments of the irregular curve with successive portions of the freehand curve 
and to draw the line with pencil or ruling pen along the edge of the curve. It is very important that 
the irregular curve match the curve to be drawn for some distance at each and beyond the segment 
to be drawn for any one setting of the curve, as shown in Fig.1.20.

For symmetrical curves, such as an ellipse, use the same segment of irregular curve in two or 
more opposite places {Refer Fig.1.21(a)}. The irregular curve is matched to the curve and the line 
drawn from 1 to 2.  Light pencil dashes are then drawn directly on the irregular curve at these points. 
Fig.1.21 (b) shows that the irregular curve is turned over and matched so that the line may be drawn 
from 2 to 1. In similar manner, the same segments is used again as shown in Fig.1.21(c) and 1.21(d). 
The ellipse is completed by filling in the gaps at the ends by using the irregular curve or French curve.

Fig.1.20: Setting of irregular curve

Step-4.  Give a slight inclination to the compass in the forward direction and draw the circle 
clock-wise while rotating the handle between the thumb and the first two fingers of the 
right hand (see Fig.1.18). In order to darken the penciled circle, repeat the same process 
in the clock-wise direction only.
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Fig.1.21: Drawing symmetrical figures by using irregular curve

1.1.4  to layout a drawing sheet
The Bureau of Indian Standards issued IS 15093:2002 and SP 46:2003 which specify the exact size 
and location for each item found on the drawing sheet. It is recommended that standard sizes and 
formats should be followed to improve readability, filing and handling of drawing sheets. Fig.1.22 
shows a typical layout on drawing sheets. The drawing work should be done in rectangular working 
space. For this purpose, border lines are drawn. The recommended minimum boarder width of 20 
mm for sizes A0 and A1 and a 10 mm minimum width for sizes A2, A3 and A4. 

The lay-out must also provide a little block which should be located at the bottom right hand 
corner of the sheet. The title block contains the following information: 

1. The title of the drawing, 
2. Drawing number,
3. Name of the organization 
4. Scale,
5. Date of drawing,
6. Initial of technical staff who prepared, verified and approved the drawing, etc.
The size of the title block recommended is 65 mm x 170 mm and it is uniform for all sizes 

of drawing sheets. However, the drawing sheet lay-out with the contents of the little block may be 
modified to suit classroom training requirements. 

1

A

2 3 4 5 6

B

C

D
1 2 3 4 5 6

A

B

C

D
Title Block

170

65

Grid
Reference

minimum width

20 mm for A0 and A1
10 mm for A2,A3 and A4

Border

Edge Drawing space

Fig.1.22: Layout of a drawing sheet

Drawing 
elements
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1.2 ConVEntion oF linES anD tHEiR aPPliCationS

1.2.1 need of line and line Work
Drawing is made up of lines. Therefore, use of correct type of line is important to describe an object 
correctly, so as to communicate the shape and size of the object clearly and completely to the reader. 
In engineering drawing, the figures are drawn by using different types of lines. Synonymously, the lines 
may be considered as alphabets of drawing and therefore each type of line, if used properly, speaks 
itself about its purpose for which it is being employed. In this section emphasis given to various basic 
types of   lines, applications and their representation in engineering drawing as recommended by 
the latest BIS and its special publications SP 46:2003. The basic types of lines and their applications 
in engineering drawing given in SP 46:2003 are summarised in Table 1.3. For complete information, 
the concerned BIS code may be referred.

1.2.2 types of lines
There are 15 basic types of lines used in engineering practice which are identified by their designation 
numbers as per BIS specifications. These lines are discussed below:

Construction lines (Type 1.1: Continuous narrow Lines) 
These lines are made for the construction of figures. They are shown in geometrical drawings. They 
should be drawn very thin and faint and hardly visible in the finished drawing.

Extension or projection lines (Type 1.1: Continuous narrow Lines)
These lines are continuous thin lines. They extend by about 3mm beyond the dimension lines. 

Dimension lines (Type 1.1: Continuous narrow Lines) 
The dimension line represents the dimensions of the feature in the drawing and is generally a continuous 
line drawn parallel to the edge. They are terminated at the outer ends by pointed arrowheads touching 
the outlines, extension lines or centre lines.

Hatching lines/Section lines (Type 1.1: Continuous narrow Lines)
These are used to indicate a surface, which is cut. A series of parallel lines is marked in the cut 
surface in an inclined fashion generally at an angle of 450 to the main outline of the section. They 
are uniformly spaced about 1mm to 2mm apart spacing among them.

Leader lines (Type 1.1: Continuous narrow Lines)
The leader lines are used to pin point a location or a feature in a drawing. They are drawn usually 
at an angle to the representation and touch the feature with an indication of an arrow.

Short centre lines (Type 1.1: Continuous narrow Lines)
These are used to mark the Centre of small circles represented in the drawings and are marked with 
a + (plus) sign.
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Outlines or visible line (Type 1.2: Continuous wide Lines)
Lines drawn to represent visible edges and surface boundaries of objects are called outlines or principal 
lines. These are Continuous wide or thick lines.

Desig-
nation 
no. 

Broad 
category 
of line 

Commonly used lines 
alongwith designation number 

and their representation
General application

01
Continuous

line
Continuous narrow line (1.1)

Thickness = 0.13 mm 

Imaginary lines of intersection, 
Construction, Projection, Short 
center, Extension, Dimension, 
Leader, Hatching, Outlines of 
revolved sections ,Root of screw 
threads, Interpretation lines of 
tapered features

table 1.3: Types of lines and their applications in engineering drawing

Continuous wide line (1.2)
Maximum width or thickness = 

0.25 mm

Visible outlines of parts in cut 
and section, when hatching is 
used, Visible outlines of parts 
in view, Reference lines in 
projection, ground lines, Arrow 
lines for making of views, cuts 
and sections, Border lines, title 
block etc. 

Continuous extra wide line (1.3)
Maximum width or thickness = 

0.5 mm 

Visible outlines, Visible outlines 
of parts in cut and section, when 
hatching is not used, Lines of 
special importance

Continuous line, free hand 
narrow (1.4)

Short break lines, Limits of 
partial or interrupted views

Continuous lines, 
Zig zag hand narrow  Long break lines, Limits of 

partial or interrupted views

02
Dshed 
lines

Dashed narrow line (2.1) Hidden lines or edges,Hidden 
outlines

Dashed narrow line (2.2) 
 Hidden lines or edges
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03
Dashed 
spaced 

line

04
Long 

dashed 
dotted line

Long dashed dotted narrow 
line (Chain narrow line) (4.1) 

Center lines, Lines of symmetry, 
Pitch circle of holes, Pitch circle 
of gears, Indication of cutting 
planes

Long dashed dotted wide 
line (Chain wide line) (4.2) 

Cutting plane representations 
at the ends and at locations 
of change of direction, Surface 
treatment indication locations

05

Long 
dashed 
double 

dotted line

Long dashed double 
dotted narrow line (5.1) 

Centroidal lines , Locus lines 
Alternate positions of movable 
parts,  Extreme positions of 
movable parts, Outlines of 
adjacent pats

Short break lines (Type 1.4: Continuous free hand narrow lines)
These lines are continuous, thin and wavy. They are drawn freehand and are used to show a short 
break or irregular boundaries.

Long break lines (Type 1.5: Continuous zig zag narrow lines)
These lines are used to indicate a break in lengthy objects such as bars and channels that are of 
uniform cross sections (regular or irregular) and are marked in zigzag wavy pattern with freehand.

Hidden lines or edge (Type 2.1: Dashed narrow Lines)
These are used to mark the invisible or hidden edge or features of an object and also called as dotted 
lines. They are made up short dashes of approximately equal lengths of 2 mm with a gap of 1 mm. 

Centre lines (Type 4.1:  Long Dashed dotted narrow Lines)
These are thin lines made up of long and short dashes, alternately spaced and consistent in length, 
beginning and ending with a long dash.  These are drawn to represent the axis of the cylindrical, 
conical and spherical feature, including the holes in these bodies and are marked protruding slightly 
beyond the outlines of the object. These lines are also used to show the centres of the circles and arcs.

Cutting - plane lines (Type 4.2: Long Dashed dotted wide Lines) 
The location of a cutting plane is shown by this line. It is a long, thin, chain line at ends only.

Chain thick lines (Type 4.2: long dashed dotted wide line)
These lines are used to indicate special treatment on the surface.
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Long double-dots line (Type 5.1: long dashed double dotted narrow line)
These line representations are made with alternate dashes of 9-12 mm long, with two dots in between 
and spaced at 1mm apart among them from the ends of the dashes. 
The application of various types of lines are shown in Fig.1.23(a) and (b). 

SolVED PRoBlEmS (WitH inCREaSinG DiFFiCUlty lEVEl)
Example 1.1 List different types of line used in following drawing marked as A to F and check your 
response with the solution provided.
Solution
Continuous wide line-A: visible edges, visible outlines, main representations, maps, flow charts.
Continuous narrow line-B: dimension lines, extension lines, leader lines, reference lines, short centre 
lines, projection lines, hatching, construction lines, guide lines, outlines of revolved sections, imaginary 
lines of intersection.
Continuous narrow freehand line-C: Preferably manually represented termination of partial or 
interrupted views, cuts and sections, if the limit is not a line of symmetry or a center line.

CENTER LINE

OBJECT LINE

EXTENSION LINE

LEADER

HIDDEN LINE

SECTION A-A

SECTIONING LINE

(A)

CENTER LINE

CUTTING PLANE LINE

DOTTED LINE

500

DIMENSION LINE
EXTENSION LINE

P P

(B)

30

A

A

Fig.1.23: Application of various lines
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Dashed narrow line-D: hidden edges, hidden outlines.
Long-dashed dotted narrow-E: center lines, axes, lines of symmetry, cutting planes.
Long-dashed dotted wide line-F: Cutting planes at the ends and changes of direction outlines of 
visible parts situated m front of cutting plane.

1.3 EnGinEERinG SCalE

1.3.1 introduction
Whenever you start making drawing of an 
object, you intuitively, either reduce it, or 
enlarge it, or keep it of true size, so that it 
occupies allotted space on paper. If you make 
drawing of a building on paper, then you have 
to reduce dimensions proportionately, so that 
the drawing comes inside the paper. If you 
draw circuit of computer processor, naturally 
you have to draw a magnified drawing, so that 
minute circuits become visible & details can 
be labelled. And, if the size of object is equal 
to the size available on paper, then there is no 
need of reducing or enlarging the drawing, you 
can make true-size drawing.

Now a day, almost all technical drawings 
are drafted with the help of some drafting software, for example Auto CAD. Since screen size of Auto 
CAD is infinite, you can always make true size drawing in Auto CAD. But when you try to take 
printout of a drawing made in Auto CAD, then before printing on paper, in the plot model dialogue 
box (Fig.1.24), the scale or the representative fraction of the drawing has to be specified or if you tick 
the fit to paper box (Fig.1.24) the scale factor is decided automatically by the software Auto CAD. 
Hence, it becomes essential to first develop understanding of the concept of representative fraction. 

Fig.1.24: AutoCAD plot dialogue box showing options 
for plot scale of printed drawing

Y

Y

X

X

C

B

B

D

C

B
E F

Section Y-Y

E

A
46°

301,7

(Source reference [3])
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1.3.2 Representative Fraction or Scale Factor of a Drawing
Representative fraction of a drawing, is a numerical fraction value. Value of representative fraction 
indicates, how much times, the linear distance in the drawing is reduced or enlarged, compared to 
actual distance. If representative fraction of a drawing is (1/4) then, it means that linear distances on 
drawing are reduced 4 times, compared to actual distances. That is an actual line of 4 cm length, is 
drawn as 1 cm long line on the drawing. And if representative fraction of a drawing is (4/1) , then 
it means that linear distances on drawing are magnified by 4 times, compared to actual distances. 
That is a line of actual length 1 cm, is drawn as 4 cm long line in the drawing.
Mathematical formula for representative fraction of a drawing is

From above formula, it is clear that representative fraction is a unitless and dimensionless value. 
For reduced drawings, its value is less than 1, for full size drawings, its value is equal to 1, & for 
enlarged drawings, it value is greater than 1.
Other variations of the formula for the representative fraction (R.F.) of a drawing are,

And in case of miniature 3D model of a big structure or a machine component, formula for R.F. 
becomes, 

Reduced drawing
Drawing, drawn with value of representative fraction less than 1, are called reduced drawings. When 
object size is larger than drawing sheet size, then you have to make reduced drawings.

Enlarged drawing
Drawing, drawn with value of representative fraction more than 1, are called enlarged drawings. When 
object size is very small compared to drawing sheet size, then you have to make magnified drawings, 
so that minute details become clearly visible.

True size drawing
Drawing, drawn with value of representative fraction equal to 1, are called true size drawings.

1.3.3 How to decide the value of representative fraction or scale factor 
of a drawing?
Whenever you start drafting a technical drawing on paper, first thing you have to decide is the 
representative fraction or scale factor of the drawing. The selection of correct value of representative 
fraction depends on two things,

1. Dimensions of the actual object
2. Dimensions of the space available on paper

Representative fraction of a drawing =
Distance between two points A and B on drawing

Actual distance between the points A and B

Area of drawing
Actual area

R.F. = �

volume of model
volume of actual objectR.F. = � �

(  )1
3
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Let me just explain to you, by a practical situation, how to reach the correct value of R.F. Suppose, 
you want to make floor plan of a room, with floor dimensions 3 m×4.5 m on A3 size drawing sheet 
(297 mm×420 mm).
Now, first step is, you bring the dimension of the object and paper in same units.

Actual floor dimension = 3 m x 4.5 m = 3000 mm x 4500 mm
Size of A3 size drawing sheet = 297 mm x 420 mm
Try to select values of R.F., only from values recommended in Table 1.4. If you select the value of 
R.F. to be 1:10, then for 3000 mm actual length, length on drawing will be 3000 ×1/10=300 mm and 
for 4500 mm actual length, length on drawing will be 4500×1/10=450 mm.

Now, 300 mm×450 mm is larger than A3 size drawing sheet (297 mm×420 mm). And therefore, 
you have to select next lower value of R.F., from recommended values, so that the drawing comes 
inside the drawing sheet.

The next lower of R.F. from recommended values is 1:20. If you select the value of R.F. to be 
1:20, then for 3000 mm actual length, length on drawing will be 3000 ×1/20=150 mm and for 4500 
mm actual length, length on drawing will be 4500×1/20=225 mm.

Now, 150 mm x 225 mm drawing, can easily come inside the A3 size drawing sheet, (297 mm×420 
mm). Hence you finalise the R.F. value as 1/20.

If you have made true size drawing in Auto CAD, then before printing, in the plot model dialogue 
box, you have to specify value of scale as (1/20).

1.3.4 Engineer’s Scale or architect’s Scale
With the availability of drafting software like Auto CAD, manual drafting of drawing has now become 
obsolete. Consequently, the engineer’s scale or architect’s scale, which are used for making manual 
drawings, are also out of fashion. But still then, the concept of engineer’s scale is useful, in developing 
your understanding of scales and scale factor.

If you try to draw a reduced drawing, manually on paper, with a particular value of R.F., suppose 
(1/20),  with a true scale, then every linear dimension has to be first divided by 20, and then the 
numerical value obtained is drawn by a true scale. This consumes time, and wastes your energy in 
repetitive calculations.

This repetitive process of calculation, can be easily automised, by the use of M3 engineer’s scale, 
shown in Fig.1.25. M3 engineer’s scale, is having two reducing scales, one with R.F. value (1/20) on 
one side, and other with R.F. value (1/10)  on other side. If you draw a line of length 100 cm by the 

Category Recommended Scales

Enlargement scales 50:1, 20:1, 10:1,5:1,2:1

Full size 1:1

Reduction scales
1:2, 1:20, 1:200,1:2000
1:5, 1:50, 1:500, 1:5000

1:10,1:100, 1:1000,1:10000

table 1.4: Recommended values of R.F. as per IS: SP 46 (2003)
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reducing scale of R.F. value (1/20) then, it is actually a line of length (100/20) =5 cm (observe Fig.1.25).
Hence you can define engineer’s scale, as scale which automatically reduces or enlarges distances 

in a ratio, whose value is equal to the R.F. value printed on the scale. Commonly available set of 
engineering scales and recommended R.F. values are shown in Table 1.5.

1.3.5 Graphical Scale
Graphical scale, is a scale drawn on the drawing sheet itself. When you are using nonstandard value 
of R.F., for which engineer’s scale is not available, then you first draw a graphical scale of required 
value of R.F., on the drawing sheet itself. This helps you, to make the drawing with given value of 
R.F., without calculation.

You can also see graphical scales, on the tourist maps and survey maps. The main advantage of 
graphical scale drawn there is, you can directly measure actual distance between two locations A and 
B on map, by the help of graphical scale printed on the map.
Two types of graphical scale will now be discussed. 

Fig.1.25: Comparing M3 reducing scale (R.F 1/20 on one side and 1/10 on other side) with a full-size 
scale

name Representative fraction

M1 1:1,1:2

M2 1:5,1:2.5

M3 1:10,1:20

M4 1:50,1:100

M5 1:200,1:500

M6 1:300,1:600

M7 1:400,1:800

M8 1:1000,1:2000

table 1.5: Commonly available set of engineer’s scales 
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Plain scale
A graphical scale, indicating two units only or a unit and its subunit only, or multiples 
of a unit and unit only, is called a plain scale. As an illustration, example 1.2 in the 
subsequent pages, explains the concept and procedure, for making graphical plain scale.

Diagonal scale
In Example 1.2, if you are asked to measure 17.4 km, you will find it difficult, to measure it by 
graphical plain scale drawn in Fig.1.26. The plain scale drawn, has least count of 1 km, and therefore 
it can measure either 17 km or 18 km, but it cannot measure 17.4 km. For measuring to the least 
count of 0.1 km, you require to draw a graphical diagonal scale.

Diagonal scale helps to measure distances in three units, i.e., unit, sub unit and sub-sub unit 
or 10 units, 1 unit and 0.1 unit or some other similar combination. As an illustration, example 1.3 
in the subsequent pages, explains the principle and procedure for making graphical diagonal scale.

SolVED PRoBlEmS (WitH inCREaSinG DiFFiCUlty lEVEl)
Example 1.2 On a tourist map of Mumbai, 10 km of actual distance is represented by 5 cm length 
on the map. What is the representative fraction of the map drawing?  Draw a plain scale on the map 
to read up to 30 km, and with least count of 1 km. Show a distance of 17 km marked on the scale. 
Solution 

Fig.1.26

Representative fraction of a drawing =
Distance between two points A and B on drawing

Actual distance between the points A and B

Representative fraction of a drawing =                =                                     =
5cm

10km

5cm

10 x 1000 x 100 cm

1

200000

Now, R.F. of drawing and R.F. of plain scale, for making or measuring elements of that drawing is 
always same.

R. F. of plain scale =
length of plain scale

Actual length to be measured

=> Length of plain scale = R. F. of plain scale x Actual length to be measured

=> Length of plain scale =                      30km =                    30   1000   100 cm = 15 cm  1
200000 x 1

200000 x x x

Scale
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1. Draw a line segment of length 15 cm, and divide it into 3 equal parts. (Logic: - 15cm distance on 
drawing, represents an actual distance of 30 km, and therefore you divide it, into 3 equal parts, 
each part representing a distance of 10 km reduced 200000 times.) 

2. At the end of first division, mark 0, & mark 10 & 20 at the end of subsequent divisions to its 
right. Divide first division, into 10 equal parts, each part representing a distance of 1km reduced 
200000 times. On first division, mark kms from 1 to 10 starting from 0 and moving to left. (Logic: 
- 0 is not marked at the start of first division, but it is marked at the end of first division. The 
advantage is, there is no need of dividing all 3 divisions into 10 equal parts. Only dividing the 
first division into 10 equal parts works. Whether, you want to measure 17 km or 7 km or 27 
km, it can be easily done with this technique.)

3. Show scale as a rectangle of height 3mm to 6mm, & for ease of measurement, draw thick and 
dark horizontal lines after alternate divisions. Mark distance of 17 km as shown in Fig.1.26.

Example 1.3 On a tourist map of Mumbai, 10 km of actual distance, is represented by 5 cm length on 
the map. What is representative fraction of the map drawing?  Draw a diagonal scale on the map to 
read up to 30 km, and with least count of 0.1 km. Show a distance of 17.4 km marked on the scale. 
Solution

Fig: 1.27

Fig: 1.28
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Fig.1.27 explains the principle of diagonal scale i.e., how in a diagonal scale you are able to measure 
minute distances, which cannot be measured by plain scale. Just observe the line segment 00 and line 
segment 78. As you go from bottom to top the horizontal distance between the two-line segments 
increases from 7 km to 8 km (R.F. =1/200000). At horizontal level 0.1 the distance between the line 
segment 00 and line segment 78 is 7.1 km (R.F. =1/200000). At horizontal level 0.4 the distance 
between the line segment 00 and line segment 78 is 7.4 km (R.F. =1/200000) and so on.

Fig.1.28 is the solution. The explanation is in continuation of explanation for problem 1.1. From 
point 10 at left draw a vertical line, and divide it into 10 equal parts, because least count required is 
0.1 km (If least count required would have been 0.2 km, then you would have divided vertical line 
from point 10 at left in 5 equal parts only). Mark the horizontal levels as 0.1, 0.2 …..0.9,1. Draw the 
rectangle and draw horizontal lines for all levels. The Diagonal scale is now complete.

To measure the distance of 17.4 km, simply go at the horizontal level of 0.4 and measure the 
distance as shown in Fig.1.28.

1.4 DimEnSioninG tECHniqUES
Dimensioning is a technique of describing the sizes and locations of various parts in a drawing. It is 
a numerical value expressed in appropriate units of measurement. It is identified on a drawing along 
with lines, symbols and text to define the geometrical characteristics of an object. All dimensional 
information necessary to define a part or a component clearly and completely shall be shown directly 
on a drawing. Each feature shall be dimensioned once only on a drawing. Dimension shall be placed 
on the view or section that most clearly shows the corresponding features.

1.4.1 Elements of Dimensioning
The elements of dimensioning include extension line, dimension lines, leaders, arrowheads, origin 
indication and dimension itself. The various elements of dimensioning are shown in Fig.1.29.

Fig.1.29: Elements of dimensioning

3615
10

50

30

Ø10

18

10

Dimension Numbers

Leader Line
Extension Line

Dimension Line

Termination (Arrow head)
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1.4.2 methods of Dimensioning
There are two methods of dimensioning. The dimensions are indicated on a drawing as per one of 
the following methods as recommended in BIS (SP 46:2003).

Method 1- Aligned system
In this system, all dimensions are placed near the middle and above the dimension lines which are 
drawn without any break and written parallel to them. Dimensional value is indicated in such a way 
that they may be read from the bottom for horizontal dimensions and from the right side for vertical 
dimensions. Fig.1.30 shows this method of dimensioning.

Method 2- Unidirectional system
In this type of system, dimensions are readable from the bottom side of the given drawing-sheet. The 
dimension lines are broken near the middle for inserting the dimensions. Fig.1.31 shows this method 
of dimensioning. This system of dimensioning is generally used on large sized drawing, where it is 
not convenient to read the dimensions from the right-hand side.

1.4.3 arrangement of Dimensions

Chain dimensions
In this arrangement, dimension lines are drawn like a chain so that the successive arrowheads touch 
each other as shown in Fig.1.32. This is also known as continuous dimensioning. 

Parallel dimensions
This type of arrangement is used when a number of dimension lines are spaced out parallel one to 
another and successively one below the other. This helps to refer a number of dimensioning from a 
common datum in a progressive manner as shown in Fig.1.33. 

Combined dimensions
This arrangement is used, when both chain and parallel dimensions are indicated in the same drawing 
as shown in Fig.1.34. 

60
15

15

15

80
60

Ø10

Ø20

TWO HOLES

30

60

15
15

15

80

60

Ø10

Ø20

TWO HOLES

30

Fig.1.30: Aligned system of dimensioning Fig.1.31: Unidirectional system of dimensioning
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Dimensioning by coordinates
In this type of dimensioning, a table can be used in place of other dimensioning styles.
This method is useful when a number of holes of different sizes have to be dimensioned. Fig.1.35 
shows the dimensioning by coordinates.

50 50 50 50 50

Fig.1.32: Chain–dimensioning

Fig.1.33: Parallel–dimensioning

20
70

120
170

50
100

Fig.1.34: Combined–dimensioning

220
100 100

50 50

Fig.1.35: Dimensioning by coordinates
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(2)

(1)
(3)
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1.4.4 Example of Dimensioning Some Common Features
In engineering drawing some common features like circle, radii, chord and small arcs, 
angles etc., are used with different sizes and shapes. Some examples are shown to give 
an idea of indicating dimensions on these common features.

Dimensioning of circle 
The dimension of a circle should be represented by the symbol Ø. If the circle is large in size it should 
be dimensioned with a dimension line drawn across the circle through its center at an angle with 
the diameter dimension shown in Fig.1.36 (a). If the space available inside the circle is insufficient 
to indicate the dimension, then it can be dimensioned using a leader or extension lines as shown in 
Fig.1.36 (b). If the space is insufficient to place the arrowheads inside, in the case of small diameter 
holes, then the diameter can be dimensioned as shown in Fig.1.36 (c). The circle should be dimensioned 
by one of the methods depending on size as shown in Fig.1.36(a), (b) and (c). 

Dimensioning of radii 
The dimension of a radii should be represented by the letter 'R'. As far as possible, the dimension line 
of a radius should pass through the centre of the arc. While dimensioning small radii, the arrow may 
be reversed. Leaders which indicate radii must always be radial lines. The radii should be dimensioned 
by one of the methods as shown in Fig.1.37.

Dimensioning-1

Dimensioning-2

Ø 10

Ø 40

Ø 20

Fig.1.36: Dimensioning of circle
       (a)                               (b)                         (c)

R5

R3

R5

R2

R15

Fig.1.37: Dimensioning of radii

Dimensioning of chord and arc length
Fig.1.38(a) and 1.38(b) shows method of dimensioning chords and arcs.
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70
70

Fig.1.38(a): Dimensioning chords Fig.1.38(b): Dimensioning arcs

Dimension in narrow space
Sometimes the space between the extension lines is too small to insert the dimension value, so the 
dimension may be placed above the extended portion of the dimension line beyond the arrowheads, 
but preferably on right side as shown in Fig.1.39.

30
13 5

30
10

5

10

Fig.1.39: Dimension in narrow space

Dimensioning of angles
Angles are normally indicated in degrees. The different angles should be dimensioned by any one of 
the methods as shown in Fig.1.40.

20° 40°
120°45°

Fig.1.40: Dimensioning of angles
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1.4.5 General Rules for Dimensioning
Some rules for dimensioning are given below:

1. Dimensions should be placed on the view which shows the relevant features clearly.
2. Dimensions marked in one view need not be repeated in another view.
3. Dimensions should be placed outside the view as show in Fig.1.41.
4. Dimensions should not be taken from hidden lines as shown in Fig.1.42.
5. Dimensions should be given from a base line, a centre line of the hole, or a finished surface.

Dimensioning to a centre line should be avoided except when the centre line passes through 
the centre of the hole. Fig.1.43.

6. The crossing of dimension lines should be avoided as for as possible.
7. Aligned system of dimensioning is recommended.
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Fig.1.41: Dimensions should be placed outside   

the view
Fig.1.42: Dimensions should not taken from   

hidden lines
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Fig.1.43: Dimensioning to the centre line of an object should be avoided

1.4.6 Drawing of arrowheads
1. Arrow heads are drawn free hands.
2. Arrow head must be symmetrical about dimension line. 
3. Arrow head may be open or solid depending upon the tip of a arrow being solid or open 

shown in Fig.1.44. 
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4. The size of arrow head should be proportionate to the thickness of drawing lines and size of 
drawing. Generally, the length of arrow head is about three times the depth. See Fig.1.45. 

Fig.1.44: Solid and open arrow

(Source reference [3])

SolVED PRoBlEmS (WitH inCREaSinG DiFFiCUlty lEVEl)
Example 1.4 Violation of some of the principles of drawing are indicated in following figure. The 
corrected version of the same as per BIS SP 46-2003 is given in the solution. The violations from 1 to 
16 indicated in the figure are explained below.
Solution

Fig.1.45: Size of arrowhead

1. Dimension should follow the shape symbol.
2. and 3. As far as possible, features should not be used as extension lines for dimensioning.
4. Extension line should touch the feature.
5. Extension line should project beyond the dimension line.
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1.5 GEomEtRiCal anD tanGEnCy ConStRUCtionS

1.5.1 introduction
The art of representation of geometrical object such as triangle, rectangle, square, circle, polygon etc, 
on a paper is known as geometrical drawings.

In the process of preparing a drawing, there will be many occasions when it will be necessary 
to utilize one or more of the geometric construction. These construction techniques will be helpful 
in solving problem involving the application of points, lines, angles and curved surfaces.

1.5.2 Definition

Definition of terms
Point: A point has position but no magnitude or the place of intersection of lines is called as point.
In Fig.1.46 a point is represented by the intersection of two lines (a),  by a short cross bar a line (b), 
by a small cross (c).
Line:   

1. A straight line is the shortest distance 
between two pints.

2. A curved line is one which changes 
its direction from point to point (see 
Fig.1.47)

Angle. An angle is formed by two intersecting lines.
The different kinds of angles are illustrated in Fig.1.48. Most of the angles used in technical drawing  
can be drawn easily with the  mini drafter, T-square or straight edge and triangles. For drawing odd 
angles, use the protractor.
Triangles. A triangle is a plane figure bounded by three straight sides and the sum of the interior 
angles is always 1800. The different kinds of triangles are shown in Fig.1.49.

point
point

point

(a) (b) (c)

Fig.1.46: Point

6. Writing the dimension is not as per aligned method.
7. Hidden lines should meet without a gap.
8. Centre line representation is wrong. Dots should be replaced by small dashes.
9. Horizontal dimension line should not be broken to insert the value of dimension in both 

aligned and uni-direction methods.
10. Dimension should be placed above the dimension line.
11. Radius symbol should precede the dimension.
12. Centre line should cross with long dashes not short dashes.
13. Dimension should be written by symbol followed by its values and not abbreviation.
14. Note with dimensions should be written in capitals.
15. Elevation is not correct usage.
16. Plan is obsolete in graphic language
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180°
90°

Straight Angle Right Angle Acute Angle

More than 90° A
90°

Obtuse Angle Complementary
Angle

Supplementary
Angle

180°

B B
A

Less than 90°

Fig.1.47: Types of line Fig.1.48: Types of angles

Equilateral Triangle
All sides Equal

All angles Equal

Isosceles Triangle
Two sides Equal

Two angles Equal

Base

Side Side

Vertex

                                    Scalene Triangle
                                       No sides or
                                    No angles Equal

AL
TI

TU
D

E
90°

Right Triangle
One 90° Angle

Fig.1.49: Different types of triangles

Quadrilaterals. A quadrilateral is a plane figure bounded by four straight sides. If the opposite sides 
are parallel, the quadrilateral is known as parallelogram as shown in Fig.1.50.

Circle. A circle is a closed curve all points of which are at the same distance from a point called the 
centre. Different parts of circles are shown in Fig.1.51.

Polygons. A polygon is a plane figure bounded by straight lines. If the polygon has equal angles and 
equal sides, it can be inscribed or circumscribed around a circle. Such polygon are known as regular 
polygon. The different types of polygons are illustrated in Fig.1.52.

SQUARE

EQUAL SIDES OPPOSITE SIDE
EQUAL

RECTANGLE

EQUAL SIDES

RHOMBUS

OPPOSITE SIDE
PARALLEL

RHOMBOID

TWO SIDE
PARALLEL

TRAPEZOID

NO SIDE
PARALLEL

TRAPEZEDIUM

Fig.1.50: Types of quadrilaterals

STRAIGHT LINE

INDEFINITE LENGHT

STRAIGHT LINE

DEFINITE LENGHT

ARC FREE CURVE VERTICAL LINE

HORIZONTAL LINE
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Fig 1.51 : Different parts circle

89°

Fig.1.51: Different parts of circle 
CHORD
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INSCRIBED TRIANGLE CIRCUMSCRIBED SQUARE PENTAGON HEXAGON

OCTAGON
HEPTAGON

9 SIDES = NONAGON

10 SIDES = DECAGON

12 SIDES =DODECAGON

90°

Fig.1.52: Different types of polygons

1.5.3 lines and angles

Bisecting a line or arc (see Fig.1.53)
1. Draw a line or arc AB of given length. 
2. Set  the compass for any radius greater than one-half of  AB. Using A&B as centres, draw  

two arcs to intersect at C and two arcs to intersect at D.
3. The point at which line CD crosses AB is the centre.
4. Note: The dividers may be used to bisect a line or divide it into a number of equal parts.

Bisecting an angle (see Fig.1.54)
1. Draw angle BAC.
2. With A as a centre and the compass set at any convenient radius, draw an arc cutting line  

AB at D and line AC at E.
3. Set the compass at a radius greater than one-half of DE.
4. With D and E as centres, draw two arc to intersect at Q.
5. Draw a line from Q to A. The line QA bisects the angle.
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Fig. 1.53 : Geometric method of
Bisecting a Line or Arch

Fig. 1.54 : Bisecting an Angle

A B

C

D

O

Fig.1.53: Bisecting a line or arc Fig.1.54: Bisecting an angle

Drawing a line parallel to another line at a given distance (see Fig.1.55)
1. Let AB be the straight line and CD the given distance at using a line parallel to AB  is to 

be drawn. Using any point E and F on line AB as centres and CD as the radius, draw two 
arcs. The line GH drawn tangent to the two arcs is the regular line.

2. Curved lines: Let AB be the curved line and CD the given distance. Draw a series of arcs 
from AB with a radius equal to CD. With the help of french curve, draw line tangent to 
these arcs (see fig1.56).

C D
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A B

Radius=CD

C D
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B
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Radius=CD

Fig.1.55: Drawing a line parallel to another line at a 
given distance 

Fig.1.56: Drawing curved parallel lines

Dividing a line into equal parts
Fig.(1.57.) shows a line AB which is to be divided into six equal parts;

1. From one end of this line draw line AC at any convenient angle.
2. Starting at A on line AC lay off six equal spaces either with dividers or a scale.
3. From the termination point of the last space D, draw a line connecting D with B.
4. With the edge of a triangle set parallel with line DB, draw lines from the points on line 

AC to line AB. The division points will be found where the parallel lines intersect line AB.

GIVEN

1
GIVEN 1

A B A B A

B

C

A

D

E C

B

A B

C

D

A

B

C

D

E

A

D

E C

B

O

2 3 2 3

Fig. 1.53 : Geometric method of
Bisecting a Line or Arch

Fig. 1.54 : Bisecting an Angle
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Fig.1.57: Dividing a line into six equal parts

1.5.4 Construction of angles by using Compass

Constructing an angle of 60°
AB is the base line, with A as centre and any suitable radius describe an arc to obtain point C. 
Using the same radius and point C as centre, mark of point D. Join AD. The angle DAC thus 
obtained is of 60°.

Constructing an angle of 30°
Construct an angle of 60° as in the preceding construction. With C and D as centres and the 
same radius AC strike  an  arc to obtain point E. Join AE. The angle EAC thus obtained is of 30°. 

Fig.1.58: Construct an angle of 60° Fig.1.59: Construct an angle of 30°

Constructing an angle of 90°
Let AB is the base line as shown in Fig.1.60. With a convenient radius AC and A as centre, 
strike the arc. Using the same radius and centre C, mark off D. Similarly, mark of E. With D 
and E as centres and using the same radius obtain point F. Join AF. Then, the angle FAC thus 
obtained is of 90°. 

Constructing an angle of 75°
Construct an angle of 90° as in the preceding construction. Using a constant radius, bisect the 
arc DO to obtain point G. Join AG. The angle GAC thus obtained is of 75°. See Fig.1.61.
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Fig.1.60: Construct an angle of 90° Fig.1.61: Construct an angle of 75°

1.5.5 Construction of triangles and quadrilaterals

Drawing a triangle with sides given of length, A, B and C as shown in Fig.1.62(a)
1. Draw one side, as C, in desired position and strike an  arc with radius equal to side A. 
2. Strike another arc with radius equal to side B. 
3. Draw sides  from intersect of arcs as shown in Fig.1.62(3).

Drawing a right angle triangle length of hypotenuse and one side is given
1. Draw line AB equal to length 'S' given in Fig.1.63(a).
2. With AB as a diameter equal to S, draw a semi circle. 
3. With A as centre and R as radius, draw an arc intersecting the semi-circle at C. Draw AC 

and CB to complete the right angle triangle shown in Fig.1.63.

Drawing an equilateral triangle
1. Draw line of AB of given length. 
2. With A and B as centres and AB as radius, strike arcs to intersect at C. 
3. Draw lines AC and BC to complete the triangle as shown in Fig.1.64.
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Fig.1.62: Draw a triangle with sides given Fig.1.63: Draw a right angle triangle length of 
hypotenuse and one side is given
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R R

A B

C

A B

C

1 2

Fig.1.64: Construct an equilateral triangle

Drawing a square
1. Select a point A which will act as one corner of the needed square. 
2. Construct horizontal and vertical lines through point A. 
3. Measure the desired length to point B and construct a vertical line through it. 
4. From point A (or B), construct a 45° line establishing point C. 
5. Construct a horizontal line through point C establishing line CD and complete  the required 

square ABCD as shown in Fig.1.65.
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Fig.1.65: Draw a square by measuring only one side

Constructing a rectangle, given the diagonal BD and one side of it
1. Bisect BD at O. 
2. With O as centre and OB as radius, draw a circle. 
3. With B and D as centres and radius equal to the length of the given side, draw arcs to cut 

the circle at C and A as shown in Fig. 1.66. 
4. Join AD, BC and then AB and CD. Thus, ABCD is the required rectangle.
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Fig.1.66: Constructing a rectangle, given 
the diagonal and one side
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1.5.6 Construction of Circles

Constructing a circle or arc through three points
Given three points A, B and C. 

1. Construct lines AB and BC. 
2. Bisect lines AB and BC using procedure as shown in Fig.1.67. 
3. The intersection of the two bisectors becomes the radius point and an arc or circle can be 

formed through points A, B and C. 

Locating a circle’s center
(Refer Fig.1.68) Given a circle of any diameter 

1. Draw any chord AB, within the circle.
2. Construct lines AC and BD perpendicular to line AB. 
3. Construct line AD and BC. Intersection ' X ' will be the circle's center. 
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Fig.1.67: Construction of a circle or an arc through three 
points

Fig.1.68: Locating a circle’s center

1.5.7 Construction of Regular Polygons

Construction of hexagon with drafting tools
Fig.1.69 shows how to construct a hexagon when the dimension given in the distance across the flats 
as opposed to the distance across the corners.

1. Bisect the line to locate its centre, using half the line’s length as a radius construct a circle. 
2. Using the 30° - 60° triangle draw the 30° and 60° inclined lines tangent to the circle and 

two horizontal lines also tangent to the circle. 
3. Draw hexagon’s heavy object lines and erase all construction lines.
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Construction of hexagon inside a circle
(Refer Fig.1.70) Given a circle with center point. 

1. Draw a horizontal line through the center of the circle forming points A and B. 
2. Using the 30° - 60° triangle construct the hexagon’s four sides from points A and B. 
3. Draw hexagon’s horizontal top and bottom lines. 

r
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A B A B

Step-1

Step-3

Step-2

Fig.1.69: Construction of hexagon Fig.1.70: Draw a hexagon inside a circle                                         

Construction of octagon
Fig.1.71 shows how to construct a octagon when the distance across the flats is given. 

1. Locate the centre of line AB. Using AZ as the radius, draw a full circle. 
2. Construct two horizontal and two vertical lines tangent to the circle’s arc. Using the 45° 

triangle construct four inclined lines tangent to the circle’s arc. 
3. Draw octagon’s heavy object lines and erase  all construction lines. 

r
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Step-1

Step-3Step-2

A B A B
Z

Fig.1.71: Draw the octagon
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1.5.8 tangency Construction
The outline of many parts of machines, apparatus, instruments and devices consists of straight lines 
and arcs gradually merging into one another. Such gradual continuation of one line whether straight 
or curved into another  straight or curved is termed as tangency.

Drawing a tangent to a circle
(Refer Fig.1.72) Given a circle of any diameter with a centre point O and a point P beyond it, draw 
a tangent from P to the circle. 

1. Join points P and O. 
2. Bisecting a line PO and describe a semicircle upon it. 
3. The point of contact between the circle and the semicircle is X. Join points P and X produce 

to Y. 
4. Line PY is the tangent.

Drawing a common exterior tangent to two unequal circles
(Refer Fig.1.73) Given two circles of unequal diameter with centres O1 and O2. 

1. Join O1 O2 and bisect it. 
2. On O1 and O2 draw a semi-circle. 
3. Mark off CE equal to DO2
4. With O1 as centre and radius O1E strike an arc EF. Join O1F and produce it to obtain the 

point A.
5. Draw BO2 parallel to O1A.
6. Join AB which is the required tangent as shown in Fig.1.73. 

Fig.1.72: Draw a tangent to a circle Fig.1.73: Draw a common exterior tangent to two 
unequal circles
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Fig.1.72: Draw a tangent to a circle
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Fig.1.73: Draw a common exterior tangent to two
                       unequal circles
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Fig.1.72: Draw a tangent to a circle
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Fig.1.73: Draw a common exterior tangent to two
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F



Basic Elements of  Drawing |  41 

Drawing a tangent to a circle through a point
Given point P on the circle.

1. Move the mini drafter horizontal scale and triangle as a unit until one side of the triangle 
passes through the point P and the centre of the circle. 

2. Slide the triangle until the other side passes through point P, and draw the required tangent. 
See Fig.1.74 

Fig.1.74: Draw a tangent to a circle through a point
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SolVED PRoBlEmS (WitH inCREaSinG DiFFiCUlty lEVEl)
Example 1.5 Construct the circumcentre of the ΔABC with AB = 5 cm, angle A = 60° and angle B = 
80° draw the circumcircle and find the circumradius of the ΔABC.
Solution
Step-1.  Draw the ΔABC with the given measurements
Step-2.  Construct the perpendicular bisector of any two sides (AC and BC) and let them meet at S 
which is the circumcentre.
Step-3. S as centre and SA = SB = SC as radius, draw the Circumcircle to passes through A,B and 
C. Circumradius = 3.9 cm.

Example 1.6 Construct ΔPQR whose sides are PQ = 6 cm   Q = 600 and QR = 7 cm and locate its 
Orthocentre.
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Solution
Step-1.  Draw the ΔPQR with the given measurements.
Step-2.  Construct altitudes from any two vertices R and P, to their opposite sides PQ and QR 
respectively. The point of intersection of the altitude H is the Orthocentre of the given ΔPQR.

Example 1.7 Construct a hexagon with 50 mm side (Horizontal)
Solution
This construction is very similar to constructing a hexagon inscribed in a circle, except we are not 
given the circle, but one of the sides instead. Steps 1-3 are there to draw this circle, and from then 
on the constructions are the same. The center of the circle is found using the fact that the radius of 
a regular hexagon (distance from the center to a vertex) is equal to the length of each side.

1. Start with a line segment 
AF of 50 mm length. This 
will become one side of 
the hexagon. Because we 
are constructing a regular 
hexagon, the other five sides 
will have this length also.

2. Set the compasses point on 
A, and set its width to F. The 
compasses must remain at this 
width for the remainder  of the 
construction.

3. From points A and F, draw 
two arcs so that they intersect. 
Mark this as point O. This is 
the center of the hexagon's 
circumcircle.

4. Move the compasses to O 
and draw a circle. This is the 
hexagon's circumcircle - the 
circle that passes through all 
six vertices

5. Move the compasses on to 
A and draw an arc across the 
circle. This is the next vertex of 
the hexagon.

6. Move the compasses to this 
arc and draw an arc across the 
circle to create the next vertex.
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7. Continue in this way until 
you have all six vertices. (Four 
new ones plus the points A 
and F you started with.)

8. Draw a line between each 
successive pairs of vertices.

9. Done. These lines form a 
regular hexagon where each 
side is equal in length to 
AF=50 mm.

Example 1.8 Construct an inscribed square with side 25 mm.
Solution 

1. Start with the given circle, 
center O and radius of 25 mm. 
If the circle center point is not 
given, you can construct the 
center using the method shown 
in Finding the center of a circle.

2. Mark a point A on the 
circle. This will become one 
of the vertices of the square.

3. Draw a diameter line 
from the point A, through 
the center and on to cross 
the circle again, creating 
point C.

4. Set the compass on A and set 
the width to a little more than 
the distance to O.

5. Draw an arc above and 
below O.

6. Move the compass to C 
and repeat.
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1. Indian Standards Institutions(ISI) is renamed as Bureau of Indian Standards (BIS). BIS 
has developed different standard code of practice to maintained the uniform standard of 
engineering drawing throughout the country. 

2. The engineering  or technical drawing can be prepared with manuals instruments on drawing 
sheets. Accuracy of drawings largely depend on the quality of instruments. Different types 
of instruments and materials staring from drawing board, T- square , Mini-drafter, drawing 
sheet etc., have been shown  along with their  dimensions as recommended by BIS. The usage 
of various drawing instruments and layout of a drawing sheet as per Indian standards are 
also described in this unit.

3. In engineering drawing, the figures are drawn by using different types of lines. The different  
types of   lines, applications and their representation in engineering drawing as recommended 
by the BIS and its special publications SP 46:2003 are explained comprehensively.

4. Drawing of an object may be the same size as that of the object (full size) or it may be larger 
or smaller than the object. The ratio of reduction or enlargement depends on the relative 
sizes of the object and of the sheet of paper on which the drawing is to be made. In this 
unit calculation of representative fraction for construction of a scale is described. Method 
of construction of plain and diagonal scales are explained  with some numerical examples. 

5. Dimensioning is a technique of describing the sizes and locations of various parts in a drawing. 
It is a numerical value expressed in appropriate units of measurement. It is identified on a 
drawing along with lines, symbols and text to define the geometrical characteristics of an 
object.  Elements  of dimensioning, Method of dimensioning as per BIS and  drawing of 
Arrowheads  are described  with  examples in this unit.

6. In engineering drawing technical students frequently use a number of geometrical constructions 
which are the application of plane geometry. So in this unit we also given more stresses on 
construction of geometrical drawings  based on plane geometry as bisecting a line or arc,  
angles, dividing a line into equal number of parts, construction of angles , triangles, , square  
circles , regular polygon and  tangency construction.

7. Draw a line through where 
the arc pairs cross, making it 
long enough to touch the circle 
at top and bottom, creating the 
new points B and D. This is a 
diameter at right angles to the 
first one AC.

8. Draw a line between each 
successive pairs of points A, 
B, C, D

9. Done. ABCD is a square 
inscribed in the given circle.

Unit SUmmaRy
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a. objective questions

A1. Fill in the blanks with appropriate words.
1.1 When drawing, the head of the T-square is made to slide against the _____edge of the 

board.
1.2 Set-squares are used  for drawing all  ______ lines except the horizontal lines.
1.3 Chisel point pencil is used for __________________.
1.4 The dimensions of A0 size drawing sheet as per BIS is ________ x _______ mm.  
1.5 The centre line is used to indicate __________ and ________________.
1.6 Section lines are usually drawn at a _________ angle. 
1.7 Drawing of buildings are drawn using ____________ scale 
1.8 When two angles together make 900, they are said to be _______angle. 
1.9 All dimensions are shown from a common datum in ______ dimensioning.
1.10 The extension line should extent about 3mm beyond the ______.

A2. Multiple Choice Questions
1.1 The compass is used for drawing
 (a) perspective (b) square (c) circle (d) triangle
1.2 A Mini drafter is used for drawing
 (a) smooth and irregular curves  (b) parallel and perpendicular lines
 (c) free hand lines only  (d) vertical lines only 
1.3 A French curve is used to draw
 (a) polygons (b) circles (c) triangles (d) smooth freeform curves 
1.4 Centre lines are drawn as
 (a) continuous narrow lines  (b) dashed narrow lines
 (c) long-dashed dotted narrow lines (d) long dashed double dotted narrow lines
1.5 Which of the following latest standard is used for line conventions according to Bureau of  
 Indian Standards?
 (a) SP46 (b) ISD609 (c)  IS696 (d) ISO9000

EXERCiSES

answers of Fill in the Blanks questions

1.1 working edge; 1.2 straight; 1.3 long thin lines; 1.4 841x1189 mm; 1.5 axis of a 
cylindrical and spherical feature; 1.6 450; 1.7 reducing scale; 1.8 complementary angle; 

1.9 parallel; 1.10 dimension line
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1.6 A long dashed double dotted narrow line is used to represent 
 (a) centre line (b) border line  (c) centroidal line (d) hidden line 
1.7 According to BIS, dimension lines, hatching and extension lines are drawn as  
 (a) continuous wide line     (b) continuous thin line
 (c) continuous extra wide line    (d) continuous free hand lines
1.8 Representative fraction in a scale is ratio of
 (a) (Length of a line in actual)/(length of line in the  drawing)
 (b) (Length of a line in drawing)/(Actual length of line on the object)
 (c) (Length of a line in drawing)/(length of line in  isometric drawing)
 (d) Length of a line on drawing X actual length of line
1.9 The unit of R.F. is 
 (a) cubic centimeter (b) square centimeter (c) centimeter (d) unit less
1.10 A 2 cm long line on a drawing represents a distance of 70 cm, R.F. of the drawing is 
 (a) 1/70     (b) 1/35    (c) 35   (d) (1/35)1/2
1.11 If the area of drawing of roof of a house is 1/100 of actual area of roof then the representative 
  fraction of drawing is
 (a) 1/100   (b) 100/1  (c) 1/10000  (d) 1/10
1.12 A solid of volume 125 m3 is represented by a similar solid model of volume 1 cm3. Scale 
  factor for the scale is
 (a) 1:12500    (b) 1:500    (c) 1:125      (d) 1:2500
1.13 When measurements are required in three consecutive units, the appropriate scale is
  (a) plain scale   (b) diagonal scale   (c) isometric scale   (d) scale of chords
1.14 The dimension for diameter of a circle should be
  (a) preceded by the symbol 'ϕ'  (b) suffixed by the symbol 'ϕ'
  (c) preceded by the symbol 'D'  (d) suffixed by the symbol 'D'
1.15 Which of the following is not a specified method for dimensioning? 
  (a) chain dimensioning     (b) perpendicular dimensioning
  (c) parallel dimensioning   (d) progressive dimensioning

answers of multiple Choice questions

1.1 (c);  1.2 (b);  1.3 (d);  1.4 (c);  1.5 (a);  1.6 (c);  1.7 (b);  1.8 (b);  1.9 (d);  1.10 (b);  
1.11 (d);  1.12. (b);  1.13 (b);  1.14 (a);  1.15 (b)
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B. Subjective questions
1.1 Why is drawing called the language of engineers?
1.2 List the different types of drawing instruments.
1.3 List the standard sizes of the drawing boards according to BIS. Which size of drawing 

board is suitable for the practice of engineering students?
1.4 Name the angles that can be draw with the help of a pair of set squares.
1.5 How are pencil graded in an engineering drawing work? Describe shapes of the pencil lead 

along with their field of applications.
1.6 List the standard sizes of the drawing sheets according to BIS. Which size is suitable for 

technical drawing?
1.7 Explain the procedure to draw parallel lines drawn with the help of a set square? Explain 

with a neat sketch.
1.8 Explain the use of compass and dividers.
1.9 Explain layout of Drawing sheet with a neat sketch.
1.10 Specify the information that can be included in the title block of a drawing sheet?
1.11 State the various types of lines and their general application? 
1.12 Differentiate between the meaning of continuous thick and dashed thin lines.
1.13 Distinguish among a full size, a reduced size, and an enlarged size drawing.
1.14 Compare engineer's scale with graphical scale.
1.15 Explain with a neat sketch of dimensioning of different sizes of circles. 
1.16 Differentiate between aligned and unidirectional dimensioning system. 
1.17 Differentiate between chain and parallel dimensioning.
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As per curriculum the practicals related to Unit-1 are:
1. Draw horizontal, vertical, 300, 450, 600 and 750 lines, different types of lines, dimensioning 

styles using Tee and Set squares/ drafter. (do this exercise in sketch book)
2. Write alphabets and numerical (Vertical only) (do this exercise in sketch book)
3. Draw regular geometric constructions and redraw the given figure (do this exercise in sketch 

book) Part I.
4. Draw regular geometric construction and redraw the given figure (do this exercise in sketch 

book) Part II.

Practical-1 Draw lines and Dimensioning

Practical statement
Draw horizontal, Vertical, 30 degree, 45 degree, 60 and 75 degrees lines, different types of lines, 
dimensioning styles using Tee and Set squares/ drafter.

Practical significance
Usually complex drawings are created by combining and modifying several different basic primitive 
shapes, such as lines, circles, arcs, polygons etc.

Relevant theory
Refer Section 1.1.3 (Use of T-Square, Set-Squares and Drafter)
Refer Section 1.2 (Types of Lines)
Refer Section 1.4 (Dimensioning styles)

Practical outcomes (PrO)
The practical outcomes are derived from the curriculum of this course:

PrO1 Use T-Square and Set-Squares to draw lines at different orientations.
PrO2 Use appropriate line and dimension style.

Practical setup (Drawing/Sketch/Circuit Diagram/Work Situation)
1. Draw horizontal, vertical, 30 degree, 45 degree, 60 and 75 degrees lines using Tee and Set 

squares/ drafter.
2. Draw different types of lines using T and Set squares/ drafter.
3. Draw different dimensioning styles. 
4. Draw the following figure in sketch book:

PRaCtiCalS
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Resources required

Sr. 
no 

Suggested Resources Required
machines/tools/ instruments 

with Vital specifications
qty

actual Resources 
used machines/tools/ 

instruments with broad 
specifications

(to be filled by the student)

Remarks 
(if any)

1 Drawing Sheet / Sketch Book 1

2 Drawing Table with Drawing Board 1

3

Mini Drafter 
T-square
Set squares (450 and 300-600)
Protractor
Drawing instrument box (containing 
set of compasses and dividers)

1 
Set

4 Pencils and Pencil leads(H, HB, B) 3

5 Insulation Electric Tap 1N.
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Precautions
1. Fix the drawing sheet and drafter properly on the Drawing board.
2. Use appropriate type of pencil based on the type of line use.
3. Minimize the use of eraser.
4. While drawing keep a hanky/cloth under your hands to avoid patching on the sheet. 
5. Don’t use blades or paper cutters to sharpen the Pencils.

Suggested procedure
1. As outlined in section 1.1.3 of the book. (Use of T-Square, Set-Squares and Drafter)
2. As outlined in section 1.2 of the book. (Types of Lines)
3. As outlined in section 1.4 of the book. (Dimensioning Styles)
4. As outlined in the solution of problem 1.4

Observations and calculations
As shown in 1.13 to 1.17, Solution of Problem 1.4 of the book

Practical related questions
1. Explain the use of set squares.
2. Which method and combination of setsquares and T-squares should be used to create a 

perpendicular line to the given line?
3. Explain how Centre lines are drawn.

Disposal of waste
Classify the waste materials to be thrown in this experiment in the following bins:

Environment friendly approach: Reuse, Reduce and Recycle
Reuse: The drawing sheets should be used from both the sides.
Reduce: Depending on the number of exercises appropriate size of drawing sheet should be used to 
reduce wastage in the form of empty space.
Recycle: Five-year old drawing sheets can be recycled.

type of Waste Colour of Bins name of item

Biodegradable waste Green bin
Five-year old drawing sheets completed 

form both the sides. Pencil shavings during 
sharpening

e-Waste Black bin

Plastic and metal waste Blue bin

Any Other
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Suggested learning resources
Refer Unit-1

Suggested assessment scheme
(to be filled by teacher)
The given performance indicators should serve as a guideline for assessment regarding process and 
product related marks.

Performance indicators Weightage/
marks

marks 
awarded

Process related: 5 marks* (33%)

1 Fixing the drawing sheet properly 1

2
Use of appropriate pencil and instrument while 
drawing different entities

2

3
Not taking support of others to draw given 
problem(s)

2

Product related: 10 marks* (67%)

4
Neatness, Cleanliness on drawing sheet/sketch 
book 

1

5 Dimensional accuracy of the output 1

6 Uniformity in drawing and line work 1

7 Creating given drawing with all problems solved 5

8 Dimensioning the given drawing and writing text 1

9 Submission of drawing in time 1

total 100 %

* Marks and percentage weightages for product and process assessment will be decided by the teacher.

name of the Student: ……………………………………….. 
marks awarded

Signature of teacher 
with date

Process Related Product Related Total
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Practical-2 Write alphabets and numerical (Vertical only)

Practical statement
Print 10 mm single stroke capital letters and numerals in vertical style using either scale or setsquare 
and by free hand.

Practical significance
Apart from graphical elements (lines, arcs, circles etc) technical drawings will also contain written 
information. This written information is referred as “lettering”. While writing annotations like Text, 
Labels, Dimensions, Part list, Symbols, leaders, balloons etc., Alphabets and Numbers are to be hand 
written during manual drawing as per BIS SP:46-2003.

Relevant theory
Size of letters

•	 Size of Letters is measured by the height h of the CAPITAL letters as well as numerals. The 
standard heights recommended by BIS SP: 46-2003 are in the progressive ratio of “square root 
2”. They are namely 2.5 - 3.5 - 5 - 7 - 10 – 14 and 20 mm. The height of lower case letter 
(without tail or stem) are 2.5, 3.5, 5, 7, 10 and 14 mm. Size of the letters may be selected 
based upon the size of drawing.

Procedure for lettering
•	 Thin horizontal guide lines are drawn first at a distance ' h' apart.
•	 Horizontal lines of the letters are drawn from left to right. Vertical, Inclined and curved 

lines are drawn from top to bottom.
•	 After completing the lettering the guidelines should not be erased.

Practical outcomes (PrO)
The practical outcomes are derived from the curriculum of this course:

PrO1 Write text and numbers on the given 2D entity.

Practical setup (Drawing/Sketch/Circuit Diagram/Work Situation)
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Resources required
Same as mentioned in Practical-1

Precautions
Same as mentioned in Practical-1

Suggested procedure
1. Draw horizontal thin parallel lines (guide lines) of 10 mm distance. h = 10 mm distances 

denotes the height of the letter.
2. Mark the width of the letters recommended by BIS (IS:9609-1983). The width of different 

letters in terms of `d' is as follows. d indicates stroke thickness and is equal to h/10. For 
example, as per following table to write J the width should be (10/10 x4) =4mm

3. For curved letters use smooth free hand curve.
4. Print straight line letters using either scale or setsquares.
5. To maintain the uniform thickness of line, use conical point soft grade pencil and avoid too 

much of sharpness (HB).
6. Guidelines of both top and bottom should always be drawn with sharp pencil (2H).

Width
(w)

Capital letters

1
4
5
6

7
9

I
J

C, E, F, L
B,D,G,H,K,N,O,P,R,S,T,U & Z

A , M , Q , V , X , Y
W

Lettering
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Observations

Practical related questions
1. State the values of Height and Width of letters J and I if the guide lines are 10 mm apart.
2. State the values of Height and Width of numbers 6 and 1 if the guide lines are 10 mm apart.

Disposal of waste
Same as mentioned in Practical-1

Environment friendly approach: Reuse, Reduce and Recycle
Same as mentioned in Practical-1

Suggested learning resources
Refer Unit-1

Suggested assessment scheme
Same as mentioned in Practical-1
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Practical-3 Draw Regular Geometric Constructions-i

Practical statement
Draw regular geometric constructions. In a situation two pulleys are connected through a belt (Open 
belt arrangement), draw the setup with circles representing the pulleys and their external tangents 
representing the sides of the belt.

Practical significance
Complex 2D drawings are created using primitive shapes like Circles, Rectangles, Triangles, Polygons, 
and Ellipses etc. Hence student must know how to draw these geometrical shapes and their tangents.

Relevant theory
Refer Section 1.5 of the book.

Practical outcomes (PrO)
The practical outcomes are derived from the curriculum of this course:

PrO1  Draw regular geometric constructions and their tangents.

Practical setup (Drawing/Sketch/Circuit Diagram/Work Situation)
Diameter of larger Pulley = 40mm
Diameter of smaller Pulley = 30mm
Center distance between the pulleys = 60 mm

Resources required
Same as mentioned in Practical-1

Precautions
Same as mentioned in Practical-1

Suggested procedure
1. Draw a line of 60 mm and and mark two end points as C1 and C2.
2. With centre C1 and C2 draw two circles of diameters 40mm and 30mm respectively. 
3. Draw a concentric circle (D3) of dia 10 mm (40mm – 30mm) on 40mm circle (D1). 
4. From centre C2 draw a line 't' touching circle D3 at P.
5. Join C1 and P (angle P is right angle) and extend it up to the circle D1 meeting at P1.
6. Draw C2-P2 parallel to C1-P1.
7. Join P1 and P2 forming the (common) tangent T1 to circles D1 and D2.
8. Similarly draw tangent T2. Tangents T1 and T2 are called external tangents.
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Observations

Practical related questions
1. Identify the angle of wrap on the larger pulley.
2. If it is a cross belt situation how would be your approach to draw the tangents.

Disposal of waste
Same as mentioned in Practical-1

Environment friendly approach: Reuse, Reduce and Recycle
Same as mentioned in Practical-1

Suggested learning resources
Refer Unit-1

Suggested assessment scheme
Same as mentioned in Practical-1

C1 C2

90°D1

P1
P2

T1

T2

D2
D3 P

t
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Practical-4 Draw Regular Geometric Constructions-ii

Practical statement
Draw regular geometric constructions like a pentagon with a given length of side.

Practical significance
Complex 2D drawings are created using primitive shapes like Circles, Rectangles, Triangles, Polygons, 
and Ellipses etc. Hence student must know how to draw these geometrical shapes and their tangents.

Relevant theory
Refer Section 1.5 of the book.

Practical outcomes (PrO)
The practical outcomes are derived from the curriculum of this course:

PrO1  Draw regular geometric constructions and their tangents.

Practical setup (Drawing/Sketch/Circuit Diagram/Work Situation)
Regular Pentagon with 50mm side is given. One side of the Pentagon should be horizontal. Also 
draw an inscribed circle in the Pentagon drawn.

Resources required
Same as mentioned in Practical-1

Precautions
Same as mentioned in Practical-1

Suggested procedure
Method-1

1. Draw a line AB equal to the given length of side (50mm).
2. Bisect AB at P.
3. Draw a line BQ equal to AB in length and perpendicular to AB.
4. With centre P and radius PQ, draw an arc intersecting AB produced at R. AR is equal to 

the diagonal length of the pentagon.
5. With centers A and B and radii AR and AB respectively draw arcs intersecting at C.
6. With centers A and B and radius AR draw arcs intersecting at D.
7. With centers A and B and radii AB and AR respectively draw arcs intersecting at E.
8. ABCDE is the required pentagon.

Method-2
1. Draw a line AB equal to the length of the given side (60mm).
2. Draw a line B1 such that <AB 1 = 108° (included angle)
3. Mark C on Bl such that BC = AB
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4. Repeat steps 2 and 3 and complete the pentagon ABCDE
Inscribed Circle

1. Bisect any two angles by lines intersecting each other at O. 
2. From O, draw a perpendicular to any one side of the pentagon cutting it at P. 
3. With centre O and radius OP, draw the required circle.

Observations

Q

c

d

r
BPa

e

               
108°

108°

108°

c

d 1

B

2

a

e

3

c

d

BP

o

a

e

Practical related questions
1. How included angle was estimated in Method-2.
2. If a circumscribed circle is required, then what should be the approach.

Disposal of waste
Same as mentioned in Practical-1

Environment friendly approach: Reuse, Reduce and Recycle
Same as mentioned in Practical-1

Suggested learning resources
Refer Unit-1

Suggested assessment scheme
Same as mentioned in Practical-1
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DESiGn innoVatiVE PRaCtiCalS/PRoJECtS/ aCtiVitiES
Student shall form a group of 5-6 students and undertake one or two micro project(s)/activity(ies) 
under the guidance of faculty and present it as group with individual participation as well. A sample 
list is given below:

1 Draw parallel lines at 30° with horizontal by using T-square and set-squares.
2 Draw vertical lines, when one of the lines makes 15°, by using T-square and set-square.
3 Draw a line AB 70 mm long. Divide the line in to four equal parts by using the divider.
4 Construct the square by using a 45° set-square.
5 You have an A2 size drawing sheet and you want to make plan of a house with plot area 30 

feet by 50 feet on it. What value of R.F you will use?
6 Construct a graphical scale to measure a distance up to 50 feet. Take R.F value as 1/100

a. Least count should be 1 foot
b. Least count should be 1 inch

7 Draw a line 119 mm long at any angle and show the proper procedure for bisecting it.
8 Draw a line 150 mm long. Using the drafting tools, divide the line into 5 equal parts.
9 Construct a 450 angle with 75 mm sides. Bisect this angle.
10 Construct an angle of 150 by using compass and show the proper procedure. 
11 Construct an equilateral triangle of 60 mm height.
12 Construct a triangle having the base 50 mm, altitude 20 mm and one side 40 mm.
13 Construct a square by measuring only 60 mm side.
14 Through three points A, B and C, draw a circle where AB = 30 mm and BC = 20 mm.
15 From a point outside a circle of 100 mm diameter, draw two tangents containing an angle 

of 600.
16 Draw a circle about a triangle of sides 60 mm, 35 mm and 55 mm.
17 Draw two circles 50 mm diameter and 40 mm diameter respectively with centre 60 mm 

apart. Draw open-belt tangents to the circles.
18 Draw a hexagon within a circle of radius 35 mm.

19 Draw an octagon when the distance across the flats is 50 mm.

•	 Teacher and students shall collect few production/construction/electrical/electronics actual 
industrial component drawings.

•	 Teacher should download the free software available to demonstrate generation of drawing 
with virtual drawing instruments during class room sessions.

•	 During the input sessions the teacher must give examples related to the relevant branch viz. 

KnoW moRE
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mechanical and allied disciplines/electrical and allied disciplines/electronics etc.
•	 Show video/animation films to explain mentioned concepts.
•	 Use charts and industrial drawing/drawing sheets developed by experienced faculty to teach 

standard symbols and current industrial/teaching practices.
•	 Teachers should ask students to use url/qr codes available in the book for further 

understanding/practicing of the concepts.

applications (Real life / industrial)
1. Drawing instruments are used to prepare neat and accurate drawings viz. civil drawings, 

architectural drawings, structural drawings, mechanical systems drawings, electrical drawings, 
plumbing drawings etc.

2. Different types of lines used in construction of figures, geometrical shapes and objects, civil 
construction drawings, mechanical engineering drawings etc. In mechanical engineering 
drawings, lines types are used to represent the outlines of adjacent parts, extreme positions 
of movable parts in the assembly drawings. In building construction works, continuous 
narrow lines are used to represent doors, windows, stairs, ramps and sloping areas.

3. Geometric constructions are used while drawing components/features in mechanical drawing, 
civil drawing, production drawing, construction drawing, architectural drawing etc.; Head of 
the bolts; Nuts; Gear tooth; Sprocket tooth; Cams; Keyways; Specially designed doors and 
windows; Water bodies; Interior; Textile drawings.

4. In engineering drawing as soon as you start drawing any component whether it is from 
mechanical, electrical, civil, electronics etc., the very first thing is to choose a scale. Hence 
no object, element and component domestic or industrial can be drawn without scale.

5. Dimensioning is used to give information of any 2D and 3D entity on drawing sheet. 
Dimensioning is used in Engineering drawing, Machine drawing, Constructional drawing, 
Electrical wiring layout drawing, Electronics component and placement drawing, Production 
drawing, Orthographic views, isometric views etc. Dimensioning is also used to provide 
information of size related to components and features like-through hole, blind hole, stepped 
hole, counter dilled hole, countersunk hole, spot faced, thickness, height, length, width, radius, 
diameter, arc, chord length, curves, angle, repeated features, pitch length, taper, chamfer, 
fillet, restricted areas, undercut, slots, groove, screw, nut, stud, rivet, bolt, washer, seal, key, 
shaft, axel, stud, rod, lever, couplings, gears, chains, bearings, belts, doors, windows, truss, 
circuit layout, plumbing line, etc.

inquisitiveness and Curiosity
Other than the classroom and drawing practice sessions , following are the suggested student-related 
co-curricular activities which can be undertaken to accelerate the attainment of the various outcomes 
in this unit:

1. Students should collect Production drawings, Building Drawings, Layouts from nearby 
workshops/industries/builders/contractors and try to 
a. redraw types of lines used
b. redraw lettering styles used
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c. list BIS code referred and the symbols/annotations/dimensioning used
d. list the type of scales used. Compare the size of component on drawing sheet with 

actual component.
e. redraw the same with the help of basic drawing instruments and tools such as Minidafter, 

T-square, Compass, Set-squares , French curve etc. 
2. Students should collect some tourist map and try to find the distance between any two 

locations with the help of graphical scale drawn on it.
3. Surf the web and list the scale used in wrist watch. Observe the scale used for a drawing a 

hostel building, hospital building, 2BHK flat. Observe the scale used for a drawing a typical 
connecting rod of a bike. Observe a scale used for the drawing of integrated circuit.

4. Each student should explain at least one problem of geometrical construction to other students 
of his class in presence of course teacher.

5. Student should maintain a separate A3 size sketch book which will be the part of term work 
and submit it along with drawing sheets. Draw minimum 5 problems related to geometrical 
construction in the sketch book (The problems on sheet and in the sketch book should be 
different).

6. Student should identify and list at least five components related to their engineering branch 
where they have seen the used of geometrical construction

1. Engineering Drawing Practices for School and Colleges SP 46:2003, published by Bureau of 
Indian Standards, Government of India, Third Reprint, October 1998; ISBN:. 81-7061-091-2, 
Manak Bhavan , 9 Bahadur Shah Zafar Marg , New Delhi

2. A work book of Engineering Drawing by T.T.T.I., Bhopal, 1999
3. A text Book of Engineering Drawing, K Venkata Reddy, BS Publication, 2008
4. Bureau of Indian Standards: https://en.wikipedia.org/wiki/Bureau_of_Indian_Standards
5. Use of Virtual drawing instruments: https://www.triumphcloud.com/
6. Virtual drawing environment: https://www.mathspad.co.uk/

REFEREnCES & SUGGEStED REaDinGS
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UNIT SPECIFICS
•	 Concept	 and	Applications	of	orthographic,	perspective,	 isometric	 and	oblique	projections.
•	 Orthographic	projection,	First	 angle	 and	Third	angle	method,	 their	 symbols.
•	 Axonometric	projection
•	 Oblique	projection
•	 Perspective	projection	
•	 Conversion	of	pictorial	 view	 into	orthographic	views.

The	understanding	of	these	topics	will	be	developed	after	reading	the	contents,	completing	the	solved	
problems,	activities,	performing	exercises	and	viewing	the	ICT	and	web	resources	mentioned	 in	 this	
unit.

At	 the	end	of	 the	unit,	 summary	 is	provided	to	recapitulate	 the	 topics	covered	and	applications	
are	mentioned	so	that	the	learner	can	correlate	the	presented	knowledge	with	real	 life	and	industrial	
situations.	Few	activities	are	mentioned	to	create	inquisitiveness	and	curiosity	in	the	learner.	Subjective	
and	objective	questions	are	provided	for	 the	reinforcement	of	 the	knowledge	and	a	 list	of	references	
and	 suggested	 readings	 is	 also	 provided	 for	 further	 learning.	Video	 resources	 along	with	QR	 codes	
are	 mentioned	 for	 getting	 more	 information	 on	 various	 topics	 of	 interest	 which	 can	 be	 surfed	 or	
scanned	 through	mobile	phone	 for	viewing.	Practical	with	details	 are	provided	 to	horn	 the	drawing	
and	drafting	 skills.

RaTIoNalE
When	you	desire	to	make	drawing	of	an	object,	then	the	first	decision	that	you	have	to	take	is,	what	
type	of	drawing	you	want	to	make?	If	you	are	communicating	shape	and	size	of	an	object	to	a	layman,	
you	make	a	pictorial	drawing	show	three	dimensional	image	of	object.	But	if	you	are	communicating	
with	 technical	 person,	 then	 in	 addition	 to	 pictorial	 drawing,	 you	may	 even	 go	 for	 an	 orthographic	
drawing	 and	 sectional	 orthographic	 drawing.	The	 advantage	 of	 orthographic	 drawing	 and	 sectional	
orthographic	drawing	 is	 you	can	 show	details	more	clearly	 and	precisely.	

PRE-REqUISITES
Before	 reading	 this	unit	 the	 student	 is	 advised	 to	 revisit	 following:	

•	 Maths:	 coordinate	 and	plane	geometry
•	 Unit-1	of	 this	book	
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UNIT oUTComES
After	reading	the	contents,	completing	the	solved	problems,	activities,	exercises	and	viewing	the	ICT		
and	web	 resources	mention	 in	 this	unit	 the	 students	 are	 expected	 to:	

U2-O1:		Explain	the	concept	and	applications	of	orthographic,	perspective,	isometric	and	oblique	
	 	 	 	 	 	 	 	 	 	 	Projections
U2-O2:	 	Differentiate	between	First	 angle	 and	Third	angle	projection	methods	alongwith	 their	
	 	 	 	 	 	 	 	 	 	 	 symbol	 specified	by	BIS	 	
U2-O3:		Draw	the	orthographic	views	in	First	Angle	Projection	from	given	pictorial	views	of	object	
	 	 	 	 	 	 	 	 	 	 containing	plain	 surfaces,	 slanting	 surfaces,	 slots,	 ribs,	 cylindrical	 surfaces.

2.1 CoNCEPT aNd aPPlICaTIoNS oF oRThogRaPhIC, PERSPECTIvE, 

ISomETRIC aNd oblIqUE PRojECTIoNS 

2.1.1 Introduction to Projections
Projection	 means	 that	 you	 project	 image	 of	 an	 object	 on	 a	 plane.	 Key	 concepts	 important	 for	
understanding	 the	meaning	of	word	projection	are:

Object
In	 Fig.2.1	 (a)	 and	 (b)	 rectangle	
ABCD	 is	 the	 object.	The	object	 can	
be	 a	 point,	 line,	 plane,	 solid	 or	 a	
sectioned	solid	whose	image	you	are	
trying	 to	project.

Plane of projection
It	is	the	plane	on	which	you	project	
the	 image	of	object.	 It	 is	 also	 called	
reference	plane	or	picture	plane.

Unit-2
outcome

EXPECTEd maPPINg WITh CoURSE oUTComES
(1- Weak Correlation; 2- Medium Correlation; 3- Strong Correlation)

Co-1 Co-2 Co-3 Co-4 Co-5 Co-6

U2-o1 3 2 3 3 2 -

U2-o2 3 3 3 2 3 2

U2-o3 3 1 2 2 2 1

Fig.2.1: Perspective projection versus parallel projection
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The station point
It	is	the	point	from	which	the	projectors	start.	In	perspective	projection	the	station	point	is	at	a	finite	
distance	whereas	 in	parallel	projection	 the	 station	point	 is	 at	 infinity.

Projectors
Projectors	 are	 the	 straight	 lines	 drawn	 from	 contour	 points	 or	 corner	 points	 of	 the	 object	 on	 the	
plane	of	projection.	

Projection
When	piercing	point	of	projectors	and	plane	of	projection	are	joined	in	proper	sequence	you	get	the	
projection	of	 the	object.

2.1.2 Classification of Projection methods
Projection	methods	are	 classified	 into	 two	broad	categories

1.	Perspective	projection	 {Fig.2.1(a)}
2.	Parallel	projection	 {Fig.2.1(b)}

Perspective projection
Fig.2.1	 gives	 a	 comparative	 pictorial	 description	 of	 parallel	 projection	 and	 perspective	 projection.	
Fig.2.1(a)	 shows	 the	 concept	 of	 perspective	 projection.	 Observe	 that	 in	 perspective	 projection	 the	
projectors	converge	to	a	point	called	station	point.	Fig.2.1(b)	shows	the	concept	of	parallel	projection.	
Observe	 that	 in	 parallel	 projection,	 projectors	 are	 parallel	 to	 each	 other	 i.e.,	 the	 station	 point	 is	 at	
infinity.	

Parallel projection
When	parallel	projectors	 are	drawn	 from	contour	of	object	on	 the	picture	plane	or	 reference	plane,	
then	figure	obtained	on	 joining	piercing	point	of	projectors	and	reference	plane	 in	proper	 sequence	
is	 called	 the	parallel	 projection	of	 the	object	 on	 reference	plane.	Parallel	 projection	 is	 classified	 into	
two	 subcategories
1.Oblique	projection	 {Fig.2.2	 (a)}
2.Orthographic	projection	{Fig.2.2	(b)}
The	 key	 differentiating	 point	 is,	 in	
oblique	 projection	 projectors	 are	
inclined	 to	 the	 plane	 of	 projection,	
whereas	 in	 orthographic	 projection,	
the	projectors	are	always	perpendicular	
to	 the	plane	of	projection.

Fig.2.3	gives	detailed	classification	
of	 different	 methods	 of	 making	 a	
drawing.	Except	multiview	projection	
all	 other	 drawings	 are	 pictorial	
drawing. Fig.2.2: Oblique projection versus orthographic projection
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2.2 oRThogRaPhIC PRojECTIoN 
The	only	 two	necessary	and	 sufficient	 condition	 for	orthographic	projection	are

1.	 Projectors	 should	be	parallel	 to	 each	other	and
2	 Projectors	 should	be	perpendicular	 to	plane	of	projection

Fig.2.3: Classification of projection methods

Fig.2.4: Pictorial view of 3D arrangement for orthographic projection of a solid

Introduction to 
Orthographic 

Projections

Fig.2.4	(a)	shows	pictorial	view	of	3D	arrangement	for	orthographic	projection	of	a	solid.	The	face	of	
solid	 containing	maximum	 information	 is	kept	parallel	 to	 the	plane	of	projection.	Fig.	 2.4(b)	 shows	
separately	the	orthographic	projection	of	solid	placed	as	shown	in	Fig.	2.4(a).	Notice	that	orthographic	
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2.2.1 multiview orthographic Projection of Solid
In	 Fig.2.4(a)	 orthographic	 projection	 of	 the	
solid	 is	 giving	 information	 only	 about	 the	
width	 and	 height	 of	 solid.	 For	 information	
about	 depth	 another	 orthographic	 view	
showing	 depth	 is	 required.	 Hence	 the	 need	 of	
multiview	orthographic	projection.	In	multiview	
orthographic	 projection	 you	 project	 multiple	
orthographic	 views	 of	 the	 solid	 from	 different	
directions.

In	 multiview	 orthographic	 projection	
(Fig.2.6),	observer	views	the	object	from	multiple	
directions	 i.e.,	 the	 projectors	 are	 drawn	 along	
different	 directions	 ‘a’,	 ‘b’,	 ‘c’,	 ‘d’,	 ‘e’	 &	 ‘f’	 and	
view	 projected	 on	 respective	 projection	 planes.	
As	shown	in	Fig.2.8	the	most	informative	view,	of	
the	object	to	be	represented	is	normally	chosen	
as	 the	 principal	 view	 (front	 view).	This	 view	 is	
named	‘A’	as	the	direction	of	viewing	is	‘a’.	Plane	
of	 solid	 containing	maximum	 information	 is	kept	perpendicular	 to	 ‘a’	direction	of	projectors.

As	per	 IS	 sp-46	 the	designation	of	views	 is	 as	given	 in	 table	2.1.

projection	 obtained	 is	 giving	 information	 only	 about	 width	 and	 height	 of	 solid	 but	 it	 is	 giving	 no	
information	about	 the	depth	of	 solid.	Hence	more	orthographic	views	 required.
Fig.2.5	(a)	shows	orthographic	projection	of	a	solid	when	all	three	mutually	perpendicular	coordinate	
axis	of	solid	are	equally	inclined	to	the	plane	of	projection.	The	angle	of	X,	Y	and	Z	axis	of	solid	with	
plane	of	projection	is	36.46°.	Such	type	of	orthographic	projection	is	called	 isometric	projection	and	
it	 will	 be	 discussed	 in	 full	 details	 in	 chapter	 3.	 Dashed	 line	made	 in	 Fig.2.5	 (b)	 represent	 invisible	
lines	 from	direction	of	 looking.	General	practice	 is	 to	 avoid	dashed	 lines	 in	 isometric	drawing.

Fig.2.5: (a) Orthographic projection of a solid when all three mutually perpendicular coordinate 
axis of solid are equally inclined to the plane of projection and (b) Isometric projection

Fig.2.6: Multiview orthographic projection approach
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Table 2.1: Designation of views

direction of observation designation of view

View from direction ‘a’ is called view from front A

View from direction ‘b’ is called view from above B

View from direction ‘c’ is called view from left C

View from direction ‘d’ is called view from right D

View from direction ‘e’ is called view from bottom E

View from direction ‘f’ is called view from rear F

2.2.2 Concept of Four quadrant
To	get	complete	information	about	shape	and	size	of	an	object,	orthographic	projection	of	an	object	
are	 taken	 on	 at	 least	 two	 mutually	 perpendicular	 planes.	 Fig.2.7	 illustrates	 the	 four	 quadrants	 or	
dihedral	 angle.	

1.	 A	quadrant	consists	of	two	principal	planes	of	
projection	 inclined	 to	 each	 other	 at	 an	 angle	
of	90°.

2.	 The	 vertical	 reference	 plane	 V.P.	 and	 the	
horizontal	 reference	 plane	 H.P.	 divides	 the	
space	in	four	regions.	Once	front	direction	of	
looking	‘a’	and	top	direction	of	looking	‘b’	are	
mentioned	 then	we	 can	define	first	quadrant,	
second	 quadrant,	 third	 quadrant	 and	 fourth	
quadrant	 as	 shown	 in	Fig.2.7.

3.	 First	 quadrant	 is	 region	 of	 space	 above	 H.P.	
and	 in	 front	of	V.P.

4.	 Second	quadrant	is	region	of	space	above	H.P	
and	behind	V.P.

5.	 Third	quadrant	 is	 region	of	 space	below	H.P	and	behind	V.P.
6.	 Fourth	quadrant	 is	 region	of	 space	below	H.P	and	 in	 front	of	V.P.

View from front or elevation or front view
Fig.2.8	 shows	 the	pictorial	arrangement	 for	obtaining	view	 from	front	or	elevation	or	 front	view.	 In	
multiview	orthographic	projection,	to	obtain	view	from	front	of	the	solid,	you	keep	most	informative	
face	of	 solid	parallel	 to	 the	vertical	 reference	plane	V.P.	Direction	of	projector	 is	along	direction	 ‘a’.	
Piercing	 point	 of	 projectors	 and	 V.P.	 are	 joined	 in	 proper	 sequence	 to	 obtain	 view	 from	 front	 of	

Fig.2.7: Four quadrants or dihedral angle
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the	solid.	Note	 that	 in	Fig.2.8	view	from	front	 is	giving	 information	about	width	and	height	of	solid	
model	but	 it	 is	not	giving	 information	about	depth	of	 solid	model.

View from above or plan or top view
Fig.2.9	 shows	 the	 pictorial	 view	 of	 3D	 arrangement	 for	 obtaining	 view	 from	 above	 or	 plan	 or	 top	
view	of	the	solid	model.	Direction	of	projector	is	along	direction	‘b’	and	the	projection	plane	H.P.	 is	
perpendicular	 to	 the	direction	 ‘b’.	 	Note	 that	depth	and	width	of	 the	 solid	model	are	visible	 in	view	
from	above	but	height	 is	not	visible.

In	Fig.2.10	the	flat	chamfer	surface	 is	replaced	by	a	vertical	and	horizontal	surface	but	still	 then	
both	 view	 from	 above	 and	 view	 from	 front	 are	 same.	That	means	 only	 view	 from	 above	 and	 view	
front	are	not	able	 to	explain	the	shape	and	size	of	solid	model	shown,	view	from	left	or	right	 is	also	
required.

Fig.2.8: Pictorial view of 3D object with chamfer 
for obtaining view from front

Fig.2.9: Pictorial view of 3D object with chamfer for 
obtaining view from above

Fig.2.10: Pictorial view of 3D object with a step for obtaining top view
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View from left

Fig.2.11(a)	gives	the	pictorial	arrangement	for	obtaining	the	left	side	view	of	the	solid.	Notice	that	the	
side	view	gives	information	about	the	depth	and	height	of	solid	model	but	it	does	not	give	information	
about	width	of	the	solid	model.	Depth	information	is	also	available	in	top	view	and	height	information	
is	also	available	 in	 front	view	then	what	 is	 the	necessity	of	side	view?	On	comparing	Fig.2.11(a)	and	
Fig.2.11(b)	 you	 reach	 the	 conclusion	 that,	 to	 show	 that	 it	 is	 a	 chamfer	 surface	 and	 not	 a	 step	 side	
view	 is	 the	 required	view.

2.2.3 methods for multiview orthographic Projection
IS-sp	46	defines	 two	methods	 for	drafting	multiview	orthographic	projections.	

1.	 First	 angle	projection	method,	 and	 	 	
2.	 Third	angle	projection	method

First angle projection method 
The	key	 point	 about	 first	 angle	 projection	method	 for	multiview	 orthographic	 projection	 of	 a	 solid	
is	 that,	object	 lies	between	 the	observer	and	plane	of	projection.	Another	way	of	 thinking	 is,	 in	first	
angle	projection	method	object	 is	positioned	 in	first	quadrant	 i.e.,	 in	 front	of	V.P.	 and	above	H.P.

Fig.2.12	shows	the	pictorial	drawing	for	object	kept	in	first	quadrant	i.e.,	above	H.P.	and	in	front	
of	 V.P.	When	 projectors	 are	 projected	 along	 front	 direction	 ‘a’	 perpendicular	 to	 vertical	 reference	
plane	 orthographic	 projection	 is	 obtained	 on	 the	 vertical	 reference	 plane,	 and	 is	 called	 view	 from	
front	or	elevation.	View	from	front	or	elevation	gives	information	about	width	and	height	of	the	solid	
model.	When	 projectors	 are	 projected	 along	 top	 direction	 ‘b’	 perpendicular	 to	 horizontal	 reference	
plane,	 then	orthographic	projection	 is	obtained	on	 the	horizontal	 reference	plane	and	 is	 called	view	
from	 above	 or	 top.	View	 from	 above	 gives	 information	 about	width	 and	 depth	 of	 the	 solid	model.	
When	 projectors	 are	 projected	 along	 left	 direction	 ‘c’	 perpendicular	 to	 the	 side	 reference	 plane	 or	
profile	 plane,	 then	 orthographic	 projection	 is	 obtained	 on	 the	 profile	 plane	 and	 is	 called	 view	 from	
left.	View	 from	 left	gives	 information	about	depth	and	height	of	 the	 solid	model.

Fig.2.11: (a) Pictorial arrangement for obtaining the left side view of the solid with chamfer
       (b) Pictorial arrangement for obtaining the left side view of the solid with step
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Now	when	you	want	to	draw	the	multiple	orthographic	views	of	the	solid	model	on	a	2-dimensional	
plane	paper	you	require	to	make	all	the	projection	planes	coplanar.	In	first	angle	projection	method,	
it	 is	 customary	 to	 revolve	 the	H.P.	 about	 its	 line	 of	 intersection	with	 vertical	 reference	 plane	 by	 an	
angle	of	 90°,	 so	 that	 it	 becomes	 coplanar	with	V.P.	 and	 comes	below	 the	vertical	 reference	plane	 as	
shown	 in	 Fig.2.13(a).	 Curved	 arrowheads	 in	 Fig.2.12	 shows	 the	 direction	 in	 which	 H.P.	 is	 rotated	
and	Fig.2.13	 (a)	 shows	 the	pictorial	drawing	after	H.P.	 is	 rotated.	 Similarly,	 in	first	 angle	projection	
method,	it	is	customary	to	revolve	the	profile	plane	about	its	line	of	intersection	with	vertical	reference	
plane	by	an	angle	of	90°	so	that	it	becomes	coplanar	with	V.P.	and	comes	at	the	same	level	as	vertical	
reference	 plane.	 Arrowheads	 in	 Fig.2.12	 shows	 the	 direction	 in	 which	 profile	 plane	 is	 rotated	 and	
Fig.2.13	(a)	shows	the	pictorial	drawing	after	profile	plane	is	rotated.	Fig.2.13	(b)	shows	final	multiview	
orthographic	projection	of	 the	solid	by	first	angle	projection	method.	Notice	 that	 line	which	are	not	
visible	 are	made	dashed.

For	 this	 simple	 solid	 only	 three	 views	 are	 enough	 and	 there	 all	 six	 orthographic	 views	 are	 not	
shown.

Fig.2.12: The pictorial drawing for an object kept in first quadrant

Fig.2.13: (a) Pictorial drawing of an object after profile plane is rotated  (b) Multiview orthographic 
projection of the object by first angle projection method

First and 

Third Angle 

Orthographic 

Projections
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Fig.2.14(a)	shows	the	symbol	for	orthographic	drawings	made	in	first	angle	projection	system.	Pictorial	
view	 in	 Fig.2.14(b)	 shows	 that	 when	 a	 frustum	 of	 a	 cone	 is	 positioned	 in	 first	 quadrant	 such	 that	
its	axis	 is	parallel	 to	H.P.	and	V.P.	 then	 its	 front	view	and	 left	side	view	are	used	as	 symbol	 for	first	
angle	projection	 system.

Third angle projection method
The	key	point,	about	third	angle	projection	method	
for	drafting	multiview	orthographic	projections	of	
a	solid	is	that,	transparent	plane	of	projection	lies	
between	 the	 observer	 and	 object.	 Another	 way	
of	 thinking	 is,	 in	 third	 angle	 projection	method	
object	is	positioned	in	third	quadrant	i.e.,	behind	
V.P.	 and	below	H.P.

Fig.2.15	 shows	 the	 pictorial	 drawing	 for	
object	 kept	 in	 third	 quadrant	 i.e.,	 below	 H.P.	
and	 behind	 V.P.	 To	 obtain	 view	 from	 front	 or	
elevation,	 projectors	 are	 projected	 along	 front	
direction	 ‘a’ toward	 the	 contour	 points	 of	 the	
solid	 model	 and	 perpendicular	 to	 transparent	
vertical	 reference	 plane.	 Notice	 that	 the	 vertical	
reference	 plane	 is	 lying	 between	 observer	 and	
object.	 	 Front	 view	 or	 elevation	 is	 obtained	 on	
the	vertical	 reference	plane	by	 joining	 in	proper	
sequence	piercing	points	of	projector	and	vertical	
reference	 plane.	 View	 from	 front	 or	 elevation	
gives	 information	about	width	and	height	of	 the	
solid	model.

To	 obtain	 view	 from	 above	 or	 top,	 projectors	 are	 projected	 along	 above	 direction	 ‘b’	 toward	
the	 contour	 points	 of	 the	 solid	model	 and	 perpendicular	 to	 transparent	 horizontal	 reference	 plane.	
Notice	 that	 the	 horizontal	 reference	 plane	 is	 lying	 between	 observer	 and	 object.	 View	 from	 above	

Fig.2.14: (a) Symbol for orthographic drawings made in first angle projection system
(b) A frustum of a cone is placed in first quadrant with its axis parallel to H.P. and V.P.

Fig.2.15: Pictorial drawing for an object kept             
in third quadrant

Fig.2.15: Pictorial drawing for an object kept in 
third quadrant
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or	 top	 is	 obtained	 on	 the	 horizontal	 reference	 plane	 by	 joining	 in	 proper	 sequence	 piercing	 points	
of	projector	 and	horizontal	 reference	plane.	View	 from	above	or	 top	gives	 information	about	width	
and	depth	of	 the	 solid	model.	

To	 obtain	 left	 side	 view,	 projectors	 are	 projected	 along	 above	 direction	 ‘c’	 toward	 the	 contour	
points	 of	 the	 solid	 model	 and	 perpendicular	 to	 transparent	 side	 reference	 plane	 or	 profile	 plane.	
Notice	 that	 the	 side	 reference	plane	 is	 lying	 between	observer	 and	object.	View	 from	 left	or	 plan	 is	
obtained	on	 the	 side	 reference	plane	by	 joining	 in	proper	 sequence	piercing	points	of	projector	and	

side	 reference	plane.	View	 from	 left	gives	 information	about	height	 and	depth	of	 the	 solid	model.
Now	when	you	want	to	draw	multiple	orthographic	views	of	the	solid	model	on	a	2-dimensional	

plane	paper,	you	require	to	make	all	the	projection	planes	coplanar.	In	third	angle	projection	system,	
it	 is	 customary	 to	 revolve	 the	H.P.	 about	 its	 line	 of	 intersection	with	 vertical	 reference	 plane	 by	 an	
angle	 of	 90°	 so	 that	 it	 becomes	 coplanar	with	V.P.	 and	 comes	 above	 the	 vertical	 reference	 plane	 as	
shown	in	Fig.2.16(a).	Curved	arrowheads	in	Fig.2.15	shows	the	direction	in	which	H.P.	is	rotated	and	
Fig.2.15(a)	 shows	 the	pictorial	drawing	after	H.P.	 is	 rotated.	Similarly,	 in	 third	angle	project	 system,	
it	 is	customary	to	revolve	the	profile	plane	about	 its	 line	of	 intersection	with	vertical	reference	plane	
by	 an	 angle	 of	 90°	 so	 that	 it	 becomes	 coplanar	 with	 V.P.	 and	 comes	 at	 the	 same	 level	 as	 vertical	
reference	plane.	Curved	arrowheads	 in	Fig.2.15	shows	the	direction	 in	which	profile	plane	 is	rotated	
and	 Fig.2.16(a)	 shows	 the	 pictorial	 drawing	 after	 profile	 plane	 is	 rotated.	 Fig.2.16	 (b)	 shows	 final	
orthographic	projection	of	solid	by	third	angle	projection	method.	Notice	that	line	which	is	not	visible	
is	made	dashed.	For	this	simple	solid	only	three	views	are	enough	and	therefore	all	six	orthographic	
views	are	not	 shown.

Fig.2.17(a)	 shows	 the	 symbol	 for	orthographic	drawings	made	 in	 third	angle	projection	system.	
Pictorial	 view	 in	 Fig.2.17(b)	 shows	 that	 when	 a	 frustum	 of	 a	 cone	 is	 positioned	 in	 third	 quadrant	
such	that	its	axis	is	parallel	to	H.P.	and	V.P.	then	its	front	view	and	left	side	view	are	used	as	symbol	
for	 thired	angle	projection	 system.

Based	on	the	above	illustrations,	it	is	quite	evident	that	the	views	obtained	by	the	two	methods	of	
projection	is	completely	identical	in	shape,	size	and	all	other	details.	The	difference	lies	in	their	relative	
positions	only.	Table	2.2	 shows	 the	 comparison	of	first	 angle	 and	 third	angle	projection	methods.

Fig.2.16: (a) Pictorial drawing of an object after profile plane is rotated 
(b) Multiview orthographic projection of the object by third angle projection method
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Table 2.2: Comparison of first angle and third angle projection method

Sl. 
No. First angle Third angle

1.
Object is kept above H.P. and in front 
of V.P. (i.e. in first quadrant) 

Object is kept below H.P. and behind 
the V.P. (i.e. in third quadrant)

2. Top view is below the front view Top view is above the front view 

3.
Right hand side view is on the left hand 
side of the front view 

Right hand side view is right hand 
side of the front view. 

4.
Left hand side view is on the right hand 
side of the front view. 

Left hand side view is on the left hand 
side of the front view. 

5.
Picture plane is placed behind the object 
with respect to observer. 

Picture plane is placed in front of 
object with respect to observer. 

6.
Each view represents the side of the 
object remote from it in the adjacent view. 

Each view represents the side of the 
object near to it in the adjacent view. 

2.3 aXoNomETRIC PRojECTIoN
Single	 view	parallel	 orthographic	 projection	obtained	when	X,	Y	 and	Z	 axis	 of	 solid	 are	 inclined	 to	
plane	 of	 projection	 is	 called	 axonometric	 projection.	Main	 advantage	 of	 Axonometric	 projection	 is	
it	 gives	3-	dimensional	 image	of	 the	object.

Axonometric	 projections	 are	 further	 classified	 into	 three	 sub	 categories,	 namely,	 Isometric,	
Dimetric	 and	Trimetric	projections	 (Fig.2.18).	

Fig.2.17: (a) Symbol for orthographic drawings made in third angle projection system
(b) A frustum of a cone is placed in third quadrant with its axis parallel to H.P. and V.P.
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2.3.1 Isometric Projection 
When	 all	 three-coordinate	 axis	 of	 solid	 are	 equally	 inclined	 to	 plane	 of	 projection	 then	 the	 single	
view	 orthographic	 projection	 obtained	 is	 called	 isometric	 projection.	 Fig.	 2.5	 shows	 the	 isometric	
projection	of	 a	 solid.	Notice	 that	 it	 gives	 a	3-	dimensional	 image	of	 the	object.	 Isometric	projection	
will	be	discussed	 in	detail	 in	 chapter-3.

2.3.2 dimetric Projection
When	 two-coordinate	 axis	 of	 solid	 are	 equally	 inclined	 to	 plane	 of	 projection,	 and	 the	 third	 axis	
is	 inclined	 at	 a	 different	 angle	 to	 plane	 of	 projection	 then	 the	 single	 view	 orthographic	 projection	
obtained	 is	 called	dimetric	projection.

2.3.3 Trimetric Projection
When	all	three-coordinate	axis	of	solid	are	inclined	at	different	angle	to	plane	of	projection,	then	the	
single	view	orthographic	projection	obtained	 is	 called	 trimetric	projection.
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120°120° 120°
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Fig. 2.18: Axonometric projections: Isometric, Dimetric and Trimetric projections

2.4 oblIqUE PRojECTIoN
Single	 view	 parallel	 projection	 when	 projectors	 are	 inclined	 to	 the	 projection	 plane	 at	 angle	 other	
than	90°	 is	 called	oblique	projection

Fig.2.19	 shows	 the	pictorial	view	of	oblique	and	orthographic	projection	of	a	 cube	and	Fig.2.20	
shows	 the	 actual	 oblique	 and	 orthographic	 projection	 of	 the	 same	 cube.	 Generally,	 you	 imagine	
the	 face	 of	 solid	 containing	maximum	 information	 parallel	 to	 the	 projection	 plane.	 In	 the	 oblique	
projection,	 you	 see	 true	 shape	 and	 size	 of	 the	 plane	 of	 solid	 parallel	 to	 projection	plane.	 Projection	
of	lines	perpendicular	to	projection	plane	is	called	receding	lines.	Though	theoretically	receding	lines	
can	 be	 drawn	 at	 any	 angle	 general	 practice	 is	 to	 draw	 receding	 lines	 at	 angle	 of	 30°,	 45°,	 60°.	 You	
get	 a	pictorial	 3-dimensional	view	of	 the	 solid	 in	oblique	projection.
Oblique	projection	 is	 further	 classified	 in	 three	 sub	categories:	

2.4.1 Cavalier oblique Projection
Projection	of	 lines	perpendicular	 to	projection	plane,	 i.e.,	 receding	 lines,	 appear	 to	be	of	 true	 length	
in	 cavalier	 oblique	 projection.	This	 is	 possible	 only	 when	 in	 3-dimension	 angle	 between	 projectors	
and	projection	plane	 is	45°.
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2.4.2 Cabinet oblique Projection
Fig.2.21	shows	in	pictorial	view,	the	Cabinet	oblique	projection	and	orthographic	projection	of	a	cube	
and	Fig.2.22	shows	the	actual	Cabinet	oblique	projection	and	orthographic	projection	of	the	same	cube.	
Receding	 lines	 i.e.,	 projection	 of	 lines	 perpendicular	 to	 projection	 plane	 appear	 to	 be	 of	 half	 true	
length.	This	 is	 possible	 only	when	 in	 3-dimension	 angle	 between	projectors	 and	projection	plane	 is	
tan-1(2)=63.43°.	On	comparing	Fig.2.20	and	Fig.2.22	you	conclude	that	cabinet	oblique	projection	gives	
a	more	proportionate	3-dimensional	 look	of	 the	 cube	compared	 to	 its	 cavalier	oblique	projection.

Fig.2.21: Pictorial drawing of concept of cabinet 
oblique projection of a cube

Fig.2.22: Cabinet oblique projection of a cube

Fig.2.20: Cavalier oblique projection of a cubeFig.2.19: Pictorial drawing of concept of cavalier 
oblique projection of a cube
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2.4.3 general oblique Projection
Receding	lines	i.e.,	line	perpendicular	to	projection	plane	appear	to	be	reduced	length	in	any	arbitrary	
proportion.	That	is	in	3-dimension	angle	between	projectors	and	projection	plane	is	having	any	value	
except	45°and	63.43°and	90°and	0°.
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Though	 all	 three	 methods	 of	 oblique	 projection	 given	 unnatural	 view	 of	 the	 object,	 still	 then	
cabinet	projection	 is	more	near	 to	actual	 view.	Main	advantage	of	oblique	projection	 is	

1.	 oblique	projection	can	be	drawn	 faster
2.	 	 In	oblique	projection	you	 see	 true	 shape	and	 size	of	plane	parallel	 to	projection	plane
3.	 	oblique	projection	gives	 a	 reasonably	 informative	pictorial	 view	of	 the	 solid.

2.5 PERSPECTIvE PRojECTIoN
There	are	various	methods	for	drawing	pictorial	3-dimension	drawing	of	a	solid.	Some	of	them	are	 :

1.	 Cavalier	oblique	projection
2.	 Cabinet	oblique	projection
3.	 Isometric	projection
4.	 Diametric	projection
5.	 Trimetric	projection
6.	 Perspective	projection

Best	 approximation	 of	 the	 view	 seen	 by	 human	 eye	 is	 perspective	 projection.	 It	 is	 3-dimensional	
representation	 of	 an	 object	 on	 a	 plane	 surface,	 as	 it	 would	 appear	 to	 the	 eye	 when	 viewed	 from	 a	
fixed	position.

Fig.2.23	shows	a	pictorial	view	describing	how	perspective	projection	is	obtained	in	3-dimensions.	
A	picture	plane	is	placed	between	observer	eye	and	object.	Projectors	are	drawn	from	corner	points	of	
the	steps	model	to	the	observer	eye.	Points	of	 intersection	of	projectors	and	picture	plane	are	 joined	
in	proper	 sequence	 to	obtain	 the	perspective	of	 the	object	on	 the	picture	plane.

Perspective	projection	 is	 further	classified	 into	 three	categories	depending	on	 the	orientation	of	
X,	Y	&	Z	axis	of	 the	object	 relative	 to	picture	plane.

2.5.1 one-Point Perspective Projection
When	two	axes	of	a	solid	are	parallel	to	picture	plane	then	it	is	called	one-point	perspective	projection.	
Fig.2.23	 shows	 a	 pictorial	 view	 showing	 relative	 position	of	 object	 and	picture	 plane	 to	 obtain	 one-
point	perspective	projection.	Fig.2.24	shows	the	one-point	perspective	projection	of	the	model	of	steps.

Fig.2.23: Pictorial view describing how perspective 
projection is obtained in 3-dimensions

Fig.2.24: One-point perspective 
projection of the model of steps.
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2.5.2 Two-Point Perspective Projection
When	only	 one	 axes	 of	 a	 solid	 is	 parallel	 to	 picture	 plane	 and	 the	 remaining	 two	 axes	 are	 inclined	
to	picture	plane,	 then	 it	 is	 called	 two-point	perspective	projection.

Fig.2.25	 shows	 a	 pictorial	 view	 showing	 relative	 position	 of	 object	 and	 picture	 plane	 to	 obtain	
two-point	 perspective	 projection.	Only	 vertical	 lines	 are	 parallel	 to	 the	 plane	 of	 projection.	 Fig.2.26	
shows	 the	 two-point	perspective	projection	of	 the	model	of	 steps.

2.5.3 Three-Point Perspective Projection
When	all	 three	axes	of	a	 solid	are	 inclined	 to	picture	plane	 then	 the	perspective	projection	obtained	
is	 called	 three-point	perspective	projection.

Further	discussion	on	perspective	projection	 like	how	 to	draw	 the	perspective	projection	 is	out	
of	 scope	of	 this	book.

2.6 CoNvERSIoN oF PICToRIal vIEWS INTo oRThogRaPhIC vIEWS
Multiview	orthographic	projection	has	the	distinct	advantage	of	clarity	and	details	compared	to	pictorial	
drawings.	Hence,	operator	on	 the	 shop	floor,	 is	 generally	provided	with	 the	multiview	orthographic	
drawings.	To	show	internal	details	more	clearly,	he	is	also	provided	multiview	sectional	orthographic	
drawings.	 Hence	 ability	 to	 convert	 pictorial	 views,	 or	 3D	 solid	 into	 orthographic	 views	 is	 of	 key	
importance	 for	 an	engineer	working	 in	design	and	drawing	department.

Whenever	you	are	required	to	make	multiview	orthographic	projection	of	a	machine	component	
the	input	data	is	either	the	pictorial	drawing	of	the	component,	or	the	real	machine	component	in	3	
dimensions,	or	pictorial	imagination	of	machine	component	in	your	brain.	Now	a	days	drafting	software	
have	 the	 capability	of	directly	 converting	a	 solid	modelling	 into	multiview	orthographic	projection.

SolvEd PRoblEmS (WITh INCREaSINg dIFFICUlTy lEvEl)
Example 2.1	Draw orthographic views of the model of steps shown to communicate all details about 
its shape and size.
Solution	 As	 per	 IS	 specification	 SP46	 letter	 ‘a’	 indicates	 the	 front	 direction	 of	 looking.	 Since	 the	
object	 is	 simple,	 only	 view	 from	 above	 and	 view	 from	 front	 are	 sufficient	 to	 explain	 the	 shape	 and	
size	of	 the	object.

Fig.2.26: Two-point perspective 
projection of the model of steps.

Fig.2.25: Relative position of object and picture plane 
to obtain two-point perspective projection
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First	 step	 in	making	view	 from	 front	 is	 to	 imagine	 the	 solid	model	positioned	 in	first	quadrant	 and	
project	 in	 3	 dimensions	 its	 view	 from	 front.	 Fig.2.28	 shows	 the	 imagination	 of	 the	 view	 from	 front	
in	 three	dimensions.	Fig.2.29	 shows	 the	visualisation	of	view	 from	 top	 for	model	of	 steps.

Generally,	 in	orthographic	drawing	starting	 is	made	 from	the	view	 in	which	true	shape	of	 faces	
of	 the	 solid	 is	 visible.	 Since	 this	model	 of	 steps	 is	 a	 having	 some	 planes	 parallel	 to	H.P.	 and	 some	
planes	parallel	to	V.P.	starting	can	be	made	from	view	from	above	as	well	as	view	from	front.	Fig.2.30	
shows	 the	 orthographic	 views	 for	 the	 model	 of	 steps.	 Only	 view	 from	 front	 and	 top	 are	 sufficient	
to	 explain	complete	 information	about	 its	 shape,	 there	 is	no	need	of	 any	other	orthographic	view.

Example 2.2	Draw orthographic views required to communicate all shape and size details for the fixture 
with triangular rib shown in Fig.2.31.

Fig.2.29: Pictorial modelling showing view from above 
of model of steps on horizontal projection plane
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Fig.2.30: Orthographic views of the model of 
steps 
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Fig.2.27: Isometric drawing of model of steps Fig.2.28: Pictorial modelling showing view from front 
of model of steps on vertical projection plane 
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Solution.
As	 shown	 in	Fig.2.32	 imagine	 view	 from	 front	
of	 the	 clamping	fixture	 in	 three	dimensions.

As	 shown	 in	 Fig.2.33	 imagine	 view	
from	 above	 of	 the	 clamping	 fixture	 in	 three	
dimensions.

Only	 view	 from	 front	 and	 top	 are	 not	
sufficient	 to	 explain	 the	 triangular	 shape	 of	
the	 rib.	 For	 explaining	 triangular	 shape	 of	 rib	
view	from	left	or	right	is	required.	As	shown	in	
Fig.2.34	imagine	view	from	right	of	the	clamping	
fixture	 in	 three	dimensions.	Fig.2.35	shows	the	
required	 orthographic	 views	 for	 the	 model	 of	
clamping	fixture	with	 triangular	 rib. Fig.2.31: Clamping fixture with triangular rib

Fig.2.35: Required orthographic views of the clamping 
fixture

Fig.2.32: Pictorial drawing showing view from 
front of the clamping fixture 

Fig.2.33: Pictorial drawing showing view from above of 
the clamping fixture

Fig.2.34: Pictorial drawing showing view from 
right of the clamping fixture
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Example 2.3 Draw orthographic views of the slotted machine component shown to communicate all 
details about its shape and size.
Solution
As	shown	in	fig.2.37	imagine	view	from	front	of	the	slotted	machine	component	in	three	dimensions.
As	shown	in	fig.2.38	imagine	view	from	above	of	the	slotted	machine	component	in	three	dimensions.
Fig.2.39	 shows	 the	 required	orthographic	views	 for	 the	model	of	 the	 slotted	machine	component.

Example 2.4	Draw required orthographic views of the upper brass of a Plummer block.
Solution
As	shown	in	fig.	2.41	imagine	view	from	front	of	the	upper	brass	of	Plummer	block	in	three	dimensions.
As	shown	in	fig.	2.42	imagine	view	from	above	of	the	upper	brass	of	Plummer	block	in	three	dimensions.
As	shown	in	fig.	2.43	imagine	view	from	left	of	the	upper	brass	of	Plummer	block	in	three	dimensions.
Fig.	2.44	shows	the	required	orthographic	views	for	the	model	of	the	upper	brass	of	Plummer	block.

Fig.2.36: Slotted machine component
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Fig.2.37: Pictorial drawing showing view from front
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Fig.2.38: Pictorial drawing showing view from above Fig.2.39: Required orthographic views of the 
slotted machine component
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Fig.2.40: Isometric drawing of the upper brass Fig.2.41: Pictorial drawing showing view from front

Fig.2.42: Pictorial drawing showing view from above Fig.2.43: Pictorial drawing showing view from left
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1.	 Parallel	projection	 is	 classified	 into	 two	 subcategories;	 	 	 	 	
a.	Oblique	projection	and	 	b.	Orthographic	projection.

2.	 In	orthographic	projection	projectors	are	always	parallel	to	each	other	and	perpendicular	to	
the	plane	of	projection.	

3.	 The	 three	 basic	 elements	 for	 a	 projection	 are;	 object,	 projectors	 and	 reference	 planes.	 In	
orthographic	 projection,	 the	 projection	 of	 the	 object	 on	 the	 vertical	 plane	 (V.P.)	 is	 known	
as	 front	view	and	on	 the	horizontal	plane	 (H.P.)	 is	known	as	 top	view.

4.	 In	first	angle	projection	method,	the	object	lies	between	the	observer	and	plane	of	projection.	
Here,	 the	object	 is	positioned	 in	first	quadrant	 i.e.,	 in	 front	of	V.P.	 and	above	H.P.

5.	 In	third	angle	projection,	transparent	plane	of	projection	lies	between	the	observer	and	object.	
Here,	 the	object	 is	positioned	 in	 third	quadrant	 i.e.,	 behind	V.P.	 and	below	H.P.

6.	 Single	 view	 parallel	 orthographic	 projection	 obtained	 when	 X,	 Y	 and	 Z	 axis	 of	 solid	 are	
inclined	 to	plane	of	projection	 is	 called	axonometric	projection.

7.	 When	all	 three-coordinate	 axis	of	 solid	 are	 equally	 inclined	 to	plane	of	projection	 then	 the	
single	view	orthographic	projection	obtained	 is	 called	 isometric	projection.

8.	 When	projectors	are	inclined	to	the	projection	plane	at	angle	other	than	90°	then	the	single	
view	parallel	projection	 is	 called	oblique	projection.

9.	 Perspective	projection	 is	3-dimensional	 representation	of	an	object	on	a	plane	surface,	as	 it	
would	appear	 to	 the	 eye	when	viewed	 from	a	fixed	position.

10.	 At	present	 in	 India,	first	 angle	projection	 is	 recommended	by	BIS.
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Front View View from Left
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Fig.2.44: Required orthographic views of the upper brass of Plummer block

UNIT SUmmaRy
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a. objective questions

A1. Fill in the blanks with appropriate words
2.1	 Multi-view	drawing	 is	 another	name	 for__________.
2.2	 Projection	of	 an	object	 shown	by	 three	view	 is	 called	as	__________.
2.3	 The	 top	view	and	________	view	 is	 always	 in	 line	vertically.
2.4	 The	horizontal	and	vertical	planes	intersect	forming	four	quadrants.	These	quadrants	are	

called_________.
2.5	 For	orthographic	projection,	BIS	 recommends	 the__________	projection	method.
2.6	 In	orthographic	projections,	 the	xy	 line	 is	 called	as	__________.
2.7	 In	orthographic	projection	projectors	 are	 always	 	 	 _________	 	 	 to	 each	other.	
2.8	 The	 top	view	of	 an	object	 is	projected	on	________	plane.
2.9	 In	oblique	projection	projectors	 are	_________	 	 	 	 to	 the	plane	of	projection.
2.10	 In	 third	angle	projection,	 the	picture	plane	 is	placed	_________	 	 the	object	with	respect	

to	observer.

A2. Multiple choice questions
2.1	 In	orthographic	projection,	 the	xy	 line	 is	 also	known	as	………………….

(a)	Horizontal	 line	 	 	 (b)	Vertical	 line	
(c)	Reference	 line	 	 	 (d)	Horizontal	 trace	

2.2	 In	orthographic	projections,	 the	projectors	 are	 assumed	 to	be	
(a)	diverge	 from	a	point	 	 	 	 (b)	Oblique	 to	 the	plan	of	projection	 	
(c)	Perpendicular	 to	 each	other	 	 	 (d)	Parallel	 to	 each	other	 	

2.3	 The	orthographic	projection	of	an	object	on	vertical	reference	plane	is	known	as	………………..
(a)	Front	view	 	 	 	 	 (b)	Top	view	 	
(c)	Rear	view	 	 	 	 	 (d)	Side	view	 	

2.4	 When	 projector	 are	 drawn	 from	 corner	 points	 of	 object	 perpendicular	 to	 horizontal	 reference	
plane	then	figure	obtained	by	joining	points	of	intersection	of	projector	and	horizontal	reference	
plane	 in	proper	 sequence	 is	 called	…………………….
(a)	Plan	of	object	 	 	 	 (b)	Elevation	of	object	 	
(c)	Front	view	of	object	 	 	 (d)	Side	view	of	object	 	

EXERCISES

answers of Fill in the blanks questions

2.1 orthographic projection;  2.2 orthographic;  2.3 Front;  2.4 angles;  2.5 First angle 
projection; 2.6 Reference line;  2.7 Parallel;  2.8 horizontal;  2.9 Inclined;  2.10 in front of;
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2.5	 Orthographic	projection	means	………………..
(a)	Projecting	an	object	 such	 that	 the	projectors	 are	perpendicular	 to	 each	other	 	
(b)	Projecting	……………….	projectors	 are	 	oblique	 to	 each	other
(c)	Projecting	an	object	 such	 that	 the	projectors	 are	parallel	 to	 each	other	and	oblique	 to	 the	

plane	of	projection
(d)	Projecting	……………..	 the	projectors	 are	parallel	 to	 each	other	and	perpendicular	 to	 the	

plane	of	projection	 	

2.6	 In	 first	 angle	 projection	 method,	 the	 relative	 positions	 of	 the	 object,	 plane	 of	 projection	 and	
observe	are	……………..
(a)	Plane	of	projection	 is	placed	 in	between	 	 	 (b)	Observer	 is	placed	 in	between	 	
(c)	Object	 is	placed	 in	between	(d)	Object	 is	placed	before	 the	plane	of	projection	and	observer		

2.7	 According	to	BIS	SP-2003,	which	of	the	following	projection	is	used	for	orthographic		projection	?		
(a)	First	 angle	projection	 	 	 	 (b)	Second	angle	projection	 	
(c)	Third	angle	projection	 	 	 	 (d)	Fourth	angle	projection	 	

2.8	 Principal	planes	 refer	 to	………………..
(a)	Vertical	plane	and	auxiliary	plane	 	 (b)	Vertical	 and	Horizontal	plane	
(c)	Central	plane	and	ground	plane	 	 	 (d)	Auxiliary	plane	and	picture	plane	 	

2.9	 The	 symbol	 recommended	 by	 BIS	 for	 indicating	 the	 angle	 of	 projection	 showing	 two	 views	 of	
the	 frustum	of	 a	………………
(a)	Cone	 	 (b)	Prism	 (c)	Pyramid	 (d)	Sphere	 	

2.10		 In	orthographic	projection,	 the	height	dimension	of	 an	object	 is	 seen	 in	……………..
(a)	Front	and	 top	view	 	 	 	 (b)	Front	and	 side	view	 	
(c)	Top	and	 side	view	 	 	 (d)	Front,	 top	and	 side	view	 	

b. Subjective questions
2.1	 Explain	 the	 term	projection.	List	 the	 elements	 required	 for	 a	projection.
2.2	 Give	 classification	of	 a	projection	method	 for	making	a	drawing.	
2.3	 Define	an	orthographic	projection?	How	does	 it	differ	 from	an	oblique	projection?
2.4	 Explain	 reference	planes	and	 their	utility.
2.5	 Differentiate	between	a	perspective	projection	and	parallel	projection.
2.6	 Explain	 the	 term	quadrant	 and	 its	utility	 to	obtain	orthographic	projection.
2.7	 Explain	 the	 concept	of	first	 and	 third	 angle	projection	method	with	 the	help	of	 suitable	

sketches.

answers of multiple Choice questions

2.1 (c);  2.2 (d);  2.3 (a);  2.4 (a);  2.5 (d);  2.6 (c);  2.7 (a);  2.8 (b);  2.9 (a);  2.10 (b)
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2.8	 Differentiate	 between	 the	 first	 angle	 and	 third	 angle	 projection	method	 on	 the	 basis	 of:								
(i)	Position	of	different	views	and	 (ii)	Position	of	object,	observer	 and	plane.

2.9	 Define	 multi	 view	 projection.	 Describe	 briefly	 the	 method	 of	 obtaining	 multi	 view	
projection	of	 an	object.

2.10	 Give	 the	 symbolic	 representation	of	first-angle	projection.
2.11	 Fig.2.45	shows	the	pictorial	views	of	four	objects.	The	direction	of	view	is	shown	by	arrow.	

Draw	 its	 front	view	and	 top	view	using	 the	first	 angle	projection.

2.12	 Draw	 three	views	of	 the	objects	 shown	 in	Fig.2.46	using	first	 angle	projection.	
2.13	 Draw	 front	and	 top	view	of	 the	 six	objects	given	 in	Fig.2.47	using	first	angle	projection.	

The	direction	of	view	 is	 shown	by	arrow.

Fig.2.45: Pictorial views for subjective problem 2.11
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Fig. 2.46: Pictorial views for subjective problem 2.12
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As	per	 curriculum	 the	practicals	 related	 to	Unit-2	are:
1.	 Draw	a	problem	on	orthographic	projections	using	first	 angle	method	of	projection	having	

plain	 surfaces	 and	 slanting.
2.	 Draw	 another	 problem	 on	 orthographic	 projections	 using	 first	 angle	method	 of	 projection	

having	 slanting	 surfaces	with	 slots.
3.	 Draw	two	problems	on	orthographic	projections	using	first	angle	method	of	projection	having	

cylindrical	 surfaces,	 ribs.

Practical-1 draw orthographic Projections of object with Plain and Slant 
Surfaces

Practical statement
Draw	 orthographic	 projections	 of	 an	 object	 having	 plain	 and	 slanting	 surfaces	 using	 first	 angle	
projection	method.

Practical significance
After	 designing	 components	 the	 next	 step	 is	 to	 manufacture/construct	 them	 hence	 production/	
construction	 drawings	 are	 required	 by	 the	 technicians.	 To	 communicate	 with	 these	 technicians	
orthographic	and	 sectional	orthographic	drawings	are	needed	which	 shows	all	possible	details	more	
clearly	and	precisely	so	that	the	component/entity	can	be	manufactured/constructed.	The	technicians	
are	trained	to	read	the	orthographic	views.	These	views	are	generally	drawn	with	first	angle	projection	
method.

Fig. 2.47: Pictorial views for subjective problem 2.13

PRaCTICalS
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Relevant theory
Refer Section 2.0 of the book.

Practical outcomes (PrO)
The	practical	outcomes	are	derived	 from	 the	curriculum	of	 this	 course:

PrO1:	Draw	orthographic	views	 in	first	 angle	projection	 from	given	 isometric	views	of	objects	

having	plain	and	 slanting	 surfaces.	

Practical setup (Drawing/Sketch/Circuit Diagram/Work Situation)

Resources required
Same as mentioned in Practical-1 of Unit-1

Precautions
Same as mentioned in Practical-1 of Unit-1

Suggested procedure

1.	 Looking	 to	 the	 given	 Isometric	 view	 of	 the	 object	 it	 can	 be	 concluded	 that	 the	 object	 is	
basically	 made	 up	 of	 a	 rectangular	 block	 base	 (100	 x	 16)	 with	 another	 rectangular	 block	
(40	 x	 30)	 centrally	 located	 on	 top	 of	 it	 along	with	 two	 symmetrically	 placed	Ribs	 (50	mm	
thick)	on	 the	 two	 sides.

2.	 Start	with	 front	view	and	draw	a	rectangle	of	100mm	by	60mm	to	represent	 the	 front	view	
of	base	block	and	another	rectangle	of	size	40	mm	length	and	30	mm	height	centrally	above	
it	 to	 indicate	 top	block.	

3.	 Join	 the	 top	edges	of	 the	 square	block	with	 that	at	 the	base	block	 to	mark	 the	 sloping	 ribs,	
on	either	 side	as	 shown	 in	 the	 front	view.	

4.	 Now	 draw	 the	 projectors	 to	 develop	 Top	 view.	 Sketch	 a	 rectangle	 of	 length	 100	mm	 and	



88  |  Engineer ing Graphics

width	 50	mm	 to	 represent	 base	 block	 and	mark	 a	 square	 of	 40	mm	 sides	 in	 the	 centre,	 to	
represent	the	top	the	centre	block	in	top	view.	Mark	the	hole	and	the	side	edges	to	indicate	
the	 ribs	 as	 shown	 in	 the	 top	view.

5.	 Project	 the	 side	view	of	 the	base	unit	 and	 the	centre	block	along	with	 the	 ribs	as	 shown	 in	
the	 right-side	view.	Represent	 the	hole	with	dotted	 lines.	

Observations

Practical related questions
1.	 In	right	side	view	the	dotted	lines	are	not	of	full	length	while	the	hole	is	a	through	hole.	Justify.
2.	 Explain	 the	purpose	of	 ribs.

Disposal of waste
Same as mentioned in Practical-1 of Unit-1

Environment friendly approach: Reuse, Reduce and Recycle
Same as mentioned in Practical-1 of Unit-1

Suggested learning resources
Refer Unit-2

Suggested assessment scheme
Same as mentioned in Practical-1 of Unit-1
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Practical-2 draw orthographic Projections of object with Slant Surfaces 
and Slots

Practical statement
Draw	orthographic	projections	of	an	object	having	slanting	surfaces	and	slots	using	first	angle	projection	
method.

Practical significance
After	 designing	 components	 the	 next	 step	 is	 to	 manufacture/construct	 them	 hence	 production/	
construction	 drawings	 are	 required	 by	 the	 technicians.	 To	 communicate	 with	 these	 technicians	
orthographic	and	 sectional	orthographic	drawings	are	needed	which	 shows	all	possible	details	more	
clearly	and	precisely	so	that	the	component/entity	can	be	manufactured/constructed.	The	technicians	
are	trained	to	read	the	orthographic	views.	These	views	are	generally	drawn	with	first	angle	projection	
method.

Relevant theory
Refer Section 2.0 of the book.

Practical outcomes (PrO)
The	practical	outcomes	are	derived	 from	 the	curriculum	of	 this	 course:

PrO1:	Draw	 orthographic	 views	 in	 first	 angle	 projection	 from	 given	 isometric	 views	 of	 objects	
having	 slanting	 surfaces	 and	 slots.	

Practical setup (Drawing/Sketch/Circuit Diagram/Work Situation)

Resources required
Same as mentioned in Practical-1 of Unit-1
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Precautions
Same as mentioned in Practical-1 of Unit-1

Suggested procedure
1.	 Looking	 to	 the	 given	 Isometric	 view	of	 the	 object	 it	 can	 be	 concluded	 that	 the	 base	 of	 the	

object	is	a	rectangular	block	which	is	supporting	a	semicircular	block	above	it.	The	semicircular	
block	is	connected	tangentially	with	a	sloping	rib	with	the	base	block.	A	longitudinal	slot	in	
the	base	and	a	 front	 inclined	central	 slot	 are	provided	 in	 the	 rectangular	block.	

2.	 Start	 from	 the	 front	 view	 and	 draw	 a	 rectangle	 of	 length	 275	 mm	 and	 height	 69	 mm	 to	
represent	base	block.	Draw	a	 full	circle	of	radius	34.5	mm	and	center	48	mm	above	and	48		
mm	 left	 from	 the	 right	hand	 top	corner	of	 the	 rectangle.	

3.	 Add	a	semicircle	with	same	center	as	that	of	circle	but	radius	equal	to	48	mm	on	top	of	the	
circle.	 Draw	 two	 vertical	 tangents	 to	 connect	 this	 semicircle	 with	 rectangle.	Mark	 a	 point	
at	96	mm	from	the	 top	 left	corner	of	 the	rectangle	and	connect	 this	point	 to	 the	semicircle	
through	 an	 external	 inclined	 tangent.	 Draw	 two	 vertical	 parallel	 lines	 55	mm	 apart	 in	 the	
center	of	 the	 rectangle	 to	 represent	 central	 inclined	 slot.	This	 completes	 the	 front	view.	

4.	 Project	the	Rectangle,	Circle,	Semicircle,	Longitudinal	slot	and	Central	inclined	slot	from	Front	
view	 to	Top	view.	 	The	corresponding	width	values	of	 these	 entities	will	be	 taken	 from	 the	
isometric	view.	Looking	at	the	figure	given	in	the	Observation	section	list	the	steps	followed:
a)……………………………………………………………………………………	…………….
b)………………………………………………………………………………………	………….

5.	 In	Right	side	view,	an	L-shaped	arrangement	indicating	the	base	block	and	the	bearing	block	
is	 shown.	 Project	 the	 end	 points	 of	 the	 rib.	The	 slope	 of	 the	 central	 cut-out	 is	 marked	 at	
a	 distance	 of	 27	mm.	 Looking	 at	 the	 figure	 given	 in	 the	Observation	 section	 list	 the	 steps	
followed:	
a)……………………………………………………………………………………	…………….
b)……………………………………………………………………………………	…………….

Observations
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Practical Related Questions
1.	 In	right	side	view	the	dotted	lines	are	not	of	full	length	while	the	hole	is	a	through	hole.	Justify.
2.	 Explain	 the	purpose	of	 ribs.

Disposal of Waste
Same as mentioned in Practical-1 of Unit-1

Environment Friendly Approach: Reuse, Reduce and Recycle
Same as mentioned in Practical-1 of Unit-1

Suggested Learning Resources
Refer Unit-2

Suggested Assessment Scheme
Same as mentioned in Practical-1 of Unit-1
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Practical-3 draw orthographic Projections of object with Cylindrical 
Surfaces and Ribs

Practical statement
Draw	 orthographic	 projections	 of	 an	 object	 having	 cylindrical	 surfaces	 and	 ribs	 using	 first	 angle	
projection	method.	

Practical significance
After	 designing	 components	 the	 next	 step	 is	 to	 manufacture/construct	 them	 hence	 production/	
construction	 drawings	 are	 required	 by	 the	 technicians.	 To	 communicate	 with	 these	 technicians	
orthographic	and	 sectional	orthographic	drawings	are	needed	which	 shows	all	possible	details	more	
clearly	and	precisely	so	that	the	component/entity	can	be	manufactured/constructed.	The	technicians	
are	trained	to	read	the	orthographic	views	which	are	generally	drawn	with	first	angle	projection	method

Relevant theory
Refer Section 2.0 of the book.

Practical outcomes (PrO)
PrO1:	Draw	 orthographic	 views	 in	 first	 angle	 projection	 from	 given	 isometric	 views	 of	 objects	
having	cylindrical	 surfaces	 and	 ribs.	

Practical setup (Drawing/Sketch/Circuit Diagram/Work Situation)
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Resources required
Same as mentioned in Practical-1 of Unit-1

Precautions
Same as mentioned in Practical-1 of Unit-1
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Suggested Procedure
1.	 In	the	given	object	there	are	two	different	sized	hollow	cylindrical	blocks	placed	perpendicular	

to	 each	 other.	 Both	 are	 connected	with	 a	 central	 L-shaped	 rib,	 which	 is	 inclined	 from	 the	
top	 and	horizontal	 from	 the	 bottom.	The	bigger	 one	 is	 placed	 in	 the	 front	 surface	 and	 the	
smaller	one	 is	placed	 in	 the	 left	hand-side	 surface	of	 the	L-shaped	 structure.	

2.	 In	front	view	start	with	to	center	lines	perpendicular	toeach	other	followed	by	two	concentric	
circles	of	55	mm	and	80	mm	diameter	 to	 represent	 the	 front	view	of	 the	bigger	 cylindrical	
block.	Locate	the	axis	of	the	side	block	which	is	22.5	mm	from	the	centre	of	these	concentric	
circles.	 Draw	 the	 outline	 of	 smaller	 cylindrical	 block	 using	 a	 rectangle	 of	 height	 of	 35mm	
and	width	18mm	centrally	placed	about	 the	axisas	 shown	 in	 the	 front	view.	

3.	 Now	 draw	 the	 inclined	 and	 horizontal	 external	 tangents	 of	 the	 bigger	 circle	 connecting	 to	
the	 rectangle.	 Draw	 parallel	 dotted	 lines	 in	 the	 rectangle	 to	 represent	 hole	 in	 the	 smaller	
cylindrical	block.

4.	 The	outlines	of	the	central	rib	are	drawn	as	tangential	lines	to	the	circle	as	shown	in	the	FV.	
5.	 The	top	views	of	 the	 three	units	are	projected	as	rectangles	and	are	 joined	as	shown	in	Fig.	

The	 top	 surface	 of	 the	 rib	 is	 shown	 in	 thick	 lines,	while	 the	 bottom	 surface	 is	 identified	 in	
dotted	 lines.

6.	 The	 left-side	view	of	 the	assembly	 is	drawn	 in	an	L-shaped	 fashion	as	 shown	 in	figure.	The	
cylindrical	holes	 in	 the	 respective	blocks	are	 represented	as	 circles	 in	 the	appropriate	views	
and	with	 dotted	 lines	 in	 the	 other	 views.	The	 rib	 is	 shown	 through	 two	 rectangle	 in	Right	
side	and	Top	view	of	thickness	15mm	while	the	thickness	of	larger	cylindrical	block	is	25mm		
and	is	visible	 in	Right	side	view	and	Top	view.	The	thickness	of	Smaller	cylindrical	block	 is	
18mm	and	 is	 visible	 in	Front	view	and	Top	view.

Observations
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Practical related questions
1.	 Identify	 the	 distances	 of	 the	 axis	 of	 smaller	 cylindrical	 block	 from	 back	 surface	 of	 the	 rib	

and	back	 surface	of	bigger	 cylindrical	block.	Are	 these	distances	 are	 same	or	different.	
2.	 Identify	 the	distance	between	 the	axes	of	bigger	 and	 smaller	 cylindrical	blocks.

Disposal of waste
Same as mentioned in Practical-1 of Unit-1

Environment friendly approach: Reuse, Reduce and Recycle
Same as mentioned in Practical-1 of Unit-1

Suggested learning resources
Refer Unit-2

Suggested assessment scheme
Same as mentioned in Practical-1 of Unit-1

•	 Teacher	 shall	 collect	 few	 production/construction/electrical/electronic	 actual	 industrial	
component	drawings	 to	 show	 them	 to	 the	 students	with	 input.

•	 During	the	input	sessions	the	teacher	must	give	examples	related	to	the	relevant	branch	viz.	
Mechanical	 and	allied	disciplines/	Electrical	 and	allied	disciplines/Electronics	 etc.

•	 Teacher	must	know	orthographic	view	of	objects	having	plain,	slanting	and	cylindrical	surface
•	 Show	video/animation	films	 to	 explain	mentioned	concepts.
•	 Teachers	 should	 ask	 students	 to	 use	 url/qr	 codes	 available	 in	 the	 book	 for	 further	

understanding/	practicing	of	 the	 concepts.

applications (Real life / Industrial)
It	is	a	standard	practice	of	engineering	companies	to	provide	a	manufacturer	or	fabricator	an	accurate,	
measured	drawing	 that	 can	be	 followed	when	making	 something.

Orthographic	 drawings	 are	 extensively	 used	 by	 designers	 –	 particularly	 architects,	 product/	
industrial	 designers	 and	 engineers,	 as	 they	 are	 ideal	 for	 visualization	 and	 projection	 between	 views			
for	design	of	buildings,	mechanical	 components,	machine	elements	 ,	 locking	arrangements,	 jigs	and	
fixtures,	 furniture	 etc.

Inquisitiveness and Curiosity
Other	 than	 the	classroom	and	drawing	practice	 sessions,	 following	are	 the	suggested	student-related	
co-curricular	activities	which	can	be	undertaken	to	accelerate	the	attainment	of	the	various	outcomes	
in	 this	unit:

KNoW moRE

Illustrative 
Example-2
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1.	 Student	should	maintain	a	separate	A3	size	sketch	book	which	will	be	the	part	of	term	work	
and	submit	it	along	with	drawing	sheets.	Following	assignment	on	orthographic	views	should	
be	drawn	with	a	 suitable	dimension	 in	 the	 sketch	book-
a.	 Laptop	computer
b.	 Steel	Almira
c.	 Refrigerator
d.	 Staircase
e.	 Single	point	 cutting	 tool

2.	 Each	student	of	the	batch	will	try	to	collect	few	pictorial	views	related	to	production	drawings/	
construction	 drawings/	 plumbing	 drawings	 from	 local	 workshops/builders	 /electrical	 and	
mechanical	 contractors	 and	 try	 to	 generate	 the	 orthographic	 views	 using	 first	 angle	 and				
third	angle	projection.

3.	 Each	 student	 of	 the	 batch	 will	 surf	 the	 web	 and	 list	 the	 product	 /	 components	 in	 which	
orthographic	views	are	used	 to	manufacture	or	 fabricate	 in	different	field	of	 engineering.

1.	 Engineering	Drawing	Practices	 for	School	and	Colleges	SP	46:2003,	published	by	Bureau	of	
Indian	Standards,	Government	of	India,	Third	Reprint,	October	1998;	ISBN:.	81-7061-091-2,	
Manak	Bhavan,	9	Bahadur	Shah	Zafar	Marg	 ,	New	Delhi

2.	 A	Text	Book	of	Engineering	Drawing,	K	Venkata	Reddy,	BS	Publication,	2008	
3.	 Engineering	Drawing,	N.D.	Bhatt,	Charotar	Publishing	House,	Anand,Gujarat,	 2014
4.	 NPTEL	 Course	 Material	 on	 Engineering	 Drawing,	 P.S.	 Robi,	 Department	 of	 Mechanical	

Engineering,	 Indian	 Institute	 of	 Technology	 Guwahati,	 India:	 https://nptel.ac.in/
courses/112/105/112105294/

REFERENCES & SUggESTEd REadINgS
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UNIT SPECIFICS
This unit presents information related to following topics:

•	 Introduction to isometric projections
•	 Isometric scale 
•	 Isometric view and isometric projection
•	 Draw isometric view of plane geometrical figures containing lines, circles and arcs shape.
•	 Conversion of orthographic views into isometric view/projection

The understanding of these topics will be developed after reading the contents, completing the solved 
problems, activities, performing exercises and viewing the ICT & web resources mentioned in this unit.

At the end of the unit, summary is provided to recapitulate the topics covered and applications 
are mentioned so that the learner can correlate the presented knowledge with real life and industrial 
situations. Few activities are mentioned to create inquisitiveness and curiosity in the learner. Subjective 
and objective questions are provided for the reinforcement of the knowledge and a list of references 
and suggested readings is also provided for further learning. Video resources along with QR codes 
are mentioned for getting more information on various topics of interest which can be surfed or 
scanned through mobile phone for viewing. Practical with details are provided to horn the drawing 
and drafting skills.

RaTIoNalE
Nearly all the engineering drawing for manufacture in industry is produced in orthographic projection. 
In an orthographic projection, we draw separately front view, top view, right-side view, etc., while in 
an isometric drawing, the front side and the top all are combined in one figure only. This thing may 
happen in a pictorial projection also, but the necessary condition in an isometric drawing is that the 
principle lines are parallel to the isometric axes and the actual dimensions of a solid object can be 
measured directly from it. Engineers or designers often use pictorial drawings and sketches to explain 
the complication of the multi-view drawing or communicate ideas both among technical and with 
non-technical staff. Most commonly used pictorial drawing is isometric drawing.
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Unit-3
outcome

EXPECTED MaPPING WITH CoURSE oUTCoMES
(1- Weak Correlation; 2- Medium Correlation; 3- Strong Correlation)

Co-1 Co-2 Co-3 Co-4 Co-5 Co-6

U3-o1 - - 2 3 3 1

U3-o2 - - 2 3 3 1

U3-o3 1 2 3 3 3 2

U3-o4 2 2 3 3 3 3

3.1 INTRoDUCTIoN To ISoMETRIC PRojECTIoNS
The term isometric comes from the Greek for "equal measure". In 
isometric projection, all the three edges of the object are equally inclined 
to the planes forming an angle of 120° with each other and called the 
isometric axes as shown in Fig.3.1. The three lines OM, OQ and OP 
meeting at point O and making 1200 angles with each other are called 
isometric axes or isoaxes.

The principles of isometric projection may be understood from 
the isometric projection of a cube. The isometric projection of a cube 
is obtained, when the line of sight is parallel to its solid diagonal. If 
a cube is resting on one of its corners on H.P. with its solid diagonal 
perpendicular to V.P. Fig.3.2 shows the front view of the cube in isometric projection when hidden 
lines are removed. It gives a realistic view of the cube. From the Fig.3.2 you may be noted that:

1. the three lines OM, OQ and OP meeting at point O, represent three edges of the cube which 
are equally inclined to the V.P. and therefore are equally fore-shortened. 

2. the line OP is vertical and other two lines OM and OQ make 30degree angle with the 
horizontal. 

Fig.3.1: Isometric axes

PRE-REqUISITES
Before reading this unit the student is advised to revisit following:

•	 Maths: Plane geometry and Unit-2 of this book 

UNIT oUTCoMES
After reading the contents, completing the solved problems, activities, exercises and viewing the ICT 
and web resources mention in this unit the students are expected to:

U3-O1:  Construct isometric scale.
U3-O2:  Differentiate between isometric view and isometric projection
U3-O3:  Draw isometric views of given simple plane geometrical figures containing lines, circles           
        and arcs shapes only
U3-O4:  Draw isometric views from given orthographic views.
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This projection is more appropriate in the case of small objects, but larger objects may appear to 
be unnatural. Perspective projection is used to represent larger 
objects.

3.2 ISoMETRIC SCalE
This scale is used only for making the isometric views. The 
projection by means of which the true distance is reduced to 
isometric distance is known as isometric scale.

In isometric projection, the measurement of dimensions 
is reduced, therefore a special scale is required to draw the 
projections. Refer to Fig.3.3(a), construct a square with MQ as 
diagonal representing the true shape of the top surface. It may 
be noted from the same figure that the lines MS and MT are 
inclined at 30˚ and 45˚ to MY respectively. It is also evident 
from Fig.3.3(b), that MT is the true length and MS is its isometric length of projection.

From right angle triangle, ∆ MYT and ∆ MYS
MY = MT cos 45˚
MY = MS cos 30˚
Now, MT cos 45˚ = MS cos 30˚

So, MS
MT

 = 
cos 45˚
cos 30˚

 = 
1

2
3 2

 = 0.81649568 = 0.816 = 
816

1000
 √/

√ /
Hence, isometric length = 0.816 x true length. 

Thus, all the dimensions in isometric projection are 0.816 
times the true length or approximately 82% of the  true length can 
be obtained either by multiplying it by factor or by construction 
of isometric scale. The isometric scale shown in Fig.3.3 (b) has 
been constructed as below steps: 

1. Draw a horizontal line MY.
2.  Draw lines MS and MT making 30° and 45° with line 

MY.
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Fig.3.2: Isometric projection
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3. all other lines representing the edges of the cube 
are parallel to one or the other of the above 
three lines i.e. OM, OQ and OP and are also 
fore-shortened equally. 

In other words, in isometric projection, the three planes 
will be equally foreshortened and the axes are equally 
spaced at 120° apart. The axes OM, OQ and OP are 
called isometric axes, refer Fig.3.2. Lines parallel to these 
axes are called isometric lines and planes parallel to the 
faces of the cube in the isometric projection are called 
isometric planes. As the three axes are fore-shortened 
equally, single isometric scale can be used.

Fig.3.3(a): Isometric projection
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3.  Construct a regular scale to true length on the 45° line (MT) such as  0,1,2,3,4 cm and project 
the same point on the 30° line MS.

4. Drawn lines should be perpendicular to the base line MY, meeting upto MS only.
5. Mark the corresponding division points on the line MS to obtain the isometric scale.

It should be noted very carefully that all the measurements should be made along isometric axis or 
isometric lines only”.

The isometric scale can be drawn in a simple form as shown in Fig.3.4. The true length is marked 
as PQ. A line PR is drawn at 15˚ to PQ to intersect another line inclined at 45˚ to horizontal and 
drawn from Q. Then 45˚ inclined lines are drawn from the divisions on the true length scale PQ, 
so that the corresponding isometric lengths are obtained on the line PR. Even though it is easy to 
calculate the isometric lengths (82%) with the help of a calculator, it is a custom to show isometric 
scale nearby the isometric projection (on top or right side) for identification.

P q
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Isometric Length

True Length
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°

3.3 ISoMETRIC PRojECTIoN aND ISoMETRIC VIEW
In isometric projection, isometric lengths (0.816 times of the true length) are used to prepare 
the drawing. In isometric view, the true lengths are used to prepare the drawing, neglecting the 
foreshortened lengths of all the edges of the object. Thus, isometric view of an object is larger than 

Fig.3.4: Simplified isometric scale
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the isometric projection of the object. Due to ease of construction and advantage of measuring the 
dimensions directly from the drawing, it has become a general practice to use the true scale instead 
of isometric scale. Thus, isometric projection seems to be smaller in size than the isometric view. 
An isometric projection and an isometric view of a cube are shown in Fig.3.5.

3.3.1 Isometric dimensioning
The general rules for the dimensioning of orthographic projection is applicable for isometric projection 
also, except the following:-

1. All the extension lines and dimension lines 
should be parallel to the isometric axes and 
they should lie on any of the isometric planes. 

2. The dimensional values should be placed at the 
middle of the dimension line. The dimensional 
values in x direction should be readable from 
the right side, while those in y direction should 
be readable from the left side. The dimensional 
values in z direction should be readable 
horizontally from the right side. 

3. It is usual practice to avoid the hidden lines, 
unless they are essential to make the drawing 
clear.

Fig.3.6 shows the recommended dimensioning layout for isometric drawing by BIS.

3.4 DRaW ISoMETRIC VIEW oF PlaNE GEoMETRICal FIGURES
Isometric drawing of plane geometrical figure  can be obtained simply by keeping in mind that :

1. All lines that are parallel on 
the object are parallel on the 
isometric projection.

2. Vertical lines will be vertical 
in projection and horizontal 
lines will be at 300 inclined in 
projection. 

3. The lines parallel to an isometric 
axis is called an isometric line and 
it is foreshortened to 82%.

4. The lines which are not parallel 
to any isometric axis, called  
as non-isometric lines, are 
not  equally foreshortened. For 
example, diagonal MQ and SO  
[see Fig.3.3(a)] are of equal lengths in front view but are of different lengths in the isometric 
projection. The  non-isometric lines are drawn by locating positions of their ends on isometric 
planes and then joining them.
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Fig.3.6: Isometric dimensioning

Fig.3.7: Lines in isometric projection
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3.4.1 Methods of Constructing Isometric Drawing
The inclined lines of an object are represented by non-isometric lines in isometric 
projections. These are drawn by one of the following methods.

1. Box Method 
2. Co-ordinate or Offset Methods.

Box method
In this method, the object is assumed  to be enclosed in a rectangular box and both isometric and 
non-isometric lines are drawn by locating their respective points of contact with the surfaces and 
edges of the box. It is always helpful to draw or imagine the orthographic views first and then proceed 
for isometric drawing. It is used to draw prisms, cylinders and frustum of solids. An example of  
isometric drawing by box method is illustrated below:
Example 3.1 Draw an isometric projection of a block with isometric lines only.
Solution (by Box-Method)
To make the procedure clear a very simple object, containing only isometric lines is taken and Fig.3.8 
shows the construction of the isometric projection by box method.

•	 At (a), the front and top view of the object are given.
•	 At (a') the three isometric axes 

are drawn, such that one of 
the axes is vertical (upward) 
and the other two making 30˚ 
angles with the horizontal.

•	 Along these axes, dimensions 
L, W and H are laid off, and 
as shown at (b) the isometric 
box is completed.

•	 Then, taking the 
measurements along the 
isometric lines, the details 
of the object are transferred 
from the orthographic view to 
the isometric box.

•	 Finally all the details which 
were drawn by light lines are 
darken  to make the figure more distinct as at (c).

Co-ordinate or Offset Methods
This method of  making an isometric drawing is  better suited to objects made-up of a number 
of planes at different angles or  contains irregular curved surfaces. In case of planes, the ends of 
the edges are located by dropping perpendiculars from each point to an isometric reference plane. 
The perpendiculars may be located on the drawing, as these are isometric lines and the respective 
measurements  are transferred from the orthographic views. In case of curved surfaces, the curved 
feature may be obtained by plotting the points on the curve, located by the measurements along 
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isometric lines. This method  is used to draw isometric projection of pyramids, cones and truncated 
solids.
The box method is generally convenient for solving most of the problems.
Example 3.2 Draw an isometric view of a square ABCD as shown in Fig.3.9 (a).
Solution
The square can be projected isometrically in three different ways, as shown in Fig.3.9(b, c and d). 
Case-1

Step-1. Draw a horizontal line and mark a point (b), on it. Draw a line ba, making a 300 angle, 
towards the left. The length is equal to the side of the square AB.

Step-2. From point a, draw a vertical line ad equal to AD. 
Step-3. From point b, draw a vertical line bc, equal in length to BC. 
Step-4. Join d and c by a straight line which is also inclined at 300 to the horizontal.

b c d a is the isometric drawing of the square ABCD and it gives a feeling as if we are viewing 
perpendicular to the line ba and from the left to the right side (Fig.3.9b).
Case-2
Another way in which the square could be projected is given in Fig.3.9(c). The procedure is exactly 
similar but the 300 angle is to be drawn on the right-hand side. This gives a feeling as if we are looking 
the square in a direction perpendicular to the side ab and from the right to the left.
Case-3
The third way is projecting the square horizontally. The procedure is as follows:  

Step-1. Draw a horizontal line and mark a point a on the line. 
Step-2. From point a, draw two lines, making 300 angles with the horizontal line but on the 

opposite sides. 
Step-3. Cut lengths equal to the side of the square AB and AD. Draw parallel lines from these 

ends to the opposite sides, completing the rhombus abcd. 
Step-4. The Fig.3.9(d) represents the isometric drawing of the square ABCD when the square 

is considered horizontal.
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Example-3.3 Draw angles in isometric as shown in Fig.3.10(a).
Solution
Isometric angles cannot be measured directly with the protractor. Angles are constructed by locating 
the end points of inclined lines by measurements parallel to the isometric axes. In Fig.3.10(a), angle 
is given in degrees, it is necessary to convert it into linear measurement.

Step-1. Draw the “construction box” with isometric axes.
Step-2. Draw the triangle and convert 30° in linear measurement “A”
Step-3. This dimension “A” should be transferred with dividers to the isometric drawing and

draw parallel inclined lines.
Step-4. Darken all final lines.

Example 3.4 Draw an isometric view of a triangle ABC as shown in Fig.3.11(a).
Solution
The triangle ABC can be iso-metrically projected in different ways, as shown in Fig.3.11(b) and (c). 

Step-1. Side 'ab' is the isometric lines while 'bc' and 'ca' are non-isometric lines. Therefore,
 enclose the triangle in a rectangle 'abde'.

Step-2. Draw an isometric view of the rectangle 'abde'. For this,
 i. As the surface of the triangle is vertical, draw a vertical line AE equal to 'ae'.
 ii. Draw line AB equal to 'ab', inclined at 300 to the horizontal.
 iii. Make the rectangle ABDE.

Step-3. Make a point C on the edge DE such that EC = 'ec'. Join AC, CB and obtain the 
required isometric view ABC of triangle 'abc'.
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Example 3.5 Draw an isometric view of a pentagon with 30 mm length of side. 
Solution
Fig.3.12(i) shows a rectangular pentagon a,b,c,d,e of 30mm length of side, to draw the isometric view 
of a given pentagon.

Step-1. Enclose the given pentagon in a 
rectangle pqrs as shown in Fig.3.12(ii)

Step-2 . Draw the isometric view of rectangle 
pqrs and locate the corners abcde of 
the pentagon.

Mark points A and B on side QP, such that 
PA = pa, PB = pb
Mark a point E on side PS such that PE = pe 
Mark point D as the midpoint of side SR. 
Mark point c on side RQ such that RC = cr 
as shown in Fig.3.12(iii).
Step-3 Join all the points BA, AE, ED, DC and 
CB. This represents the required isometric view 
of given pentagon a,b,c,d,e shown in Fig.3.12(iv).

Example 3.6 Draw an isometric drawing of a circle of 40mm diameter using four centre method.
Solution
Four centre method is an approximate method of drawing isometric circles. The isometric drawings 
of a circle in a vertical plane and in a horizontal plane are shown in Fig.3.13.

Step-1. Construct the square ABCD enclosing the circle and touching it at 1,2,3 and 4. See 
Fig.3.13(a).

Step-2. When the circle is in a vertical 
position, draw AB at 30° to the 
horizontal and from A&B, 
draw vertical line AD and BC. Join 
DC. Mark the mid points 1,2,3 and 
4. Note the points  
where A3 and C1 cut the diagonal BD 
at e and f.

Step-3. With these two points e and f as 
centres, draw arcs with radius  
e4(= f2) equal to “r” and with A and C 
as centres and radius A3 (= C1) equal 
to “R” draw arcs. 1,2,3,4 is the  required 
isometric view of the circle, when it is 
in a vertical plane as shown in Fig.3.13(b).

In similar manner, the isometric view of the circle in a horizontal plane can be drawn. Here, AB and 
BC are at 30° to the horizontal line as shown in Fig.3.13(c).

d
d

p q

rs

e

a

SS
EE

PP
AA

BB
QQ

CC

RR

DD

b

c

b

e

a
Given (i)

(ii)

(iii) (iv)

30

30

Fig.3.12: Isometric view of a pentagon

Fig.3.13: Isometric view of a circle by 
four centre method

1

3

4 2

B

C

A

D

(a)

(c)

1
R

30° 30°

Rf

34

2

B

CA

D

r

r

e

(b)

1
30°

R

R

f

3

4

2

B

C

A

D

r

r
e



Isometr ic Project ions |  105 

Example 3.7 Draw the isometric projection of a square plate of side 60 mm with fillet radius of 12 mm 
in left lower and upper corners as shown in Fig.3.14(a) as is visible from front. 
Solution

•	Construct	 the	 square	abcd	using	 isometric	 scale.	
•	Draw	 the	 two	 isometric	 axes,	one	at	30°	 to	horizontal	 and	another	axis	vertical.	Mark	corner	

‘C’ at the junction of the isometric axes and construct the rhombus ABCD as described earlier. 
•	Mark	 the	points	M	and	N	at	 a	distance	equal	 to	fillet	 radius	12	mm	from	corner	A	on	AD	

and N on AB. 
•	Draw	lines	from	M	and	N	perpendicular	to	AD	and	AB	to	get	 the	center	C1.	With	the	center	

C1, draw the arc MN, with the given fillet radius C1 M and the same is repeated to get the 
arc at lower left corner with the center C2. Hence, complete the projection. 
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SolVED PRoblEMS (WITH INCREaSING DIFFICUlTy lEVEl)
Problems related to Conversion of orthographic views into isometric view
Example 3.8 Fig.3.15(a) shows the orthographic projections of an object. Draw its isometric view.
Solution The required isometric view is shown in Fig.3.15(b).

Fig.3.14: Isometric projection of a square plate

Fig.3.15(a): Given top, front and side views Fig.3.15(b): Isometric view

Isometric 
Projections of 
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Isometric 
Projections of 

3D objects
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Example 3.9 Fig.3.16(a) shows the top view and front view of cut block. construct the isometric view 
along with its dimension.
Solution Fig.3.16(b) shows the required isometric view. 

Example 3.10 Fig.3.17(a) shows the top view and front view of an object. Construct the isometric view.
Solution Fig.3.17(b) shows the required isometric view. 

Example 3.11 The top view and front view of the E block is shown in Fig.3.18(a). Draw its isometric view. 
Solution Fig.3.18(b) shows the required isometric view. 
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Example 3.12 Fig.3.19(a) shows a square headed bolt of 25 mm diameter and 85 mm long with a 
square neck of 25mm thickness and bolt head no chamfer. Draw the isometric view of a square bolt.
Solution Fig.3.19(b) shows the required isometric view. 

Example 3.13 The top view and front view of an object is shown in Fig.3.20(a). Construct an isometric 
scale and draw its isometric projection.
Solution Fig.3.20(b) shows the used isometric scale and Fig.3.20(c) shows the required isometric 
projection. 
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Example 3.14 The top view and front view of an object is shown in Fig.3.21(a). Draw the isometric 
projection.
Solution Fig.3.21(b) shows the required isometric projection.

Example 3.15. The top view and front view of an object is shown in Fig.3.22(a). Draw the isometric 
projection. Enter dimensions on the isometric drawing.
Solution. Fig.3.22(b) shows the required isometric projection. 
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Example 3.16 Fig.3.23(a) shows the orthographic projections of an object. Using isometric scale, draw 
its isometric projection.
Solution Fig.3.23(b) shows the required isometric projection. 

Example 3.17 Two views of a hut model are shown in Fig.3.24(a). Draw its isometric view. Need not 
dimension the isometric view. 
Solution Fig.3.24(b) shows the required isometric view

1. Isometric projection/view is a 3-dimensional (pictorial) view/projection whose principal faces 
and axes are equally inclined to the planes forming an angle of 120° with each other. 

2. Isometric projection is to be drawn with isometric scale. 
3. Isometric views are to be drawn with True scale. 
4. In isometric projection, all edges are equally foreshortened in the ratio √2 : √3 to that of 

actual dimensions. 
5. Isometric view of an object is larger than the isometric projection of the object.
6. Lines parallel to the isometric axes are termed as isometric lines. Lines which are not parallel 

to isometric axes are known as non-isometric lines.
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7. Planes representing the faces of the cube as well as other planes parallel to these planes are 
called isometric planes. Planes not parallel to isometric planes are non-isometric planes.

8. Isometric projection of prisms, cylinders and frustum of solids are drawn using ‘Box Method’. 
9. Isometric projection of pyramids, cones and truncated solids are drawn using ‘Co-ordinate’ 

or ‘off-set method’.
10. In ‘Isometric dimensioning’, it is usual practice to avoid the hidden lines, unless they are 

essential to make the drawing clear.
11. Isometric projection of a square is a rhombus and Isometric projection of a circle is an ellipse. 
12. To draw isometric projection of a circle, ‘Four centre method is an approximate method 

but comparatively simple method. 

a. objective questions

A1. Fill in the blanks with appropriate words
3.1 When a drawing is prepared with an Isometric scale is known as............................
3.2 The axes of an Isometric view are ....................... degree apart to each other.
3.3 The lines which are parallel to the Isometric axes are known as ............................
3.4 .................................scale is used to convert the true length into Isometric Lengths. 
3.5 In Isometric Projection, the vertical line on the object remains ...........................
3.6 Isometric view of an object is ........................ than the Isometric projection of the object. 
3.7 Isometric projection of a square is a ....................... shape.
3.8 To draw isometric projection of a circle, .............. method is comparatively simple method.
3.9 In Isometric projection, all edges are equally foreshortened in the ratio ................ to that 

of actual dimension.
3.10 ............................... Projection is more suitable for small objects. 
3.11 True lengths are used for drawing Isometric ..................................

EXERCISES

answers of Fill in the blanks questions

3.1 Isometric Projection; 3.2 120; 3.3 Isometric lines; 3.4 Isometric; 3.5 vertical; 3.6 larger;        
3.7 rhombus; 3.8 Four Centre method; 3.9 √(2):√3; 3.10 Isometric; 3.11 View
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A2. Multiple Choice Questions
3.1 Foreshortening term is not used for 

(a) Isometric view     (b) Orthographic View (c) Oblique View  (d) Cabinet View 
3.2 An Isometric scale is smaller than actual scale by 

(a) 0.67 times     (b) 0.71 times (c) 0.81 times      (d) 0.89 times  
3.3 Four Centre method is used to draw isometric view of a 

(a) triangle          (b) circle (c) square (d) rhombus
3.4 The angle that Isometric lines make with each other is 

(a) 60°  (b) 75°     (c) 90°     (d) 120°
3.5 On Isometric plane, a circle appears as 

(a) square  (b) quadrant of a circle      (c) an ellipse    (d) an involute 
3.6 The utility of an Isometric Scale is 

(a) to measure foreshortened lines   (b)  to project the object on projection plane          
(c) to measure diagonal lines         (d) to measure centre line  

3.7 Pictorial views drawn on Isometric scale are called 
(a) isometric view    (b) isometric projection  (c) isometric drawing  (d) multi view drawing 

3.8 Shape of a square in an Isometric plane remains appear as 
(a) square box      (b)  parallelogram         (c) square prism   (d) rhombus  

3.9 The appearance of an Isometric Projection as compare to an Isometric View is 
(a) smaller  (b) larger (c) more realistic (d) equal  

3.10 The ratio between the isometric and true length is  
(a) 2 / √3  (b)  √2 / 3 (c) √2 / √3 (d) 1- (√2/√3)

3.11 Select the correct Isometric view corresponding to the orthographic view shown in Fig.3.25.

       Fig.3.25: Orthographic views

(a) (b)

 (c) (d)

answers of Multiple Choice questions

3.1 (b); 3.2 (c); 3.3 (b); 3.4 (d); 3.5 (c); 3.6 (a); 3.7 (b); 3.8 (d); 3.9 (a); 3.10 (c); 3.11 (d)
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b. Subjective questions
3.1 Define isometric line and non-isometric line with the help of a sketch.
3.2 Define isometric axes and isometric planes.
3.3 Differentiate between isometric projection and isometric drawing.
3.4 Determine the relationship between true length and isometric length.
3.5 Describe the meaning of foreshortening in isometric view.
3.6 Explain the utility of an isometric scale.
3.7 Describe the constructional steps to be followed to draw an isometric Ssale.
3.8 List the different methods to draw isometric projection. Describe offset method.
3.9 Explain the principle followed to draw an isometric projection of an object by box method 

with a neat sketch.
3.10 Write the principles of dimensioning in isometric projection.
3.11 State the merit of drawing isometric view.
3.12 Describe the four centre method of drawing isometric projection of a circle with a neat 

sketch.
3.13 Draw the isometric drawing of the components shown in Fig.3.26
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Fig.3.26: Drawing of subjective problem 3.13
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3.14 Draw the isometric drawing of a rectangular prism of base 25 mm x 40 mm and the 
height 55 mm.

3.15 Draw the isometric view of square prism with a side of base 30mm and axis 50mm long 
when the axis is (a) vertical and (b)horizontal.

3.16 A cube, 30 mm edge, is placed centrally on the top of another square block, of 50 mm 
edge and 15 mm thick. Draw the isometric drawing of the two solids. 

3.17 The top view and front view of an object is shown in Fig.3.27. Construct an isometric 
scale used and draw its isometric projection.

3.18 Fig.3.28 shows the front and top view of a tray. Draw its isometric view with dimension.

3.19 Draw isometric view of  the stepped cut block, from the given two view in Fig.3.29.
3.20 Two views of a pin support are shown in Fig.3.30. Draw its isometric view. Need not 

dimension the isometric view.
3.21 The front and top view of an ink bottle are given in Fig.3.31. Draw its isometric view 

without labeling the dimension.
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PRaCTICalS

As per curriculum the practicals related to Unit-3 are:
1. Draw two problems on Isometric view of simple objects having plain and slanting surface 

by using natural scale.
2. Draw some problems on Isometric projection of simple objects having cylindrical surface 

by using isometric scale.

Practical-1 Draw Isometric View of object with Slant Surfaces

Practical statement
Draw two problems on Isometric view of simple objects having plain and slanting surface using 
natural scale.

Practical significance
Generally the orthographic views of an object are difficult to imagine and are separately drawn for top, 
front and side views. To visualize the object properly views like isometric, oblique and perspective are 
generally used. All the threes views are visible in a single isometric view and hence easy to understand. 
On the other hand for a designer, while developing new ideas, isometric sketching plays an important 
role in arriving at a final acceptable solution which can be shared with others and feedback can be 
taken even from a non technical person.

Relevant theory
Refer Section 3.0 of the book.
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Practical outcomes (PrO)
PrO1: Draw isometric view from given orthographic views of the object with slant surfaces.

Practical setup (Drawing/Sketch/Circuit Diagram/Work Situation)

Resources required
Same as mentioned in Practical-1 of Unit-1

Precautions
Same as mentioned in Practical-1 of Unit-1

Suggested procedure
1. Study the given front and side view of the object.
2. Sketch the isometric axes. 
3. Enclose the given object in a box of height as maximum height available in side or front view 

(50mm), of width as maximum width available in side view (45mm) and finally the length 
as maximum length available in front view (60mm). Sketch the box with light pencil (2H).

4. Remember that any vertical line in front and side view will remain vertical in isometric front 
and side view. Any horizontal line in front and side view will become 30° inclined in isometric 
front and side view while all line of top view will become 30° inclined from horizontal.

5. Draw the isometric view of the imaginary box keeping above rule in mind as shown in 
figure of Step-1.

6. The direction of arrow represents the front view of the isometric imaginary box. Now try 
to locate the points from orthographic front view to this front face of the box (as indicated 
by black bold dots).

7. Lay-off the distances in each face to locate all the features and points as shown in figure of 
Step-2.

8. Sketch the lines through these points and parallel both isometric axes as shown in figure 
of Step-3.

9. Complete the view by darkening the required lines as shown in observation section.
10. Dimension the final isometric view and add the necessary notes.

Front view Right side view

Isometric 
Projection- 
Object with 

slant surfaces
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Observations

Practical related questions
1. Explain the difference between Isometric view and Isometric projection.
2. Explain the natural/True scale and isometric scale.
3. Explain the method to locate the root or notch point of the V in isometric view.

Disposal of waste
Same as mentioned in Practical-1 of Unit-1

Environment friendly approach: Reuse, Reduce and Recycle
Same as mentioned in Practical-1 of Unit-1

Suggested learning resources
Refer Unit-3

Suggested assessment scheme
Same as mentioned in Practical-1 of Unit-1

SteP 1 SteP 2 SteP 3
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Practical-2 Draw Isometric Projection of object with Cylindrical Surfaces 

Practical statement
Draw Isometric projection of simple objects having cylindrical surface using isometric scale. A frustum 
of a cone of base diameter 50mm, top diameter 30mm and height 45mm is resting upon its base on 
HP. Draw its isometric projection.

Practical significance
Generally the orthographic views of an object are difficult to imagine and are separately drawn for top, 
front and side views. To visualize the object properly views like isometric, oblique and perspective are 
generally used. All the threes views are visible in a single isometric view and hence easy to understand.  
On the other hand for a designer, while developing new ideas, isometric sketching plays an important 
role in arriving at a final acceptable solution which can be shared with others and feedback can be 
taken even from a non technical person.

Relevant theory
1. Refer section 3.0 of the book.
2. Difference between Isometric View and Isometric Projection (refer section 3.3 of the book).
3. Refer section 3.4 (Example 6.0) of the book.
4. All isometric lines are shortened to 82% of their original lengths. To get the length of Isometric 

lines multiply their original lengths by 0.82. Following figure shows the isometric lines of a 
cube of 1 unit sides.

Practical outcomes (PrO)
PrO1: Draw isometric projection from given orthographic views of the object with cylindrical surfaces.

Practical setup (Drawing/Sketch/Circuit Diagram/Work Situation)
A frustum of a cone of base diameter 50mm, top diameter 30mm and height 45mm is resting upon 
its base on HP. Draw its isometric projection.

Resources required
Same as mentioned in Practical-1 of Unit-1

Precautions
Same as mentioned in Practical-1 of Unit-1

Suggested Procedure
1. Draw the Top and front orthographic views of the frustum of cone and enclose the circles 

of top view inside the squares.
2. Construct the isometric scale as outlined in section 3.2 of the book. 
3. Sketch the isometric axes. 
4. Draw the isometric square 1234 (Rhombus) for the base of the cone as shown in the figure. 

Isometric 
Projections-
Object with 

curved 
surfaces
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All sides of the isometric square are isometric hence each should be of 0.82 x 50 = 41mm 
length.

5. Now construct the isometric (Ellipse) ABCD inside the isometric square 1234 using four 
center method.
•	 Mark A,B,C and D as midpoints of the sides 1-2,2-3,3-4 and 4-1 respectively. Join (the 

ends of the minor diagonals) 1 to meet points B & C and 3 to meet points A & D. 
•	 Let B1 and A3 intersect at point K and D3 and C1 intersect at a point L. Then K, 3, L 

and 1 are the four centers for drawing the ellipse. 
•	 With center 1 and radius 1B draw Arc B-C. With center 3 and Radius 3A draw Arc 

A-D. With center K and radius KA draw Arc A-B. With centre L and radius LD draw 
Arc C-D.

•	 These Arcs join in the form of an Ellipse ABCD which represents the required isometric 
as shown in the figure.

6. Now draw the vertical axis PO of length 0.82 x 45 = 36.9mm from the center of the base 
ellipse in upward direction.

7. To draw top isometric circle about center O, draw 30° inclined lines EG and FH through 
point O of length equal to 0.82 x 30 = 24.6mm each. Draw second Isometric Square 5678 
(Rhombus) parallel to these lines and construct second isometric circle EFGH (Ellipse) inside 
this rhombus using same procedure as outlined in Step-5.

8. Draw the outermost generators of the frustum of cone as tangents to the two ellipses. 
9. Finish the view using proper line type and dimensioning. All construction lines should be 

draw thin (with 2H/H pencil) and the final entities should be thick (with HB/B pencil)

Observations

Practical related questions
1. Explain the difference between Isometric view and Isometric projection.
2. Explain the natural/True scale and isometric scale.
3. Explain the method to locate the point O in isometric projection.
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Disposal of waste
Same as mentioned in Practical-1 of Unit-1

Environment friendly approach: Reuse, Reduce and Recycle
Same as mentioned in Practical-1 of Unit-1

Suggested learning resources
Refer Unit-3

Suggested assessment scheme
Same as mentioned in Practical-1 of Unit-1

•	 Teacher shall collect few production/construction/electrical/electronic actual industrial 
component drawings to show them to the students with input.

•	 During the input sessions the teacher must give examples related to the relevant branch viz.
Mechanical and allied disciplines/electrical and allied disciplines/electronics etc.

•	 Teacher must know isometric view of objects having plain, slanting and cylindrical surface
•	 Show video/animation films to explain mentioned concepts.
•	 Use charts and industrial drawing/drawing sheets developed by experienced faculty to teach 

standard symbols and current industrial/teaching practices.
•	 Teachers should ask students to use url/qr codes available in the book for further 

understanding/practicing of the concepts.

applications (Real life / Industrial)
Isometric drawings are extensively used by designers–particularly architects, product/industrial 
designers & engineers, as they are ideal for visualising concept of complicated structures, assemblies, 
components, machine tools etc.

Isometric drawings are extensively used by interior designers for furniture design, furnishing 
residential buildings etc. Objects drawn using isometric projection gives a clear understanding of 
the object. This can be anything from single point cutting tools to CNC machines, sneakers to office 
revolving chairs. To draw any component in isometric drawings the very first thing is to draw a 
isometric axes and/or isometric scale. 

•	 Surf the web and list the isometric view used in industrial product
•	 Surf the web and list the isometric view used by architects and Builders
•	 Surf the web and list the isometric view used by interior designers and game designers

It is a standard practice of engineering companies to create isometric drawings for marketing and 
selling of their products/components. Some of the examples are as follows:

KNoW MoRE
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1.  Mobile phone 8.  Television
2.  Bearings 9.  Laptop
3.  Car 10. Pumps
4.  Cutting tools 11. Compressors
5.  CNC machines 12. Water coolers
6.  Washing machine 13. Furniture design
7.  Refrigerators and Air conditioners 14. Flanges, Valves, Elbows and other fittings

Inquisitiveness and Curiosity
Other than the classroom and drawing practice sessions, following are the suggested student-related 
co-curricular activities which can be undertaken to accelerate the attainment of the various outcomes 
in this unit:

Student should maintain a separate A3 size sketch book which will be the part of term work and 
submit it along with drawing sheets. Following assignment should be drawn in the sketch book:
1. A wooden sitting chair; Laptop computer; Wall clock; Steel almira; Refrigerator; Dovetail 

stop; Staircase
2. Isometric views: Each student of the batch will try to collect at least one production drawings/ 

construction drawings/ plumbing drawings from local workshops/builders /electrical and 
mechanical contractors and try to generate isometric views from the orthographic views  
given in the drawings.

3. Isometric and orthographic views: Each batch will collect a single point cutting tool from 
workshop and draw its isometric and orthographic views with a suitable enlarged scale. In 
carpentry shop each batch will try to make wooden model from these views.

4. Isometric views: The teacher will assign one set of orthographic projections and ask the 
student to develop 3D thermocol models of the same.

1. Engineering Drawing Practices for School and Colleges SP 46:2003, published by Bureau of 
Indian Standards, Government of India, Third Reprint, October 1998; ISBN:. 81-7061-091-2, 
Manak Bhavan , 9 Bahadur Shah Zafar Marg , New Delhi

2. Engineering Graphics for Degree, K.C.John , PHI publication,2010
3. A text Book of Engineering Drawing, K Venkata Reddy, BS Publication, 2008 
4. NPTEL Course Material on Engineering Drawing, P.S. Robi, Department of Mechanical 

Engineering, Indian Institute of Technology Guwahati, India: https://nptel.ac.in/
courses/112/105/112105294/

REFERENCES & SUGGESTED REaDINGS



Free Hand Sketches of 
Engineering Elements4

unit specifics
This unit presents information related to following topics:

•	 General Guidelines for freehand sketching 
•	 Free hand sketches of machine elements
•	 Free hand sketches of orthographic view
•	 Free hand sketches of isometric view

The understanding of these topics will be developed after reading the contents, completing the solved 
problems, activities, performing exercises and viewing the ICT and web resources mentioned in this 
unit.

At the end of the unit, summary is provided to recapitulate the topics covered and applications 
are mentioned so that the learner can correlate the presented knowledge with real life and industrial 
situations. Few activities are mentioned to create inquisitiveness and curiosity in the learner. Subjective 
and objective questions are provided for the reinforcement of the knowledge and a list of references 
and suggested readings is also provided for further learning. Video resources along with QR codes 
are mentioned for getting more information on various topics of interest which can be surfed or 
scanned through mobile phone for viewing. Practical with details are provided to horn the drawing 
and drafting skills.

Rationale
After studying unit 2 and 3, you are well familiar with orthographic projection and isometric projection 
and also done enough practice work for the conversion of orthographic views into pictorial drawing 
and vice-versa. In this unit, we will discuss the application of principles of freehand sketching. Free-
hand sketching plays an important role in the preparation of drawing in engineering field. Therefore, 
it is essential to the designer to records his clear and concise ideas in the form of sketches which are 
later converted into working production drawings. 

It is usually assumed that skill in sketching may be acquired more easily than proficiency in 
instrumental drawings. This is not so because, both in sketching and instrumental drawings, the same 
basic principles of drawing must be employed. A lot of effort and practice are required to sketch 
say, two parallel lines, a circle, etc. then to draw the same. A student is therefore advised to acquire 
the sketching skills through constant effort and practice because later in his career, he must be in a 
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unit-4
outcome

eXpecteD MappinG WitH couRse outcoMes
(1- Weak Correlation; 2- Medium Correlation; 3- Strong Correlation)

co-1 co-2 co-3 co-4 co-5 co-6

u4-o1 - 1 2 3 3 -

u4-o2 - 1 3 3 3 -

u4-o3 - 1 3 3 3 -

4.1 GeneRal GuiDelines foR fReeHanD sketcHinG
Freehand sketching is one of the most effective ways to communicate a pictorial or verbal idea to a 
workman. For freehand sketching of an object, consider the following general guidelines

1. When sketching, use a suitable paper and pencil.
2. Carefully examine the object to be sketched and describe the shape of the object completely. 
3. Showing the relative parts in fair proportion but not to any particular scale.
4. Add all essential dimensions wherever necessary.
5. Have notes to specify, for example, the material used, manufacturing methods etc.

4.1.1 Materials for sketching
Freehand sketches show generally what a viewer visualises rather than technical details. The main 
sources of freehand sketching are imagination and modifying existing sketches. These freehand sketches 
are drawn with minimum resources, which include the following things: 

better position to express his ideas through, on the spot sketches, not only to his superiors but also 
to his sub-ordinates.

pRe-Requisites
Before reading this unit the student is advised to revisit following: 

•	 Unit-2 and Unit-3 of this book. 

unit outcoMes
After reading the contents, completing the solved problems, activities, exercises and viewing the web 
resources mentioned in this unit the students are expected to:

U4-O1:  Sketch proportionate freehand sketches of machine elements such as nuts, bolts, studs, 
 locking devices etc.

U4-O2:  Draw sketches of orthographic views of the given objects on squared graph paper.
U4-O3:  Sketch an isometric view from given orthographic views on isometric grid sheet.
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•	 Pencil - The pencil should be soft enough to give a good texture on a medium rough paper. 
Though any of the soft pencil in the range F to 2H can be selected but the HB grade pencil is 
mostly preferred. 
•	 Paper - Depending upon the condition of work and the purpose of drawing, a variety of 
papers are used for sketching. An engineer working in a design office should use a drawing 
sheet or sketch paper of a good quality. For sketching the different views of a component and 
to produce dimensioned sketches, squared graph paper (Fig.4.1) is used. Similarly, isometric 
grid sheet (Fig.4.2) is used to prepare isometric 3 dimensional sketches. In the beginning, one 
can practice freehand sketching using plain paper, so that develop a good sense of proportion, 
accuracy of observation and proper use of pencil work. 
•	 Eraser - A good quality soft eraser is required to make the sketches neat and clean. 

4.1.2 General sketching elements to Draw shapes of objects
The shapes of objects are made-up of flat and curved surfaces, which are represented by straight and 
curves lines and hence the student must first develop skill in sketching these elements rapidly and 
accurately.

4.1.3 sketching of straight lines

fig.4.1: Squared graph sheet fig.4.2: Isometric grid sheet

fig.4.3: Sketching different kinds of line fig.4.4: Sketching a square
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The first step in making any straight line is to determine its length by lightly marking its end points. 
Sketchy dashes are then tried between these end points, correcting the angle of direction in each 
stroke. The gaps are then closed in stages and the line is thin darkened to full intensity. Fig.4.3 
indicates the directional motion to be adopted for drawing different kinds of lines such as horizontal, 
vertical or inclined.

4.1.4 sketching a square 
Fig.4.4 indicates the steps to be followed in sketching a square. 

4.1.5 sketching of circles and arcs
Small circle and arcs can be drawn easily in one or two strokes without using any guiding block. 
There is a systematic method for sketching large circle and arcs.

One method of sketching a large circle, is estimate the radii and marked it on horizontal and 
vertical centre lines to locate a square. Sketched inside the square as shown in Fig.4.5.
In another method, the radii are estimated and marked off on the lines indicated to locate the points 
through which the circle will be sketched. See Fig.4.6.

4.2 fReeHanD sketcHinG of MacHine eleMents 
All machines are made of several component parts. The devices used for holding together two parts 
of a machine or structure are called fasteners. The fasteners are classified into two main categories:

1. Temporary fasteners and 
2. Permanent fasteners 

A screw thread is the functional element used on a bolt, stud, set-screw or any other threaded 
piece or components. All screwed pieces fall under the category of temporary fasteners. Temporary 
fasteners are widely used in joining the machine parts and other engineering products where frequent 
dismantling is required. Nuts and bolts, screws, studs and pins are examples of temporary fasteners, 
whereas riveting, welding, soldering and brazing etc. are permanent fastening.

4.2.1 parts of a screw thread
In a study of threads and their representation on a drawing, it is necessary to define a few important 
terms used in specifying any thread. Different parts of a screw thread are shown in Fig.4.7 and 
defined below. 
Outside or major diameter: It is the diameter at the crest of the thread measured at right angles to 
the axis of the screw.

fig.4.5: Sketching a circle fig.4.6: Another method of sketching a circle
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Core or minor diameter: It is the 
diameter at the core or root of the 
thread. It is the smallest diameter of 
the screw and is equal to the outside 
diameter minus twice the depth of the 
thread.
Effective diameter: It is equal to the 
length of the line, perpendicular to and 
passing through the axis, and measured 
between the points where it cuts the 
flanks of the thread.
Nominal diameter: It is the diameter 
of the cylindrical piece on which the 
thread is cut. The screw is specified 
by this diameter. 
Pitch: It is the distance measured parallel to the axis, between a point on one thread form and a 
corresponding point on the adjacent thread form, i.e. from crest to crest or root to root. It may also 
be described as the reciprocal of the number of thread forms per unit length, i.e. P = 1/N.
Root: The root is the inner-most or bottom surface created by two adjacent flanks of the thread.
Crest: It is the outer-most or top surface part of the thread. 
Flank: The surface between the crest and the root is called the flank of the thread. 
Angle: It is the angle between the flanks measured on an axial plane. 
Lead: It is the distance measured parallel to the axis from a point on a thread to a corresponding 
point on the same thread after one complete revolution. It can also be described as the distance 
moved by a nut in the axial direction in one complete revolution. The lead is equal to the pitch in 
case of single-start threads. 
Depth of thread: The depth is the distance between the crest and the root, measured at right angles 
to the axis. It is equal to half the difference between the outside diameter and the core diameter.
Slope of thread: It is equal to one-half the pitch of the thread.

4.2.2 types of thread profile
It is the shape of a thread on a section plane containing the axis of thread. It is often called the profile 
of thread. Basically two types of profiles are there, one is square and another is triangular. All the 
available and used types of profiles are minor modifications of either square or triangular thread. Each 
type has different application. Pitch of the profile depends upon the nominal diameter. Fig.4.8 shows 
various profiles, their shape and proportions in terms of pitch. Use of each profile is discussed below.

V thread (metric thread)
The Bureau of Indian Standards has adopted V-thread profile recommended by the International 
Organisation for Standards (ISO) a metric screw thread for use in our country.
This types of screw threads are also known as Unified Thread. It has a 60° thread angle between the 

fig.4.7: Different parts of a screw thread
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adjacent inclined surfaces. Since such a profile has sharp edges that can cause injury while using and 
hence avoided. 

A practical modification of this groove is a metric thread in which the sharp crest is truncated. 
External threads are flat at crest of length P/8 and root is rounded with radius of 0.1P (Fig.4.8b). 
This profile is used by most of the thread fasteners. 

British Standard Whitworth (B.S.W) thread
A similar shape as that of V threads, but the included angle as 550 is used for British Standard 
Whitworth thread (Fig.4.8c). The depth of thread is 0.64P and radii at root crest are 0.14P.

Square thread
Since these types of screw threads are in the form of a square, it is called square thread. The flanks 
or the sides of this thread are perpendicular to the axis of the thread. The depth and thickness of 
the thread are equal to half of the pitch (Fig.4.8d). A modified square thread has a slight taper of 50 
on the both flanks to form included angle of 100 (Fig.4.8e).

It is the simplest and strong type of thread profile and hence used for transmission of motion 
and power as in vices, clamps etc. and for converting a rapid rotary motion into slow linear motion, 
for example, the lead screw of a lathe, screw presses, jacks etc.

Acme thread
An Acme thread is a slight modified form of a square thread and the sides are inclined at 14.50 

(Fig.4.8f). A half nut is used to connect and disconnect the power from these screws. It is strong thread 
because of wider base with the added advantage of easy operation of engagement and disengagement 
of the half nut due to the inclined surfaces. 

It is suitably used for power screws like the breaks screw, jack screws and on the value operating 
screw for axial power transmission. 

Buttress thread
Buttress thread is designed to transmit power in one direction only. It is commonly used in large 
guns, in jacks and in other mechanisms that have high-strength requirements. It has efficiency of 
square thread and strength of V-thread, earlier it was produced with one phase as vertical, but never 
profile have slope of 70 with vertical (Fig.4.8g), while other face at 450.

Knuckle thread
A semi-circular profile of radius P/4 is used for these threads (Fig.4.8h). This profile is suitable if 
threads are to be formed by moulding or rolling like sheet metal covers for jars.

Thread presentation
True representation of thread is difficult and time consuming and hence not used. In true representation, 
crest and root lines are helix, which is laborious. In drawing threads are generally represented 
by simplified or conventional method. Fig.4.9 and 4.10 shows the simplified and conventional 
representation of thread.
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Simplified representation of thread
In simplified method, the V profile of V threads is not drawn. The crest lines are represented by 
thin lines at distance P, inclined at helix angle and root lines by thick line in between the thin lines 
(Fig.4.9). In the side view, the outer diameter is drawn by full circle, while the root diameter is drawn 
a circle slightly more than 3/4 circle. Gap of the circle for root diameter can be shown in any position. 

Conventional representation of threads
This is the simplest method. A thin line parallel to the major diameter at distance equal to the depth 
of the thread is drawn (Fig.4.10). It gives no idea about the hand of helix and start of threads, etc., 
hence these are to be mentioned separately by a note. If not mentioned, it is presumed that it is a 
single start, right handed thread.
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fig.4.8: Different types of thread profile
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fig.4.9: Simplified representation of thread fig.4.10: Conventional representation of thread
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4.2.3 Drawing a Bolt, nut and Washer
The bolt and nut joint or screwed fastening is a temporary joint. A bolt is a cylindrical part having 
a hexagonal or square head on one side and threads, partially or completely on the cylindrical part. 
The counter part of the bolt is a nut that is also either hexagonal or square and has internal threads 
with same pitch as that of the bolt. The parts to be joined together are drilled with a hole of the 
same size as the body diameter of the bolt or slightly more for easy insertion. The bolt is then passed 
through the parts to be joined and then the nut is tightened on the threads of the bolt. When the 
nut is rotated, it advances on the threaded body of the bolt and clamps the parts. 

A washer is placed below the nut so 
that the surface of the part is not spoiled 
due to tightening of the nut. It also increases 
the contact area, thereby reducing the local 
intensity of stress. Fig. 4.11 is a display 
of pictorial view of hexagonal bolt with 
hexagonal nut and washer. Fig. 4.12 is a 
detailed drawing because it gives the required 
details of individual parts of an assembly 
of hexagonal bolt, nut and Fig.4.13 shows 
orthographic views of the same assembly.

fig.4.11: Pictorial view of hexagonal bolt with hexagonal 
nut and washer
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fig. 4.12: Detailed drawing of hexagonal bolt, nut and washer
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fig.4.13: Orthographic views of hexagonal bolt, nut and washer
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4.2.4 studs
Studs are used for components that are removed frequently like cylinder heads, cover etc. A stud does 
not have a head and is cylindrical in shape having threads of the same hand (generally right hand) 
on both sides as shown in Fig.4.14. The length of the stud can be divided in three areas: 

1. Metal End: this is fully tightened in one of the components. Its length varies from D to 1.5D.
2. Plain Portion: It is the unthreaded portion of the stud. Its length is about 0.5 D, but can 

have more length also. This portion accommodates other parts. 
3. Nut End: The nut is tightened at this end. Its length is kept as 2D+ 6 to 25mm.

The metal end is tightened into the tapped hole (threaded hole) of the body. The remaining portion 
guides the removable part to be positioned. Then the nut is tightened. Engine cylinder heads are 
tightened using studs and not bolts.

4.2.5 screws
A screw is smaller in size both for diameter and length than a bolt and has threads for the entire 
length of the shank. The head is not hexagonal but circular. The various shapes of the heads used for 
the screws are shown in Fig.4.15. There are many types of screws and are described below.
Cap Screw: When a screw is tightened in tapped hole, it is known as cap screw.
Machine Screw: If a screw uses a nut on the other end, it is called as machine screw (Fig.4.16). They 
have a good finish and are used for light applications. They are made of steel or brass.
Set Screw: A set screw is tightened in a tapped hole in an outer part to press the inner part to keep 
it in position, e.g., a screw in the knob of a microwave, washing machine etc. The ends are therefore 
given a pencil shape like cone, dog or cup as shown in Fig.4.17.

D
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fig. 4.14: A stud
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fig. 4.15: Shapes of screw heads fig. 4.16: Machine screw
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fig. 4.17: Types of screw ends 

4.2.6 locking arrangements for nuts
When bolts and nuts are used in machine elements having vibrations, there are chances of getting 
them loosened. The loosening can go to the extent that the nut may come out completely and cause 
hazards. To keep the nut at the tightened position, locking devices are used. A large number of 
locking devices are available, some of which are as follows:

1. Jam Nut or lock nut: A lock nut is an additional nut placed theoretically below the main 
nut. This is about one half or two third thickness of standard nut.

2. Castle nut: It is a hexagonal nut with cylindrical upper part. This part is slotted in line with 
the centre of each face. A split pin is inserted through two slots in the nut and a hole in 
the bolt. This used in automobile industry.

3. Sawn nut: It has a slot sawn half way through. After the nut is tightened, the small screw is 
screwed which produces more friction between the nut and the bolt preventing the loosening 
of the nut.

4. Penn, ring or grooved nut: It has a upper hexagonal part and a lower cylindrical part. The 
bottom cylindrical portion is recessed to receive the tip of locking set screw.

5. Locking with pin: The nuts are locked by means of taper pin or cotter pin.
6. Locking with plate: A plate or locking plate is used to lock the bolt.
7. Spring lock washer: As the nut is tightened, one edge of the washer will be digging itself in 

the that piece thus increasing the resistance so that the nut will not be loosened.

Some of the locking devices are shown in Fig.4.18.

fig.4.18: Locking devices
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4.2.7 sketching Machine parts
When making a technical sketch of a machine part 
begin with constructing its overall outlines (the so-
called "dimension cage") in light lines. In our example 
[Fig.4.19(a)] such a dimension cage is a rectangular box. 
Since any machine part may be thought of as consisting 
of separate elements which resemble some geometrical 
solids, sketch all elements step by step until the whole 
machine part is obtained. Finish the sketch by adding 
surface shading, as in Fig.4.19(b). 

When sketching a machine part from a model, 
for example, a cam, as in Fig.4.20(a), the student, 
while carefully scrutinizing its shape, must also 
compare the size of its separate elements, thus 
developing his sense of proportionality. Presented 
in  Fig.4.20 are two technical sketches made from 
one and the same model. It is quite obvious 
that the sketch in Fig.4.20 (b) is incorrect, since 
proportionality is not observed. The distance b is 
not uniform and therefore the line of intersection 
(a portion of an ellipse) of the flat lug with the 
cylinder is incorrect. As compared with the 
model, dimension k is considerably enlarged, the 
thickness of the cylinder wall is reduced, as is 
the depth of the slot e. The dimension e must 
be approximately 2.5 times larger than a, while 
in Fig.4.20(b) they are equal. Fig.4.20(c) gives a 
correct version of the sketch. 

4.2.8  Hints on drawing a Hexagonal 
nut

1.  Work out the required dimensions that is 
nominal diameter of bolt, height of nut, 
size across flats, radius of front chamfer 
and radius of crest of the thread etc.

2.  Draw the centrelines, horizontal and vertical, to locate the centre of circled into view.
3.  Commence drawing from top view, as it contains circles. Draw the two circles for root and 

crest of threads and also draw the third circle for chamfer on the nut.
4. Outside the chamfering circle, complete the hexagon.
5. Project the corners of the hexagon, thus drawn, to front view and draw two parallel horizontal 

line apart by height of nut, already calculated, to cut these projections.
6. Draw the front chamfer arc in front view and project its point of intersection with the two 

inner vertical projections, horizontally.
7. Locate the centre of the remaining arc and complete the views.

fig.4.19: Typical machine element

fig. 4.20: A cam
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4.3 fRee HanD sketcHes of oRtHoGRapHic vieW
Theory of orthographic projection has already been discussed in detail in unit 2. All the rules and 
conventions discussed there are applicable in orthographic sketching. Orthographic sketches are made 
either on plain paper or squared graph sheet.

Orthographic sketching may require sketching any combination of the six principal views of 
the object. Usually the front, top and right side views are selected for describing an object in an 
orthographic sketch. In general, a combination of views that show the most detail and the least 
number of hidden lines should be chosen. 

The procedure followed in making a sketch is almost the same as that in drawing with instruments. 
Though the sketch is not made to scale, yet it should be fairly proportionate and should be according 
to all the conventional practices of projection. A well-prepared sketch should give the same good 
appearance as a good instrument drawing. The pictorial view of an object is given in Fig.4.21 (a).  
The steps to be followed in making a freehand sketch of orthographic views of a given object are 
illustrated below in Fig.4.21.

Step 1. Study the given object until its shapes and functions are understood. Decide the views 
which best describe the shape of the object.
Block in the views in light lines and space the views to give a balanced appearance to 
the sketch.

Step 2. Add the details in each view in light construction lines, so that they need not be erased.
Step 3. Sketch the required arc and circle in each view by any one of the method as shown in 

Fig.4.5 and 4.6. 
Step 4. Sketch the additional required lines and brightening the circle and arc in each view.
Step 5. Sketch the required hidden lines, brightening the visible lines, add the necessary dimensions 

and name the views of the drawing.

16

36
40 28

16

16
20

32

24
18

6

12

12

72

36
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Given (a) step-1: Block in view

step-2: Add details in light lines step-3: Construct arc and circle 
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4.4 fRee HanD sketcHes of isoMetRic vieW
Theory of isometric drawing has already been discussed in detail in unit 3. All the rules and conventions 
discussed there are applicable in isometric sketching. Isometric sketches are made either on plain 
paper or isometric grid paper. Though any of the methods used in making isometric sketching can 
be adopted for making isometric sketches, yet the Box-construction method is mostly preferred. 
The procedure followed is the same as that used in isometric drawing. Two orthographic views of 
the object are given in Fig.4.22(a). The following steps are usually used for freehand sketching of 
isometric view:

Step 1. Study the orthographic views of the object and decide the position in which it should 
be placed to reveal the maximum details. Lay out the isometric axes, which should be nearly 
120˚ apart from each other, i.e. one axis vertical and the other two at 30˚ (approximately) 
with horizontal.

Step 2. Taking the proportions length, width and height  along the isometric axes, complete the 
enclosing box. As the accuracy of the sketch depends upon the accuracy of the isometric 
box, the following points should be observed carefully: -
•	 Vertical	 edges	must	be	vertical.	
•	 Transverse	 lines	must	be	parallel,	may	be	 little	 converging	but	never	diverging.	
•	 The	angle	of	 the	 inclines	 axes	 should	never	be	more	 than	30˚.	

Step-3. Transfer the details from orthographic views to the isometric box. Take the proportions             
along or parallel the isometric axes only.  For non-isometric lines, first locate the end   
points to establish the line. 

Step-4  Sketch additional required non- isometric lines and circle & arcs and brightening the 
desired surfaces.

Step 5. Brighten the required lines and complete the view with all the necessary dimensions.

Fig.4.22 illustrates the step-by-step construction of an isometric sketch.

step-4: Add necessary lines step-5: Add necessary hidden lines, dimensions 
and name the views

fig.4.21: Steps in sketching of orthographic view
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fig.4.22: Steps in sketching of an isometric view
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1. Freehand sketching is one of the most effective ways to communicate a pictorial or verbal 
idea to a workman.

2. Three things absolutely essential for sketching work are pencil, eraser and paper.
3. A pencil of the grade HB is preferred for sketching works.
4. The sketches drawn using only pencil and eraser are called 'Free Hand Sketches'.
5. Designers, engineers,  artists and teachers use this for immediate graphical communication.
6. In all fields of engineering these are essential to draw the diagrams, prepare the layouts, 

think  of a design etc.
7. To start with grid sheets help to practise well.
8. Vertical lines are to be drawn from top to bottom.
9. Inclined lines are to be drawn from lower left to upper right.
10. Arcs of small radii and circles are conveniently drawn by constructing squares.
11. A sketch is considered to be good when its features are shown in correct proportions.

a. objective questions

A1. Fill in the blanks with appropriate words
4.1 In industry, freehand sketches are employed to present the ideas of the ---------- to  others 

or the management. 
4.2 A pencil of the grade -----------is preferred for sketching works. 
4.3 Sketching a --------------is also useful in sketching circles. 
4.4 Circular feature in isometric projection, appear as ----------- feature. 
4.5 Shop drawings are supplied in the form of ------------- views. 
4.6 A washer is used to protect ------------ surface and distribute stresses.
4.7 Locking devices are used so that the --------- does not open.

unit suMMaRY

eXeRcises

answers of fill in the Blanks questions

4.1 Designer/engineer; 4.2 HB; 4.3 square; 4.4 elliptical; 4.5 orthographic views; 
4.6 Bottom surface; 4.7. nut
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A2. Multiple Choice Questions
4.1 Flank in a screw member is the

(a) unthreaded portion    (b) inclined surface of the thread  
(c) extreme surface of the screw member  (d) inner most part of the thread  

4.2 Thread angle of BSW thread is 
(a) 55˚ (b) 60˚      (c) 29˚  (d) 45˚ 

4.3 Buttress threads are used for applications where there is 
(a) heavy load      (b) high speed   
(c) power load is in one direction only   (d) high load and speed  

4.4 Length of bolt is specified as measured from  
(a) top of head to end of bolt  (b) bottom of head to end of bolt  
(c) where the threads start to end  (d) bottom of head to start of threads  

4.5 A stud is used where  
(a) bolt cannot be used   (b) heavy load is on bolts   
(c) parts are removed frequently   (d) no space is there for bolt head 

4.6 A screw has its top head that is generally 
(a) circular   (b)  square  (c) hexagonal (d) octagonal  

4.7 A lock nut is different from ordinary nut with regard to
(a) height (b) diameter  (c) type of threads (d) shape  

B. subjective questions
4.1 List the applications of free hand sketching.
4.2 List the materials for free hand sketching.
4.3 Explain the procedure to draw freehand lines on a technical sketch at an angle of 30˚ 

and  45˚ with the horizontal.
4.4 Write the steps to be followed in freehand sketching of:

(a) square (b) circle and (c) ellipse
4.5 Define the term fastening and its types. Under what circumstances each type is used?
4.6 Give different applications of thread.
4.7 Define at least five parts of a screw thread.
4.8 Explain the conventional method for drawing threads.
4.9 Describe the steps to be followed in sketching orthographic views of an object.
4.10 Write the steps to be followed in sketching isometric projection of an object, from the 

given orthographic views.

answers of Multiple choice questions

4.1 (b); 4.2 (a); 4.3 (c); 4.4 (b); 4.5 (c); 4.6 (a); 4.7 (a)
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4.11 Make freehand Sketches of the following machine elements:
(a) Hexagonal headed bolt and nut taking bolt diameter as 40 mm.
(b) Square headed bolt and nut taking bolt diameter as 24 mm.
(c) Nut and lock nut.
(d) Ring nut.

4.12 Draw two views of bolt and nut of diameter 20mm and the length 75mm with square head.
4.13 Draw front, side and top view of a hexagonal bolt of diameter 24mm and length 85mm 

along with its nut and washer.
4.14 Draw freehand the isometric projection of the following :

(a) A cube of 50 mm side
(b) Hexagonal prism with side of 50 mm and 80 mm long

4.15 Make sketches of two simple models of machine parts as shown in Fig.4.23 (a) and (b).
4.16 Two orthographic view of an object are given in Fig.4.24. Add third view in both cases. 

You may draw isometric views in given isometric block with grid.
4.17 Sketch by freehand the front, top and left side view of each object as given in the Fig.4.25 

on squared graph paper.
4.18 Sketch the isometric view of each on isometric grid as shown in Fig.4.25.

fig.4.23: Pictorial views for subjective problem 4.15

(a)                        (b)
fig.4.24: Pictorial views for subjective problem 4.16



138  |  Engineer ing Graphics

As per curriculum the practicals related to Unit-4 are:
1. Draw free hand sketches/ conventional representation of machine elements in sketch book 

such as thread profiles, nuts, bolts, studs, set screws, washers, Locking arrangements.
2. Problem based Learning: Given the orthographic views of at least three objects with few 

missing lines, the student will try to imagine the corresponding objects, complete the views 
and draw these views in sketch book.

practical-1 Draw free Hand sketches/conventional Representation of 
Machine elements

Practical statement
Draw free hand sketches/ conventional representation of machine elements in sketch book such as 
thread profiles, nuts, bolts, studs, set screws, washers, Locking arrangements.

Practical significance
Generally in the process of engineering design, the first step is conceptual design, i.e. formulation of 
idea. This concept has to be transferred on paper, generally by freehand sketching without the aid of 
drawing instruments because it require several modification based on the discussion and feedback in 
arriving at a final acceptable solution. 

fig.4.25: Pictorial views for subjective problem 4.17 and 4.18

pRacticals
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Relevant theory
Refer section 4.0 of the book.

Practical outcomes (PrO)
PrO1: Draw free hand sketches/ conventional representation of machine elements..

Practical setup (Drawing/Sketch/Circuit Diagram/Work Situation)
Create 10 free hand sketches of following fasteners:

(a) Stove bolt (b) Stove bolt (c) Collar screw (d) Hanger bolt (e) Lag screw

(k) Ribbed neck(i) Fin neck(h) Square neck

(n) Turnbuckle (o) Clevis

(p) Heli-coil insert(u) Drive screw(t) T-head bolt(s) Wing nut

(q) Wood screw

(g) Track bolt(f) Step bolt

(l) Countersunk 
bolt

(m) Round head 
bolt (buton head)

Carriage bolts
(j) Countersunk 

square neck

(r) Thumb screw

(v) Patch screw (w) Plow bolt (x) Eye bolt (y) U-bolt (z) Hook bolt
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Resources required
Same as mentioned in Practical-1 of Unit-1 except drawing instruments, T-Square, Set Square, Mini-
Drafter. Further, Machine element Conventional Representation BIS codes are also required. Rectangular 
and Isometric grid or graph papers are also required.

Precautions
1. Use appropriate type of Pencil based on the type of line use.
2. Don’t use blades or paper cutters to sharpen the Pencils.

Suggested procedure
1. To make a good sketch, it is necessary that one should be able to draw straight lines, curves, 

etc. without any external aid. In the beginning, one should practice to draw horizontal 
and vertical lines. It may not be exactly to scale, but it should be proportional for better 
understanding. 

2. For example if free hand sketching of a ratchet is required then following suggestive steps 
can be taken up:

Step 1 Step 2 Step 3 Step 4

3. Initially a Rectangular grid or an Isometric grid can be used to draw the components in 
orthographic and Isometric views.
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Observations

Practical related questions
1. Explain the difference between a rectangular and Isometric grid.
2. Write five applications of each Screw and Nut-Bolt

Disposal of waste
Same as mentioned in Practical-1 of Unit-1

Environment friendly approach: Reuse, Reduce and Recycle
Same as mentioned in Practical-1 of Unit-1

Suggested learning resources
Refer Unit-4 
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Suggested assessment scheme

performance indicators Weightage/
Marks

Marks 
awarded

process related: 5 Marks* (33%)

1 Use of appropriate pencil while drawing different entities 3

2 Not taking support of others to draw given problem(s) 2

product related: 10 Marks* (67%)

3 Neatness, Cleanliness on drawing sheet/sketch book 1

4 Closeness of free hand sketches to actual counterparts 3

5 Uniformity in drawing and line work 1

6 Creating given drawing with all problems solved 4

7 Submission of drawing in time 1

total 100 %

* Marks and percentage weightages for product and process assessment will be decided by the teacher.

name of the student: ……………………………………….. 
Marks awarded

signature of teacher 
with date

Process Related Product Related Total
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practical-2 Draw Missing views and information

Practical statement
Given the orthographic views of at least three objects with few missing lines, the student will try to 
imagine the corresponding objects, complete the views and draw these views in sketch book (Problem 
based Learning).

Practical significance
Practice to identify missing views and information is very helpful in further strengthening of engineering 
drawing concepts, Orthographic views, Isometric views and visualization ability in a student.

Relevant theory
Refer section 4.0 of the book.

Practical outcomes (PrO)
PrO1: Draw missing views and information in the given orthographic views and isometric views.

Practical setup (Drawing/Sketch/Circuit Diagram/Work Situation)
Identify the missing views and lines in the following situations (First Angle Projection). 

Resources required
Same as mentioned in Practical-1 of Unit-4.

Precautions
Same as mentioned in Practical-1 of Unit-4.
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Suggested procedure
1. In situation-1 if you examine critically there is no missing information in front and side 

views but when we look from the top of the object then three circles should be visible hence 
one circle is missing in the top view. 

2. In situation-2 the front view shows a circular hole while it is hidden in top and side views 
hence in top and side views it should be represented by a pair of two parallel dotted lines. 
In top view the dotted lines are present but in side view the dotted lines for circular hole 
are missing. Similarly in front view there is a rectangular through slot in the base hence its 
corresponding dotted lines in top and side views should be available. One dotted line in side 
view and two dotted lines in top view are to be drawn to make them complete. As one of 
the edges of the hole is in line with one of the edges of slot hence in top view some part of 
the right dotted lines for hole and slot are overlapping.

3. In situation-3 the projection of bigger circular block is missing in the side view. Hence a 
rectangle of height equal to diameter of circular block and width equal to thickness of circular 
block should be drawn in side view to make it complete.

4. In situation-4, the front view has got a circular through hole which is hidden in other two 
views hence dotted lines corresponding to this circular hole in top and side views should 
be drawn. Similarly, in left side the inner edge of rectangular slot should be represented by 
two vertical dotted lines in the given side view. 

Observations
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Practical related Questions
1. In situation-3 two vertical dotted lines are shown. Explain the presence of these lines and 

why they are dotted.
2. In situation-4 four vertical dotted lines are shown. Explain the presence of these lines and 

why they are dotted.

Disposal of waste
Same as mentioned in Practical-1 of Unit-4.

Environment friendly approach: Reuse, Reduce and Recycle 
Same as mentioned in Practical-1 of Unit-4.

Suggested learning resources
Refer Unit-4

Suggested assessment scheme
Same as mentioned in Practical-1 of Unit-4.

•	 Teacher	 shall	 collect	 few	production/construction/electrical/electronic	 actual	 industrial	
component drawings to show them to the students with input. 

•	 During	 the	 input	 sessions	 the	 teacher	must	 sketches	 some	objects	 	by	 freehand	on	white	 /
black board related to the relevant branch viz. mechanical and allied disciplines/electrical 
and allied disciplines/electronics etc. 

applications (Real life / industrial)
Freehand sketching has applications in the following areas :-

•	 In R&D section, while designing new products or any changes in the existing design the 
designer makes sketches or schematic diagrams to conveyed his ideas to a draftsman or others.

•	 In production and  maintenance departments, freehand sketches are prepared to give details 
about the part to be repaired or modification needed in an existing structure of machine etc.

•	 Freehand sketching helps the teacher to explain concepts in the classroom.

inquisitiveness and curiosity
Other than the classroom and Drawing practice sessions, following are the suggested student-related 
co-curricular activities which can be undertaken to accelerate the attainment of the various outcomes 
in this unit:

knoW MoRe

Missing lines 
and missing 

views
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a. Student should maintain a separate A3 size sketch book which will be the part of term work 
and submit it along with drawing sheets. Following assignment on orthographic views should    
be drawn with a suitable dimension in the sketch book-
i. Electric motor
ii. Car model
iii. Computer monitor
iv. Electronic circuit board
v. Staircase
vi. Multi views of a house

1. Engineering Drawing Practices for School and Colleges SP 46:2003, published by Bureau of 
Indian Standards, Government of India, Third Reprint, October 1998; ISBN:. 81-7061-091-2, 
Manak Bhavan, 9 Bahadur Shah Zafar Marg , New Delhi

2. Online course material on Free hand sketching, T. Jeyapoovan Thangasamy, Department of 
Mechanical Engineering, Hindustan Institute of Technology and Science, Chennai, India, 
https://fdocuments.in/document/lesson-14-freehand-sketching-orthographic-projections-
part-i.html

3. Online course material on Free hand sketching, https://deseng.ryerson.ca/dokuwiki/_media/
mec222:asc3.pdf

4. Video on  Sketching Orthographic Views, http://www.cadmodelinghub.com/, https://www.
youtube.com/watch?v=VkMG9Se1AGM

5. Video on Freehand Sketching for Engineers - Video 3 - Orthographic and Circles, Marklin 
https://www.youtube.com/watch?v=nEaqezJIEMs

RefeRences & suGGesteD ReaDinGs
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Drafting Interface5

UNIT SPECIFICS
This unit presents information related to following topics:

•	 Computer Aided Drafting (CADr): Concept and benefits 
•	 Computer hardware and computer aided design and drafting software
•	 System requirements and understanding the interface for AutoCAD software
•	 AutoCAD software installation process
•	 AutoCAD software opening screen and different pallet/tool bars
•	 Invoking commands in AutoCAD software
•	 File features: Opening new and existing drawing file, saving the file, creating templates
•	 Setting up parameters for new drawing like units, limits
•	 Use of drawing aides like grid, snap, ortho, object snaps
•	 Function keys, short-cut key characters, undoing and redoing action
•	 Exiting AutoCAD software

The understanding of these topics will be developed after reading the contents, completing the solved 
problems, activities, performing exercises on AutoCAD software and viewing the ICT and web resources 
mentioned in this unit.

At the end of the unit, summary is provided to recapitulate the topics covered and applications 
are mentioned so that the learner can correlate the presented knowledge with real life and industrial 
situations. Few activities are mentioned to create inquisitiveness and curiosity in the learner. Subjective 
and objective questions are provided for the reinforcement of the knowledge and a list of references 
and suggested readings is also provided for further learning. Video resources along with QR codes 
are mentioned for getting more information on various topics of interest which can be surfed or 
scanned through mobile phone for viewing.

RaTIoNalE
From many years, drawing has been an indispensible part of engineering as it is the link between 
engineering design and manufacturing activities. Information related to dimensions, tolerances, shape,  
size and other details for the manufacturing are communicated to the manufacturing personnel in form 
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UNIT oUTComES
After reading the contents, completing the solved problems, activities, performing exercises on 
AutoCAD software and viewing the ICT and web resources mentioned in this unit the students are 
expected to: 

U5-O1: Explain Computer aided drafting (CADr), associated terminology and advantages
U5-O2: Interface computer hardware and software interface for CADr
U5-O3: Perform file related operations in AutoCAD software
U5-O4: Set up new drawing in AutoCAD software
U5-O5: Use status toolbar options for accurate drawing

Unit-5
outcome

EXPECTED maPPING WITH CoURSE oUTComES
(1- Weak Correlation; 2- Medium Correlation; 3- Strong Correlation)

Co-1 Co-2 Co-3 Co-4 Co-5 Co-6

U5-o1 - - - - - 1

U5-o2 - - - - - 2

U5-o3 - - - - - 3

U5-o4 - - - - - 3

U5-o5 - - - - - 3

of drawings made as per the prescribed drafting standards. The manufacturing personnel and designers 
can understand and interpret the drawings in the same sense based on these drafting standards. The  
engineering drawings can be made both as per the conventional methods as seen from Unit 1 to 4 of 
this book and also using computers (Unit 5 and 6 of this book). The traditional methods uses manual 
drafting instruments like drafting board, pen, pencil, ink, tracing paper, etc. The drawings made using 
computers are termed as Computer Aided Drafting, Computer Aided Design & Drafting, Computer 
Assisted Drafting, Computer Augmented Drafting, Computer Automated Drafting, etc. This Unit 
outlines the basics of Computer Aided Drafting and interface of Computer Drafting hardware with 
software.   It also describes initial steps to be followed to start any drafting software like AutoCAD, 
AutoCAD main window, setting up of new drawing and how to invoke commands.

PRE-REqUISITES
Before reading this unit the student is advised to revisit following: 

•	 Engineering Drawing Unit-1 to 2 of this book
•	 Maths: Coordinate and Plane geometry
•	 Basic Computer and MS window operations
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 Engineering Department 

Drawing Office 

Manufacturing Section 

Sales  
Department 

Service 
Department 

Fig.5.1: Typical industrial drawing office work flow

5.1 INTRoDUCTIoN
Any machine part to be produced 
is primarily designed and then 
its drawing is made. Based on 
the drawing the industry will 
manufacture it. This drawing happens 
to be the communication between the 
designers and the shop floor of the 
manufacturing. Thus, engineering 
drawing is a vital communication 
tool for engineers.
In the past these drawings were made 
manually but now computer aided drafting software are used.

Fig.5.1 provides the flow of work in a typical industrial drawing office. 
Many software are available for drawing but the most popular is AutoCAD. This book provides 

information related to AutoCAD 2020.

5.2 ComPUTER aIDED DRaFTING
CADr means Computer Aided Drafting. It is a process of preparing a drawing of an object on   
computer screen using computer drafting software.

Many types of drawings are there in different fields of engineering and sciences. In the area of 
aeronautical engineering and mechanical various drawings related to machine components and layouts 
are prepared. In the area of civil engineering various layouts and plans are prepared. In the field of 
electrical engineering, the layouts of power distribution system and circuit diagrams are prepared. 

Computers have brought drastic changes in many fields including engineering drawing. Not only 
the time involved in computer aided drawing or drafting is a fraction of that involved in manual 
drafting but also the revision can be done quickly without disturbing the entire drawing. It is very 
easy to draw different views of the object using CADr. To use CADr software effectively the user 
must learn and practice all the commands. This unit and next intend to develop the ability in the 
learner to draw, modify, edit, manage and print any simple to complex 2D entities using AutoCAD 
software. The use of CADr approach offers high graphics capabilities to support designer in

•	 Visualizing and conceptualizing his ideas
•	 Drawing, modifying, saving and printing very quickly
•	 Making and using animations
•	 Performing design calculations
•	 Applying colors, ergonomics, aesthetics and other formatting features easily

In CADr the drawing is made on the computer screen  using computer aided design and drafting 
software like AutoCAD, Creo, Catia, Unigraphics, Solidworks, etc. Modification and editing is very 
easy in these digital drawings and once complete the drawing can be saved in the external or internal 
memory like computer Hard Disk/CD/Floppy/External HD/Pen Drive. Once the drawing is complete 
then it can be printed using Printers or Plotters. Upto A3 size drawings printers can be used while 
for large and colored drawings plotters are used. The printed drawing quality is independent of skills 
of the person contrary to manual engineering drawing.
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5.3 BENEFITS oF CaDR
The implementation of the CAD system provides variety of benefits to the industries in design and 
production as given below:

1. Enhanced productivity in drafting
2. Less time for preparation of drawing
3. Less man power requirement
4. Easy alterations as per clients requirements
5. Reduced transcription errors in drawing
6. Enhanced accuracy of drawing
7. Assistance in document preparation 
8. Better evolved designs
9. Improvement in aesthetics and interpretation of drawing by using colours
10. Development of orthographic views and projections with geometric and dimensioning 

tolerances
11. Sectioned views with different patterns of  hatching
12. Usage of blocks to facilitate development of assembly and sub assembly drawings
13. Part list and bill of material preparation
14. Machining, tolerance and surface finish symbols at the desired surfaces
15. Hydraulic and pneumatic circuit diagrams with symbols
16. Ease in printing/plotting to any scale

5.4 HaRDWaRE aND VaRIoUS CaD SoFTWaRE aVaIlaBlE
The CAD system comprises of computer hardware system and software. 

5.4.1 CaD Hardware
The CAD hardware is the computer system and it may be 

1. a Workstation computer or
2. a Personal computer (PC) or 
3. a Laptop computer

The workstation consists of a high resolution 19/24 inches monitor and graphics accelerator card for 
quick display, facility to work with multiple windows, higher Random Access Memory (RAM) and 
higher Hard Disk storage. The workstation looks similar to a personal computer but has a higher 
performance and is almost five times more expensive. It has high speed and better memory and 
display capabilities.

Laptop computers are portable computers that can be taken in a bag to any place. A typical 
Laptop computer includes motherboard with processor, sound cards, graphics card, network card, 
internal hard disk, different ports to connect external devices, screen, keyboard, speakers, camera and 
mouse pad. They come along with a battery to provide power to the system and the battery can be 
charged using a power adapter. 
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A Personal Computer/Workstation (CAD Hardware)(Fig.5.2) typically consists of 
1. High-resolution Monitor (21/19/14 ")
2. Central Processing Unit with numeric 
 co-processor, 8 to 32 MB RAM, a  
 hard disk drive, a cache memory, a  
 colour graphics card.
3. Speakers 
4. Printer/Plotter
5. Keyboard
6. Three-button scroll Mouse/Digitiser 

Central Processing Unit (CPU)
A central processing unit (CPU), also called as 
central processor, main processor or just processor is the brain of a computer, containing all the 
circuitry needed to process input, store data, and output results. The CPU performs basic arithmetic, 
logic, controlling, and input/output (I/O) operations specified by the instructions in the program. 
The internal components in a typical CPU are:

1. Motherboard
2. Networking cards
3. Graphics card
4. Processor
5. Hard drive
6. USB ports
7. Monitor ports
8. Power supply

Input devices
The input devices are used for making selections from a menu, typing information/commands, placing 
cursor at appropriate position and selecting entities from the screen etc. Sending the commands/
information into the computer produces the digital drawing on the computer screen. Following devices 
(Fig.5.3) are used as input devices but Keyboard and Mouse are most commonly used input devices.

a. a keyboard, for giving inputs through alphabet, number and arrow keys;
b. a mouse is a small box type device that can control movements in the same direction 

when pushed across a surface; 
c. thumb wheels, horizontal movement is controlled by one wheel and vertical movement 

regulated by second wheel; 
d. a light pen, for pointing the pen to directly select the position on screen;
e. a joystick, being a vertical lever mounted in a box controls movements in all directions;
f. a tracker ball, the rolling of the ball controls movements in all directions;
g. a puck or (h) stylus in conjunction with the digitising tablet, can enter the complete 

Fig.5.2: Typical computer system
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drawing from a sketch or half-completed drawing by attaching it to the digitiser and 
used  to indicate the important points on lines, curves, etc., and entering into the relevant 
commands.

Output devices
The output devices receive data from the computer processor and give a digital output on the screen  
or a hard copy through a printer. The main output devices are computer monitors and printers/
plotters. The printers are of two types being impact type or non-impact type.

1. impact printers. These are now less popular. They are dot matrix type and form shapes by 
selecting relevant small dots from print heads.

2. non-impact printers. These include electrostatic, ink-jet and laser printers, viz.:
a. electrostatic printers. These create shapes by burning away a thin metallic coating on 

the special printing paper;
b. ink-jet printers. These use a print head  that directs a jet of ink at the paper to create 

the required shapes;
c. the laser printers use a fine beam of laser light to create the required shapes. 

The two basic types of plotter are flatbed and drum type:
a. flatbed plotters. These have a flat area to place the paper of any type and thickness and 

the pens of different thickness and different colours of ink can be used in any direction 
with plot head.;

b. drum plotters. They have a rotating drum that can move paper in two directions. The 
pens have a limitation being movement only across the drum. The drawings are created 
by the combination of pen movement and drum rotation. In comparison to flatbed 
plotters the drawings are of lower precision and longer length.

5.4.2 CaD Software
The CAD software is an interpreter or translator which allows the user to perform specific type of 
application or job related to CAD. The following software are available for drafting:

1. AutoCAD
2. Solid Works
3. CATIA

Fig.5.3: Input devices
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4. NX Unigraphics
5. Creo
6. HYPERMESH
7. ANSYS
8. MSc. NASTRAN
9. FLUENT – GAMBIT

The above software have their own graphic user interface and areas of applications.

AutoCAD software (student version)
AutoCAD package is best suited for accurate and perfect drawings of engineering designs. The drawing 
of machine parts, isometric views and assembly drawings are possible in AutoCAD. It is quite exhaustive 
and is internationally known for drafting purposes. It is developed and marketed by Autodesk, Inc. 
AutoCAD was first released in December 1982. AutoCAD is a software application for 2D and 3D 
computer-aided drafting as a desktop application and since 2010 as a mobile-web and cloud-based 
app, currently marketed as AutoCAD 360. The version AutoCAD 2020 is being described in this book.

Autodesk Inc. provides licensed education and commercial versions of AutoCAD, discounted 
version for education purpose, one and three year education versions for students of AICTE approved 
technical institutions and one month free trial version for any user. All educational versions are 
same except the DWG files created or modified using student version have an internal bit-flag set 
(the "educational flag") and if such files are printed using any version of AutoCAD the printout 
has ‘education version’ written on all four sides of the printed drawing.. The Autodesk Education 
community provides registered students and faculty with free access to different Autodesk applications.

5.5 SYSTEm REqUIREmENTS aND UNDERSTaNDING THE INTERFaCE
The minimum computer hardware requirement for installing AutoCAD is 

•	 Operating	System:	Microsoft	Windows	10	 (64-bit	only),	 8.1	 (64-bit	only),	or	7	SP1	 (64-bit	
only)

•	 Processor:	 2.5	GHz	 (3+	GHz	 recommended)
•	 Memory:	8	GB	 (16GB	recommended)
•	 Disk	 space:	6.0	GB
•	 Display:	1920	x	1080	 resolution	with	 true	 color	 (high	 resolution	&	4K	displays:

resolutions up to 3840 x 2160 supported on Windows 10, 64-bit systems (with capable display 
card)

•	 Display	Card	Basic:	 1	GB	GPU	with	29	GB/s	Bandwidth	and	DirectX	11	compliant	
(Recommended: 4 GB GPU with 106 GB/s Bandwidth and DirectX 11 compliant)

•	 Keyboard
•	 Three	button	mouse	
•	 Printer	or	 a	Plotter
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5.6 aUToCaD INSTallaTIoN PRoCESS
Refer website: https://www.autodesk.com/education/free-software/all 

1. Click AutoCAD 
2. Create your login account using the MRCET mail id. xyz@mrcet.ac.in (you can access the 

software for 3 years) 
3. After you create your account, sign in and choose 

a. Version: AutoCAD 2020 
b. Operating System: 32 or 64 bit (To find the information, Right click on My Computer or 

My PC and select properties.) 
c. Language: English (so you can have more effective technical support) 

4. Serial number and Product key will be displayed. This information is required at the time of 
activation after installing the software 

5. Download can be carried in two ways: 
a. Download Now (Recommended) 
b. Browser Download 

6. After downloading the file, double click on the installation file and then click Yes to complete 
the installation 

7. Now click on Install 
8. Check the box I accept the click next 
9. For the standalone License type default option, enter the serial key & product key details 

found on the software database for this software version 
10. Click Install and Click Finish to complete the installation 

5.7 STaRTING THE aUToCaD PRoGRam
Presumption: The authors presume in the book that AutoCAD software is installed on the computer 
system and the user has the basic knowledge of computers. To start, click the AutoCAD icon on 
the desktop or click the start button at the left corner of the screen. The sequence of selections is 
provided below; please follow it to launch the software.

Launching 
AutoCAD 

and Opening 
drawing

AutoCAD 
Main Screen
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Fig.5.4: AutoCAD 2020 opening screen

5.8.1 application menu 
Menus are available through the application button in the 
upper left corner of the drawing window. This menu contains 
the commands used to create, save, print and manage your 
drawing.

5.8.2 Command Prompt
The rectangular horizontal window at lower side of the 
screen is called the command area. The instructions given 
to the computer through keyboard is shown in this area. It 
is important to read the command prompt when working 
with an unfamiliar command. To enter a command using 
the keyboard, type the command name on the command 
line and press ENTER or the Spacebar. 

5.8.3 Navigation Bar
The navigation bar is a user interface element where you can access both unified and product-specific 
navigation tools. Unified navigation tools are those that can be found across many Autodesk products. 

5.8 aUToCaD oPENING SCREEN (THE USER INTERFaCE)
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5.8.4 quick access Toolbar
The Quick Access toolbar, displayed in the Drafting & Annotation workspace is located at the very top 
of the drawing window next to the Application button. The Quick Access toolbar may be customized by 
adding or removing commands. This is done by right clicking on the toolbar and selecting Customize 
Quick Access toolbar or selecting the arrow at the end of the toolbar.
Icons to open a new file, open an existing file, 
save a file, undo, redo and plot followed by a 
file name are present at the top. A default File 
name [Drawing1.dwg] in this sequence is also 
present as shown below. The details related to 
these actions are provided in sections 5.10 to 
5.14.

5.8.5 Drawing area & Cross Hair 
The drawing area happens to be the major area in the centre of the screen. The drawing has to be 
created in this area. A cross hair is displayed here that can be moved using a mouse. It identifies 
pick and drawing points within the drawing area. Use the crosshairs, which are controlled  by your 
pointing device, to locate points and to select-draw-modify objects. The cross hair position is indicated 
by coordinate values shown at the left end of the status bar.

5.8.6 Status Bar 
The status bar (Fig.5.5) displays the cursor location, drawing tools and the tools that affect the 
drawing environment. It also provides quick access to some of the most commonly used drawing 
tools, coordinates of the cross hair (Cursor) and buttons for Grid, Snap, Object snap, Object snap 
tracking, Polar tracking, Ortho and Scale etc.

 

Print File 
(F7) 

Snap 
(F9) 

Ortho 
(F8) 

ISO 
Draft 

Object Snap 
Tracking (F11) 

Object Snap 
(F3) Dynamic UCS 

Scale Graphics Config 

Fig.5.5: AutoCAD 2020 status bar
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5.8.7 menu Bar
The Menu bar displays options like Home, Insert Annotate etc., as shown below. If this is not visible, 
you can type the system variable Menubar at the command line and set its value as 1 to display. 
A zero value hides this bar. Ribbon related to each tab/option can be activated by clicking it. For 
example Home tab has toolbars like Draw, Modify, Annotation, Layers, Block, and Properties etc. 
Any toolbar can be dragged and placed at any convenient place on the screen using mouse.

It is mandatory to remember the shape of each icon. In case you cannot remember then if the 
mouse is brought over the icon for a while then a tool tip display shows the job assigned to the icons.

5.8.8 ViewCube
The ViewCube is a navigation tool that allows you to switch between viewing directions. This is very 
useful in 3D space. It is located in the upper right corner of the drawing area.

5.8.9 UCS and WCS
The UCS icon by default is located at the lower left corner of the drawing area coinciding with WCS. 
AutoCAD uses the 3-dimensional coordinate system. This coordinate system is termed as the World 
Coordinate System (WCS). In the drawing area its icon is shown at the lower left corner, using arrows 
to show the X and Y axis and a square is shown at the intersection (Fig. 5.1). The Z direction is taken  
at right angles to the screen and outwards.

There is another movable user defined coordinate system called 
the User Coordinate System (UCS). Its origin can be set anywhere in 
the WCS or coincide with the WCS (in the Fig.5.1 it coincides with 
the WCS). To differentiate, when working with UCS the square at 
the center of the icon is not displayed. Its display can be put On or 
Off using UCSICON command. Its position and orientation can be 
changed using UCS command.

The current UCS model name is displayed in the UCS menu 
located below the view cube. The menu helps in the following manner, 
restoration of named UCS’s saved with the model, switch to the WCS, 
or define a new UCS. The WCS item on the menu is used to switch 
the coordinate from UCS to WCS. In the new UCS, the current 
UCS can be rotated based on 1, 2 or 3 points to define a new UCS. 
If the new UCS is clicked a new UCS appears with a default name 
or unnamed. The name option can be used to save the new defined 
UCS. The view cube can orient the new UCS or WCS providing 
direction of modeling. Orientation of view cube with WCS helps navigate the model in the north 
and up directions. The setting for controlling are called as ViewCube settings.
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5.8.10 Draw Tool Bar
The Draw tool bar or pallet is a user interface element which contains following commands which 
are used to draw any 2D and 3D entities. Detail treatment of this tool bar is given in next chapter.

•	 LINE, XLINE, MLINE, PLINE
•	 POLYGON
•	 RECTANG
•	 ARC
•	 CIRCLE
•	 DONUT
•	 SPLINE
•	 ELLIPSE
•	 BLOCK
•	 POINT
•	 HATCH
•	 BHATCH
•	 REGION

5.8.11 modify Tool Bar
The Modify tool bar or pallet is a user interface element which contains following commands which 
are used to modify/edit already drawn 2D and 3D entities. Detail treatment of this tool bar is given 
in next chapter.

•	 ERASE
•	 COPY
•	 MIRROR
•	 OFFSET
•	 ARRAY
•	 MOVE
•	 ROTATE
•	 SCALE
•	 TRIM
•	 EXTEND
•	 CHAMFER
•	 FILLET
•	 BREAK
•	 EXPLODE

5.8.12 layout line
The layout line on the screen is at the bottom. This helps to select the layout. The default is Model 
Layout. Switch your drawing between model (drawing) space and paper (layout) space. You generally 

Draw and 
Modify 

Toolbars
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create your designs in model space and then create layouts to plot and print your drawing in paper 
space.

5.8.13 Command line
The Command line is just above the Layout line in the middle of the screen. See Fig. 5.4 where “Type 
a Command” is written. The area is used to type commands. The prompts for data (    ).

5.9 INVoKING CommaNDS IN aUToCaD
You can use any of the following methods to start commands. 

1. Menu bar: Click an option on Menu bar. From the popup menu, select a choice by clicking 
the mouse on it.

2. Toolbars/Ribbon: Click on an icon of the ribbon with the left mouse button. 
3. Command line: At the Command line type a command using the keyboard and then press 

ENTER key (    ).
a. To repeat the last command : press ENTER or SPACEBAR or right click in the drawing area 

and choose repeat. 
b. To repeat one of the last six commands: right click in the command window or text window 

and from the shortcut menu choose recent commands.
c. To repeat the same command multiple times: at the command prompt enter multiple and 

at the next prompt enter the command you want to repeat.
d. To cancel a command: press ESC.

5.10 oPENING a DRaWING

5.10.1 open an Existing Drawing
Click on the red letter A on the top left of your screen or press second icon on the quick access bar. 
This opens options like Drawing, Drawing from AutoCAD Web, Sheet Set, DGN, Sample files as 
shown in Fig. 5.6. Click the first option- Drawing which displays the browser from where you can 
‘Look in’ and choose any existing file from the list. As soon as the desired file is selected the software 
opens it on the screen.

5.10.2 open a New Drawing
Opens a new drawing based on the measurement system you choose- English (inches) or metric(mm). 
Click on the red letter A on the top left of your screen or press first icon on the quick access bar. 
Click on the ‘New’ button and your screen should then look like Fig.5.7. Select Drawing option and 
the software opens another form which contains default AutoCAD templates. If you want to use any 
readymade template then choose any one from the list, otherwise if you want to open new drawing 
without template then press a small down arrow button adjacent to Open  and select ‘open with no 
template’ Imperial for units in inches and Metric for units in mm as depicted in Fig.5.7.
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Fig.5.6: Opening an existing file

5.10.3 Use a Template
If in above case you choose option 'Opens' then a new drawing will be opened based on a readymade 
template you select from the list. The list displays template files (.dwt extension) that exist in the 
drawing template file location as specified in the Options dialog box. Template file store all the settings 
for a drawing and can also include predefined layers, dimension styles and views.

5.11 SaVING DRaWING FIlES
All the three commands SAVE, SAVE AS and QSAVE allow you to save your drawing by writing it to 
a permanent storage device such as Hard Drive/Pendrive/External Hard Disc Drive. SAVE command 
saves the current named drawing. The SAVE AS command sets the name of the current drawing to 
the new file name you specify. QSAVE command saves the current named drawing without asking 
you to enter a filename, thus allowing you to do a quick save. You can invoke save command: 

•	 By	 selecting	 it	 from	Application	 icon	 	 	 	 list.
•	 From	 the	Quick	Access	 toolbar	and	 	
•	 By	 typing	 in	Command	 line	 :	 SAVE,	SAVE	AS	 ,	QSAVE	and	press	Enter	key.

Fig.5.7: Opening a new file with or without template
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5.12 CREaTING USER DEFINED TEmPlaTES
A drawing template file is a drawing file that has been saved with a .dwt file extension and it specifies 
the styles, settings and layouts in a drawing, including title blocks. You can specify a different template 
file from the templates' list to start a new drawing as per your requirement.

To create a custom (user defined) template:
•	 Click	New	Drawing.
•	 In	the	Select	template	dialog	box,	select	acad.dwt	from	the	list	of	templates	and	then	modify	

the template.
•	 You	can	change	preferences	or	 controls	 in	 the	drawing,	 add	or	 replace	 the	border	or	 title	

block, import or configure standards and erase or add drawing elements.
•	 Click	 'Save	As'	AutoCAD	Drawing	Template.
•	 By	default,	 the	 software	 saves	 the	new	 template	 in	 the	 folder	ProgramData\Autodesk\........\

Template.
•	 For	File	name,	 enter	 a	name	 for	 the	new	 template	 and	click	Save.
•	 In	 the	Template	Options	dialog	box,	 enter	 a	brief	description	of	 the	 template	 and	 specify	

the measurements. 

5.13 DRaWING aIDS

5.13.1 Setting Units 
The type of units can be set for the drawing using 
UNIT command.

•	 Typing	 in	Command	 line	 :	UN
•	 By	clicking	application	button	and	choosing	

Click Units under Drawing utilities. 
In both the cases the Drawing Units dialog box is 
displayed. 

•	 Length tile is displayed in the upper left corner. 
In this tile, click the arrow in the combo box 
and select a Type and Fractions (Fig.5.8). 

•	 For Length, Decimal is most common and 
for Angle, Decimal Degree is most common.

•	 Precision is the number of digits after decimal 
point to appear with the dimension, e.g., 12.1 
or 12.67.

•	 Select appropriate units in combo box. The 
effect of this setting is displayed in the Sample 
Output tile at the bottom of the dialog box. 
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•	 By clicking the Direction button at the bottom of the dialogue box the direction to measure 
angles is set. The Direction control dialog box is displayed. East direction is taken as horizontal 
direction. Click on any one of the radio buttons as desired and then click the OK.

•	 Click the OK button to save and exit.

5.13.2 Drawing limits
The Limits command in AutoCAD is used to set an invisible rectangular boundary in the drawing 
area or viewport. You can set the limits of the drawing area in Metric or English before you start a 
drawing. Setting the limits serves as a reference tool that marks the area in your drawing in which 
you are currently working. This is the area which will be displayed when you ‘Zoom’ ‘All’(Z   
A     ). It is also the area in which the visible grid and snap grid are extended to. If limits are on, 
you cannot draw any entity outside the limits. You can see the drawing area by making the Grid on. 
The drawing boundaries are usually set to match the size of a sheet of drawing paper. This means that 
when the drawing is plotted and a hard copy is made, it will fit on the drawing paper. To set limits:

•	 Click	Format	menu	Drawing	Limits.	
•	 Enter	 the	 coordinates	 for	 a	point	 at	 the	 lower-left	corner	of	 the	grid	 limits.	
•	 Enter	the	coordinates	for	a	point	at	the	upper-right	corner	of	the	grid	limits	and	press	ENTER.

5.13.3 Snap, Grid and ortho
Grid is a display of small dots on the screen at equally specified distances in the horizontal and vertical 
directions. This grid can also be rotated. While plotting the drawing the grid points do not appear. For 
activation of GRID, the grid button on the status bar can be clicked. The status bar is at the bottom 
of the screen (Fig.5.5)  or by pressing Function key F7 or by typing the command as mentioned:
Command: GRID
Specify grid spacing (X) or [ON/OFF/Snap/Aspect] <10.0000>:
Specify a value of grid spacing

Fig.5.8: Setting drawing units
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Snap is the smallest invisible distance of increment that can be set for the mouse. If Snap is set on, 
the mouse moves in steps of the set increment. To select any intermediate point between the dots 
of the grid, put Snap off by pressing F9 or on Status bar (Fig. 5.5) click the Snap button or type the 
command as under:
Command: SNAP
Specify snap spacing or [ON/OFF/Aspect/Rotate/Style/Type] <10.00000>:
Specify snap increment or put it off
Ortho, Orthogonal can be written as Ortho in short. It means 90° to each other. On setting the mode 
ON the lines are drawn along the X and Y direction. The Ortho is set as on either by clicking on 
ORTHO button on the status bar (Fig.5.5) or by pressing F8 Function Key or by typing the command 
at command line as mentioned below:

•	 Command: ORTHO
•	 Enter mode [ON/OFF] <ON>: Type an option: On or Off as desired.
•	 On the Status Bar, right-click on snap mode, find and select Snap Settings.
•	 In the Drafting Settings dialog box, Snap and Grid tab, click Snap on.
•	 Under Snap Type, make sure Grid Snap and Rectangular Snap are selected.
•	 In the Snap X Spacing box, enter the horizontal snap spacing value in units.
•	 The check box, Equal X and Y Spacing, applies to both snap and grid spacing.
•	 Modify other settings as needed.
•	 Snap mode can be turned on and off with the F9 key. You can suppress snap temporarily 

by holding down F9 while you create or modify an object.

5.13.4 object Snaps  
To make drawings quickly and accurately AutoCAD 
provides tracking and Object snap tools. The Object 
snap features select locations accurately based on 
existing objects in your drawings. Without object snaps 
the resolution of your screen makes it impossible to 
select points with the accuracy. 

For making accurate selection the object snap is 
used like the objects center, endpoint, midpoint and 
so on.  

You can select this command 
•	 From the status toolbar: clicking the down 

arrow adjacent to Object Snap button on the 
Status bar or Right-click it (Fig.5.9).

•	 Typing in Command line: DSETTINGS,
•	 OSNAP

Fig. 5.9: Using object snap facility
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5.14 FUNCTIoN KEY aSSIGNmENTS
To change the status of coordinate display, ortho etc. you can use Function and Control keys. The 
following is the list of function and control keys.

F1  Displays Help
F2  Toggles between the text and graphics screen
F3  Running Object Snap on/off
F4  Tablet (an input device) on/off
F5  Switches between the top, front and side views for isometric drawings
F6  Switches dynamic UCS to on or off
F7  Grid on/off
F8  Ortho on/off; if on, lines are either horizontal or vertical
F9  Snap mode on/off
F10  Polar option on/off
F11  Object Snap Tracking on/off

5.15 SHoRT-CUT KEY CHaRaCTERS
Short-cut characters are given in table 5.1

A ARC Draws an arc

C CIRCLE Draws a circle

E ERASE Deletes the selected object(s)

F FILLET Creates a radius at the intersecting lines

G HATCH Displays Boundary Hatch and Fill dialog box

L LINE Draws a line

M MOVE
Moves a drawing from one place to another but drawing coordinates 
change

O OFFSET Draw a parallel line or arc at specified distance

P PAN Moves drawing on screen without changing its coordinates

R REDRAW Redraws the whole drawing

S STRETCH Stretches an entity by specified distance

T TEXT Writes text

Table 5.1 Short-cut key command name function
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V VIEW Displays View dialog box

W WBLOCK Displays Write Block dialog box

X EXPLODE Breaks a group of entities into separate entities

Z ZOOM Enlarges or reduces the view

In this unit you have learned:
1. The meaning of Computer Aided Drafting and related terminology.
2. About computer aided hardware and software required for CADr.
3. How to install AutoCAD Student version.
4. About AutoCAD main window user interface.
5. Opening a new/exiting, closing and saving a drawing.
6. How to create a user defined template.
7. Setting of units and limits.
8. Various Drawing aids like Snap, Grid, Object Snap to draw accurate drawing.
9. About Short Cut keys and Function keys.

a. multiple Choice questions
5.1 RAM for a computer means

(a) Regular and Accurate Memory (b) Random Access Memory
(c) Rapid Access Management   (d) Right Actual Mode

5.2 Size of a display unit is measured as
(a) Width of screen     (b) Height of screen
(c) Distance across diagonal corners of screen   (d) Average of width & height of screen

5.3 A Mouse is a
(a) pointing device on screen  (b) disturbance in a computer
(c) device to locate fault   (d) device to draw complex drawings

5.4 Files can be accessed over internet if a computer has a
(a) VGA card    (b) Network card
(c) Modem card    (d) Sound card

UNIT SUmmaRY

EXERCISES
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5.5 The device to make a hard copy of A0 size of drawing from the computer is
(a) Digitizer  (b) Printer
(c) Scanner   (d) Plotter

5.6 AutoCAD is a software for
(a) drafting    (b) designing
(c) designing and drafting   (d) drafting and manufacturing

5.7 Menu bar on the AutoCAD screen contains
(a) File, Edit, View, etc.   (b) Draw, Modify, etc.
(c) Cut, Copy, Paste, etc.   (d) None of the above

5.8 Commands given in AutoCAD appear
(a) in the drawing area   (b) on the toolbar of commands
(c) at the command line   (d) at the status line

5.9 Snap is turned on or off using function key
(a) F4   (b) F6
(c) F7   (d) F9

5.10  Function key F8 is used to toggle
(a) Coordinate display  (b) Grid display

(c) Status bar   (d) Ortho

B. Subjective questions
5.1 List the advantages of Computer Aided Drafting.
5.2 Describe the various displays on an AutoCAD screen.
5.3 Explain the method to open a new file in AutoCAD
5.4 Describe the functions assigned to Function keys (F1 to F11) in AutoCAD.
5.5 Discuss the importance of UCS icon. How can you put UCS icon on and off?

1. As per curriculum the practical related to Unit-5 are: Nil

answers of multiple Choice questions

5.1 (b); 5.2 (c); 5.3 (a); 5.4 (c); 5.5 (d); 5.6 (a); 5.7 (a); 5.8 (c); 5.9 (d); 5.10 (d)

PRaCTICalS
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•	 Teacher should download the command reference guide of AutoCAD 2020.
•	 During the input sessions the teacher must give examples related to the relevant branch viz.

Mechanical and allied disciplines/ Electrical and allied disciplines/Electronics etc.
•	 Teacher should demonstrate all above commands through AutoCAD software and guide 

students in Hands-on sessions.
•	 Show video/animation films to explain mentioned concepts.
•	 Use videos/spoken tutorials to teach AutoCAD software.
•	 Teacher must know 3D modeling also using AutoCAD 2020.

applications (Real life / Industrial)
Computers have brought drastic changes in many fields including engineering drawing. Not only the 
time involved in computer aided drawing or drafting is a fraction of that involved in manual drafting 
but also the revision can be done quickly without disturbing the entire drawing. It is very easy to draw 
different views of the object using CADr. Currently, industries, professionals and practicing engineers 
are using computer aided drafting software for creating digital production drawings in mechanical 
and allied engineering domains, digital building and construction drawings in civil engineering and 
architecture domain, digital pipe lines and layouts in chemical and food processing fields, digital layouts 
of power distribution system and electric circuits in electrical engineering domain. To use CADr 
software effectively the user must learn and practice all the commands, shortcut and functional keys.

Inquisitiveness and Curiosity
1. Download student version of AutoCAD and tryout above commands.
2. Open a new drawing with and without template and observe the difference.
3. Open an existing drawing file and save it with other name.
4. Open an existing file and check its Units and Limits.
5. Open a new file and set Units to mm. Make the grid ON/OFF and Snap ON/OFF. Change 

the setting of Snap and observe the movement of cursor.

1. Machine Design Includes AutoCAD Second Edition, Ajeet Singh, Tata McGraw Hill Education 
Private Limited, New Delhi, 2018.

2. AutoCAD 2020: A Problem-Solving Approach, Basic and Intermediate, 26th Edition, Sham 
Tickoo, CADCIM Technologies, 2019.

3. AutoCAD 2013, Command Reference Guide, Autodesk Inc.
4. AutoCAD Shortcuts Guide, Autodesk Inc.
5. Autodesk knowledge network, tutorials, documentation, downloads, troubleshooting articles, 

https://knowledge.autodesk.com/support

KNoW moRE

REFERENCES & SUGGESTED REaDINGS
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UNIT SPECIFICS
This unit presents information related to following topics:

•	 Draw basic entities like line, circle, arc, polygon, ellipse, rectangle, multiline, polyline.
•	 Method of Specifying points: Absolute and relative cartesian and polar coordinates.
•	 Modify and edit commands like trim, extend, delete, copy, offset, array, block, layers.
•	 Dimensioning the digital drawing: linear, horizontal, vertical, aligned, rotated, baseline, 

continuous, diameter, radius, angular. Dim scale variable. Editing dimensions.
•	 Writing text on the digital drawing: Single and multiline line text.
•	 Selecting various plotting parameters such as paper size, drawing orientation, plot scale, plot 

offset, plot area, print preview
The understanding of these topics will be developed after reading the contents, completing the solved 
problems, activities, performing exercises on AutoCAD software and viewing the ICT & web resources 
mentioned in this unit.

At the end of the unit, summary is provided to recapitulate the topics covered and applications   
are mentioned so that the learner can correlate the presented knowledge with real life and industrial 
situations. Few activities are mentioned to create inquisitiveness and curiosity in the learner. Subjective 
and objective questions are provided for the reinforcement of the knowledge and a list of references 
and suggested readings is also provided for further learning. Video resources along with QR codes   
are mentioned for getting more information on various topics of interest which can be surfed or 
scanned through mobile phone for viewing. Practical with details are provided to horn the drawing  
and drafting skills.

RaTIoNalE
Today every industry by default needs computerized drawings. The computerized drawings have their 
advantages of storage, retrieval, ease of modification, transmission etc. Further, the most critical factor 
is the accuracy of creation of overall design and specially curves which no hand drawing can match. 
To improve the employability quotient of the students many engineering institutions worldwide have 
adopted this approach. Usually digital drawings are created by combining and modifying several 
different basic primitive shapes, such as lines, circles, and arcs to create more complex shapes. AutoCAD 
is widely used design and drafting software to create these digital drawings. The version AutoCAD 
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UNIT oUTComES
After reading the contents, completing the solved problems, activities, performing exercises on 
AutoCAD software and viewing the ICT & web resources mentioned in this unit the students are 
expected to:

U6-O1: Use Draw tool bar of AutoCAD software to draw simple 2D entities
U6-O2: Use Modify tool bar of AutoCAD software to modify and edit 2D entities
U6-O3: Create drawings using Blocks, Array and Layer commands in AutoCAD
U6-O4: Apply dimensions to simple 2D entities using AutoCAD software
U6-O5: Write text in drawings using AutoCAD software
U6-O6: Plot drawing in AutoCAD software

Unit-6
outcome

EXPECTED maPPING WITH CoURSE oUTComES
(1- Weak Correlation; 2- Medium Correlation; 3- Strong Correlation)

Co-1 Co-2 Co-3 Co-4 Co-5 Co-6

U6-o1 3 - 2 - - 3

U6-o2 3 - 2 - - 3

U6-o3 3 - 2 - - 3

U6-o4 - 3 - - - 2

U6-o5 - 3 - - - 2

U6-o6 - - - - - 2

6.1 INTRoDUCTIoN
In this unit the student will learn concepts of creating and modifying drawing objects, including lines, 
arcs and circles etc. and also use Object Snaps, Object Snap Tracking, Polar Tracking, Coordinate 
methods and Dimensioning to create accurate drawings. Unit also covers knowledge elements related 

2020 is being described in this book. The outcomes of this unit are performance based, hence, once 
you complete the unit, you will be able to perform the outcomes listed in the unit. In this unit the 
student will learn concepts of creating and modifying drawing objects, including lines, arcs and circles 
etc. This unit provides step-by-step instructions to use each command along with practice exercise 
for the command usage.

PRE-REqUISITES
Before reading this unit the student is advised to revisit following: 

•	 Basic AutoCAD commands mentioned in Unit-5
•	 Maths: Coordinate and Plane geometry
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to creation and modification of Layers, Blocks, 
Text writing and Hatching. The students will 
also learn how to navigate through drawings 
with Pan and Zoom commands, Do and 
Undo and finally Exiting from AutoCAD after 
saving the drawing. The section ahead provides 
instructions to use each command and also 
supplements with practice exercises to use the 
commands.

6.2 USE oF moUSE
It is assumed that you are using a mouse with a middle roller-button as depicted in Fig. 6.1.

Fig.6.1: Typical Mouse: left and right clicks

 

Right Mouse Button Left Mouse Button 

Pick or Click Quickly press and then release the left mouse button 

Right-click Quickly press and release the right mouse button 

Double-click Rapidly click the left mouse button twice

Drag Press and hold down the left mouse button while you move the mouse

Point
Move the mouse until the mouse pointer (cursor) on the screen is positioned 
over the item you want

Select
Position the mouse pointer/drawing cursor over an item and click the left 
mouse button

6.3 HoW To SElECT a CommaND
AutoCAD provides you with two different methods of selecting commands:

1. One is selecting a tool from the Ribbon/Pallet, 
2. The alternative is to type the command in the command line.

Both methods give the same output. Choose the method as per your preference. For example: 
Method 1: Selecting the tool from the Ribbon (Fig. 6.2)

1. First select a Tab such as Home.
2. Locate the correct Panel/Tool Bar/Pallet such as Draw (Fig. 6.3).
3. Select a tool such as Circle. 

a. If the tool includes multiple types, it will show a down-arrow. On selecting the down   
   menu arrow a submenu appears. Select the desired type such as 2-Point.
b. The latest selection will then become the current displayed tool because AutoCAD assumes 

that you may need that tool again.
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Method 2: Keyboard entry
The command may be input by typing the command on the command line or in the dynamic input 
tool tip (if dynamic input is on).

6.4 CommaND lINE
Used to enter a command in the Command Line.

•	 Type the first letter of a command, such as 'c' for circle.
•	 A list of commands that begin with the letter 'c' will appear. Select the desired command 

from the list because 'c' is also related to Close, Change properties, Combine etc.
•	 On entering the command like circle the prompt and option gets displayed on the command 

line. The prompt for Circle command asks you to: 'Specify center point for circle' or [3P/2P/
Ttr/(tan tan radius)]

•	 The information within [ ] brackets are options that you may select. Clickable options are 
displayed in blue while options displayed in black must be typed in the command line OR 
selected from the option menu.

•	 History gets recorded of the used commands. The history can be displayed using F2 or 

 

Menu Bar/Ribbon Application Menu 
Fig. 6.2: Ribbon in AutoCAD 2020 main screen (user interface)

 3. Tab 

1. Panel 

2. Tool 

Fig. 6.3: Selecting a tool from the Ribbon
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the up arrow on the command line at the right hand end. Recent Commands tool displays 
recently selected commands.

•	 Press <Ctrl+9 > to toggle the command line on and off.
•	 By pressing space bar on keyboard you can activate the previous command used.

6.5 DYNamIC INPUT ToolTIP
This is another method of inputting commands, values and select options. Turn on the dynamic input 
button in the Status Bar to activate it. In case of Dynamic Input, the command will be entered in 
the tooltip box after the cursor.

•	 Place the cursor in the Drawing Area (important).
•	 Type the first letter of a command, such as ‘c’ for circle.
•	 A list of commands that begin with the letter ‘c’ will appear.
•	 Select the command from the list.
•	 If you press the ↓ down arrow, the options will appear below the prompt (Fig. 6.4).

6.6 Tool/ICoN TIP HElP
•	 When you hover your cursor over a tool/icon an initial ToolTip will appear telling you the 

name of the tool with a brief description (Fig 6.5 a).
•	 If the cursor is placed little longer on the icon, a graphic display directly from the help 

system will appear (Fig 6.5b).

Fig. 6.4: Dynamic input method to enter a command

Fig. 6.5: Tool tips in AutoCAD 2020
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6.7 CooRDINaTE SYSTEm
Absolute coordinate system. In absolute coordinate system the points are located in respect to the 
origin (0,0). The absolute coordinates are specified by entering X and Y coordinates. For example 
point 2,3 represents point with X=2 (i.e horizontal) and Y=3 (i.e vertical) from origin.
Relative Cartesian coordinates. Relative coordinates specify the X and Y distance from a previous 
point. They are called relative coordinates because they only have meaning relative to a point previously 
specified. You tell AutoCAD that the coordinates are relative by using the @ symbol. For example a 
Relative coordinate of @5,2 will go to the right 5 units and up 2 units from the last point entered.
Polar coordinates. Another common situation is to know the distance and angle of a point from 
either 0,0 or a previous point. In this case, you can use polar coordinates, which can be either 
absolute or relative. Most commonly, you use relative polar coordinates. Polar coordinates take the 
form distance<angle. (To type the angle symbol, use the less than symbol on your keyboard.) Relative 
polar coordinates must have the @ sign before the coordinate.
Direct distance entry. One shortcut for entering coordinates is direct distance entry. After you specify 
the start point of a line, at the Specify next point or [Undo]: prompt, simply move the mouse cursor 
in the direction you want the line to go and type in the line’s length. It works best in orthogonal 
mode or with polar tracking, discussed next, which makes it easy to specify exact angles. You can 
use direct distance entry for any command that requires you to specify a distance and a direction, 
including both drawing and editing commands.

6.8 CREaTING ElEmENTaRY oBJECTS (DRaW Tool BaR)
In AutoCAD, the screen acts as a drawing sheet and the drawing is not created by drawing instruments 
rather pressing buttons OR typing command related to basic 2D entities like Line, Circle, Arc, Rectangle, 
Polygon etc. To create a drawing in AutoCAD, Draw tool bar is used (Fig. 6.6 and 6.7). To create 
any entity (Point, Line, Arc, Circle etc.) either click the related icon available in the Draw Tool Bar 
OR type the respective command at Command line and then specify/supply the values as prompted. 
Just keep an eye on the messages prompted by the software and supply the required data. If you feel 
that something went wrong then press Esc key and the command will get terminated. If you prefer 
to separate the Draw Panel/Tool bar/Pallet from the Ribbon, you may drag the Panel off the Ribbon 
to a new convenient location on the screen.

 

Spline with fit points 

Spline with control vertices 

Construction Line 

3D Polyline 
Helix 

Region 
Wipeout 

Point 

Rectangle 

Break 

Ray 
Hatch 

Ellipse 

Donut 
Revcloud 

Measure 

Fig. 6.6: Draw Panel/Toolbar/Pallet in AutoCAD 2020 main screen ribbon
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6.8.1 Point
•	 The Point command will insert a point marker in your drawing at a position which you pick 

or at any coordinate location which you enter in the Command window.
•	 Other ways of defining a point can be accessed through the fly-out menu.
•	 By default the point style is a simple dot, but it can be changed any other using the point 

style dialogue box. (Try commands PDMODE & PDSIZE with different values)

•	 Tool Bar: Menu → Draw → Point
•	 Command: PO

6.8.2 line
•	 Creates straight line segments 
•	 It is used to draw lines continuously. It is possible to separately edit each line segment.
•	 To draw Horizontal and Vertical lines make Ortho ON.

•	 Tool Bar: Menu → Draw → Line  
•	 Command: L
•	 Specify first point: press ENTER to continue from the last drawn line or arc or specify a point.
•	 The different options are:

a. Continue: This helps to continue the line from the most recently drawn endpoint of 
the line.

b. Close: End the line segment at the beginning of the first line segment, which forms a 
closed loop of line segment.

c. Undo: Erases the most recent segment of a line sequence.

Example 6.1 Draw following shape with any dimensions
Solution

Fig. 6.7: Solution of example 6.1

Specify first point Specify next point

Angled Line

Specify next point

Next Point ENTER
Horizontal Line

Vertical Line

Specify next point
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1. Select the Line command.
2. Place the First endpoint anywhere in the drawing area.
3. Turn Ortho on by selecting the Ortho button or <F8>. (The “Ortho” button will change to 

a neon blue when on).
4. Move the cursor to the right and press the left mouse button to place the next endpoint. 

(The line should appear perfectly horizontal).
5. Move the cursor down and press the left mouse button to place the next endpoint. (The line 

should appear perfectly vertical).
6. Now turn Ortho off by selecting the Ortho button. (The “Ortho” button will change to gray 

when off).
7. Move the cursor up and to the right on an angle (the line should move freely now) and 

press the left mouse button to place the next endpoint.
8. Save the drawing as: Ex-1-Line (or any name)

6.8.3 Construction lines
•	 Creates an infinite line which passes through two picked points.
•	 Are very useful for creating construction frameworks or grids. 
•	 Construction lines are not normally used as objects in finished drawings. Therefore, it is 

usual to draw all your construction lines on a separate layer (section 6.13) which will be 
turned off or frozen prior to printing.

•	 Tool Bar: Menu → Draw → Construction  Line  
•	 Command: XLINE
•	 Specify a point or [Hor/Ver/Ang/Bisect/Offset]: Specify a point or enter an option.
•	 The different options are:

a. Hor: Creates a horizontal construction line. 
b. Ver: Creates a vertical construction line. 
c. Ang: Creates a construction line at a specified angle. 
d. Bisect: Create a construction line that bisects an angle defined by 3 points. 
e. Offset: Creates a construction line that is offset from an existing line by a specified distance. 

6.8.4 multiple lines
•	 Creates multiple parallel lines.
•	 Commonly used to create wall of any civil construction and Road in Top view.

•	 Tool Bar: Menu → Draw → Multiple Lines  
•	 Command: MLINE
•	 Specify start point or [Justification/Scale/Style] : Specify a point or enter an option.
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6.8.5 Polyline
•	 Create two-dimensional polylines.
•	 A polyline is very similar to a line. It is created in the same way a line is drawn. It requires 

first and second endpoints. But a polyline has additional features, as follows:
a. Polyline is one object, even though it may have many segments.
b. You may specify a specific width to each segment.
c. You may specify a different width to the start and end of a polyline segment.
d. In polyline you can switch from arc to line and vice versa.

•	 Tool Bar: Menu → Draw → Poly Lines
•	 Command: PLINE
•	 Specify start point :Specify point (1)
•	 Current line-width is <current>
•	 Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: Specify a point (2) or enter 

an option.
•	 The different options are:

a. Width: Specify the starting and ending width. You can create a tapered polyline by 
specifying different starting and ending widths.

b. Arc: This option allows you to create a circular polyline less than 360 degrees.
c. Close: The close option is the same as in the Line command. Close attaches the last 

segment to the first segment.
d. Length: This option allows you to draw a polyline at the same angle as the last polyline 

drawn. This option is very similar to the Offset command. You specify the first endpoint 
and the length. The new polyline will automatically be drawn at the same angle as the 
previous polyline.

6.8.6 Polygon
•	 Creates a polygon of any number of equal sides.
•	 Tool Bar: Menu → Draw → Polygon
•	 Command: POLYGON
•	 Enter number of sides <current> : Enter a value between 3 and 1024 and press ENTER.
•	 Specify center of polygon or [Edge]: Specify point of center
•	 Enter ‘c’ (Circumscribed about Circle).
•	 Specify the radius length. Specifying the radius with your pointing device determines the 

rotation and size of the polygon. Specifying the radius with a value draws the bottom edge     
of the polygon at the current snap rotation angle.

•	 The different options are:
a. Centre of Polygon: Defines the center of the polygon.
b. Inscribed in Circle: Indicates the radius of a circle on which all vertices of the polygon 

line fall.

 
P1 
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c. Circumscribe about circle: Indicates the distance from the centre of the polygon to the 
midpoints of the edges of the polygon.

d. Edge: Defines a polygon by specifying the endpoints of the first edge.

6.8.7 Rectangle
•	 Creates a Rectangle
•	 Tool Bar: Menu → Draw → Rectangle
•	 Command: RECTANGLE
•	 Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: Enter an option 

or specify a point (P1)
•	 Specify other corner point : Specify a point (P2)
•	 The different options are (Fig.6.8):

a. Chamfer: Creates a rectangle with chamfer by specifying chamfer distances
b. Fillet: Creates a filleted rectangle by specifying fillet radius
c. Width: Controls the line width of rectangle
d. Thickness: Controls thickness of rectangle
e. Elevation: For drawing a rectangle at the specified height from the XY plane

 P2 

P1 

P2 

P1 

P2 

P1 

Inscribed Pentagon Circumscribed Pentagon Edge Option

 P2 

P1 

Dist2 

Dist1 

 
P2 

Radius 

P1 

 

Width 

 

P1 

P2 

45o 

(a) Rectangle with Chamfer option (b) Rectangle with Fillet option

(c) Rectangle with width option (d) Rectangle with rotation option

Fig.6.8: Draw rectangle with different options
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6.8.8 Circle
•	 Creates a circle
•	 Tool Bar: Menu → Draw → Circle
•	 Command: CIRCLE
•	 Specify center point for circle or [3P/2P/Ttr(tan tan radius)] : provide a point on the screen 

or give coordinates of the point or enter an option
•	 The different options are:

a. Center, Radius: By defining the center point and radius of the circle
b. Two Point: By specifying the endpoints of circle diameter
c. Three Point: By specifying 3 points on the circle
d. Tangent, Tangent Radius: It draws a circle which is tangent to two objects (line, circle 

or arc) and with a specified radius.

Center, Radius
•	 Specify the center point for the circle by moving the cursor 

to the desired location in the drawing area  or provide the 
coordinates of center point (1)and click the left mouse button.

•	 Now as you move the cursor away from the center point, a 
circle will start forming.

•	 When the circle of desired size is visible (2), press the left 
mouse button, or you can type the radius, give value and 
then press ENTER.

Centre point and Diameter
Defines the diameter of the circle.

3P (Three Points)
To draw a circle when three points on 
circumference are selected.
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2P (Two Points)
To draw a circle when two endpoints of the 
diameter are selected.

Tan, Tan, Tan
To draw a circle tangent to three given objects.

Tan, Tan, Radius
To draw a circle with radius value and
tangent to two given objects.

6.8.9 arc
•	 Creates an arc. In AutoCAD an arc can be drawn in 11 distinct ways.
•	 The default method of drawing an arc is 3point method. Other options are:

a. Start, Center, End: Specify start point, center point and end point of arc
b. Start, Center, Angle: Specify start point, center point and included angle of arc
c. Start, Center, Length: Specify start point, center point and cord length
d. Start, End, Angle: Specify start point, end point and included angle
e. Start, End, Direction: Specify start point, end point and starting direction of arc
f. Start, End, Angle: Specify start point, end point and radius of arc
g. Center, Start, End: Specify center point, start point and end point of arc
h. Center, Start, Angle: Specify center point, start point and included angle of arc
i. Center, Start, Length: Specify center point, start point and cord length
j. Continue: Continue drawing an arc from a previously drawn arc
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•	 Tool Bar: Menu → Draw → Arc  
•	 Command: ARC

•	 The arc can be created using the Arc command and using any of the three specified values 
given below. Specify the value asked by the prompt then type the characters displayed in 
uppercase within brackets and then press ENTER key
a. Start point
b. Center point
c. End point
d. Radius
e. Included angle
f. Chord length
g. Direction at start point.

6.8.10  Donut
•	 Draws filled rings, annulus and circles.

•	 Tool Bar: Menu → Draw → Donut
•	 Command: DONUT
•	 Specify inside diameter of donut <current>: Specify a distance or press ENTER
•	 Specify outside diameter of donut <current>: Specify a distance or press ENTER
•	 Specify center diameter of donut <exit>: Specify a point by clicking on screen or providing 

coordinates or press ENTER/Esc to end the command.

Fig. 6.9: Different options to draw circle and arc in AutoCAD

Illustrative 
Example-1
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6.8.11 Spline
•	 Creates a quadratic of cubic spline (NURBS) curve

•	 Tool Bar: Menu → Draw → Spline  
•	 Command: SPLINE
•	 Specify first point or [Object]: Specify a point or enter ‘O’
•	 Depending on the method the first point can be the first fit point or the first control vertex.
•	 Specify next point: Specify/Click next point this will create additional spline segments until 

ENTER key is pressed.

6.8.12 Ellipse
•	 Creates an ellipse or an elliptical arc

•	 Tool Bar: Menu → Draw → Ellipse  
•	 Command: ELLIPSE
•	 There are 3 methods to draw an Ellipse (Fig. 6.9). Either specify 3 points of the axes or 

define the center point and the axis points or define an elliptical Arc.

Axis, End method
•	 Command: ELLIPSE
•	 Specify axis endpoint of ellipse [Acr/Center/Isocircle]: Specify/Click the primary point on 

the major or minor axis (P1). [Refer Fig.6.10(a)]
•	 Specify/Click other endpoint of the axis (P2)
•	 Specify distance to other axis or [Rotation]: Specify/Click third point (P3) perpendicular to 

the first axis.

Center method
•	 Command: ELLIPSE
•	 Specify center of ellipse: Specify/Click center of ellipse (P1) [Refer Fig.6.10(b)]
•	 Specify endpoint of axis: Specify/Click first axis endpoint (either axis) (P2)
•	 Specify distance to other axis or [Rotation]: Specify/Click third point (P3) perpendicular to 

the first axis.

Isocircle option
•	 In isometric view the appearance of a circle is like an ellipse. In AutoCAD it is called as 

isocircle and is useful for isometric view. 
•	 Set the snap style option of SNAP to isocircle and isometric snap on. Function key F5 can 

be used to obtain different shapes of an isocircle depending on the type of view (front, side 
and top).
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 P2 

P3 P1 

P1 

P3 

P2 

P2 P1 

P3 

Specifying Major axis first (P1/P2), 
then Minor axis (P3)

Specifying Minor axis first (P1/P2), 
then Major axis (P3)

Specify Center (P1) then P3 
and P2

Fig. 6.10: Different options to draw ellipse in AutoCAD

(a) Axis, End method (b) Center method

Example 6.2 Draw following shape with any dimensions.
Solution

1. Start a New file.
2. Draw the Circle using the Center / Radius option.
3. Using Object Snap draw the Circumscribed Polygon next. 
4. Locate the center of the Polygon at the center of the Circle using Center object snap and 

locate the radius of the Polygon on the Circle using Quadrant object snap.
5. Ortho <F8> on.
6. Use Object Snaps Midpoint and Endpoint to draw lines.
7. Complete the middle shape using line command and object tracking option on.
8. Save the drawing as: Ex-2

 Locate the Line using 
Midpoint Object Snap  

Circle and Polygon 
have same Center 
location  

Use Endpoint and 
intersection Object Snap  
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Example 6.3 Draw following shape with any dimensions.
Solution

1. Start a New file
2. To draw the given figure use Polygon, Ellipse and Donut commands as per instructions 

shown in the figure
3. Save the drawing as: Ex-3

6.8.13 Block
•	 Creates a block definition from objects you select.
•	 A Block is a cluster of objects that are converted into one object. The applications of the 

block command are drawing of a nut, bolt, rivet, gear tooth, transistor, bathroom fixture, 
window, screw, tree pipe fittings.

•	 First a Block must be created then it is inserted into the drawing. In terms of space inserted 
block uses less space than a set of objects.

Creating a Block
•	 To create a block, first you have to draw all the objects which will be converted into a Block
•	 Tool Bar: Menu → Draw → Block
•	 Command: BLOCK
•	 AutoCAD displays the Block Definition dialog box (Fig. 6.11).

1. Enter the New Block name in the Name box
2. Select the Pick point button (Or you may type the X, Y and Z coordinates). As you click 

on this button the Block Definition box will disappear and you will return temporarily 
to the drawing.

 
Snap Ellipse to Midpoint 
of Polygon side  

Snap center of Ellipse 
to the point using 
Node Object Snap  

Snap center of Donut to 
endpoint of Polygon 
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3. Choose the location for insertion point of the block. Usually this point is the Center, 
Midpoint or Endpoint of an object. On insertion of the block it is the insertion point 
to which the block gets attached.

4. Select one of the options:
a. Retain: After the block creation the original objects will remain on the screen.
b. Convert to block: After the block creation the original objects will disappear from the 

screen and instantly reappear as a block.
c. Delete: After the block creation the original objects will disappear from the screen.

5. After this the select objects button should be clicked. Now select the objects individually or 
by window options and then press ENTER.

6. The Block Definition box disappears and the control return temporarily to the drawing.
7. Select the OK button.
8. Now new block is created and stored in the drawing’s block definition table.

Inserting a Block
•	 A Block can be inserted at any location in the same or another drawing.   

 During insertion one can scale, rotate or explode the block.
•	 Select the Insert command through Ribbon or keyboard:

a. Ribbon → Insert Tab → Block Panel → Insert Block
b. Keyboard → INSERT then press ENTER

 

1 

2 

8 

5 

4 

Fig.6.11: Block definition dialog box in AutoCAD

Block creation
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•	 Insert Window will appear. Choose the desired block.
•	 Choose the location on screen to insert the block and press left mouse button.
•	 To insert block in another file save the block with WBLOCK command.

6.8.14 Hatch
•	 Fills a specified boundary using a suitable pattern. The hatching will be carried out inside 

a closed defined area.
•	 The type of pattern and pattern variables can be chosen from a library of patterns available.
•	 Tool Bar: Menu → Draw → Hatch
•	 Command: BHATCH
•	 Enter a pattern name or [?/Solid/User Defined] <current>: Enter a predefined or custom 

pattern name, enter an option or press ENTER key.
•	 This will display the Boundary Hatch and Fill dialog box (Fig. 6.12).
•	 The hatch dialogue box has two tabs Hatch and Gradient, click on the Hatch tab.
•	 Let the Type be pre-defined as default type.
•	 In the pattern combo box click arrow to select the type of pattern. More patterns will appear 

on clicking the three dots button on the right side. Hatch Pattern Palette dialog box is 
displayed. Choose a pattern from this dialog box and by clicking OK button you can come 
back to Hatch and Gradient dialogue box.

•	 The pattern selected is shown in a window below that combo box.
•	 In the Angle combo box let the Angle be zero and Scale as 1.0000.
•	 To select the boundary for hatching, you can use any one of the two buttons on right side;
•	 Add: Pick Points or Add: Select Objects.
•	 If you choose Pick Point option, the dialog box disappears and then you click anywhere in a 

closed boundary where hatching is required. Dashed lines will display the selected boundary.
•	 If you choose Select Object button you have to select all the objects forming a boundary by 

clicking on them one by one.
•	 Press ENTER key after the selections are made.
•	 Click Preview, the hatching is displayed.
•	 At this stage if you are not satisfied with the spacing and angle of the hatching lines then 

you can increase/decrease the scale and angle value. Again click Preview and if satisfied  
Press OK button.

•	 Instead of hatch you can fill colour in the enclosed area by clicking on Other predefined 
tab and then Solid. Click Gradient tab to shade an area in which the colour fades gradually 
in a chosen pattern.  
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Press this 
Arrow 

Fig. 6.12: Boundary Hatch and Fill dialog box in AutoCAD

6.8.15 Region
Creates a region of objects from a selection set of existing objects 

Define Regions
•	 Tool Bar: Menu → Draw → Region
•	 Command: REGION
•	 Select objects for creating the Region, these objects should form an enclosed area like a 

circle or a closed polygon.
•	 Press ENTER key. The Command prompt provides a message that indicates the number of 

loops detected and the number of regions created.

Define Regions with Boundaries
•	 Tool Bar: Menu → Draw → Boundary
•	 Command: BOUNDARY
•	 Boundary Creation dialog box will be displayed, select Region in the Object Type list.
•	 Click Pick Points.
•	 Click a point inside each closed area that you want to make as a region and press ENTER.
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6.9 moDIFYING CommaNDS

 

Lengthen 

Edit Polyline 

Set to Bylayer 

Break at Point 

Change Space 
Align 

Break 

Edit Hatch 

Erase 

Bring to front 

Edit Spline 
Offset 

Explod
e 

Copy Nested objects 

Edit Array 

Reverse Join 

Fig.6.13: Icons in Modify Panel/Toolbar/Pallet in AutoCAD 2020 main screen Ribbon

6.9.1 Erase
•	 Removes selected objects from a drawing
•	 Objects can be raised by three methods from the drawing 
•	 Tool Bar: Menu → Modify → Erase  
•	 Command: ERASE 

Method 1
•	 Click the Erase command and then select the objects.
•	 Select objects: Select the object to be erased individually or using window options.
•	 Select objects: Press ENTER. The selected objects will be deleted.

Method 2
•	 Select the object to be erased individually or using window options.
•	 Click the <Delete> key on the keyboard.

Method 3
•	 Select the object to be erased individually or using window options.
•	 Press the right mouse button.
•	 Select Erase from the Shortcut Menu using the left mouse button.

6.9.2 Copy 
•	 Creates duplicates of already created objects.
•	 The steps required are:
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a. Select the objects to be copied.
b. Select a base point.
c. Select a new location for the new copy.

•	 Tool Bar: Menu → Modify → Copy
•	 Command: COPY
•	 Select objects to be copied (for multiple selection press shift and select) and  press ENTER Key
•	 Specify base point or displacement, or [Multiple]: Choose a point for a single copy or enter 

‘m’ for multiple copies.
•	 Specify/Click a second point. The selected objects are copied to the new location.
•	 If the second point is very near to the base point  and  object snap is on then sometimes 

copy may not appear.  Press F3 to put the snap off and repeat COPY command.

Copy an Object using a Displacement
•	 Tool Bar: Menu → Modify → Copy
•	 Select the objects to copy and press ENTER.
•	 The displacement can be entered using Cartesian, polar, cylindrical or spherical coordinates.
•	 The @ sign should not be used as the software assumes it as relative coordinates.
•	 At the prompt for the second point, press ENTER.
•	 The selected objects will be copied to a new location based on the relative coordinate values 

entered.

6.9.3 mirror 
•	 Creates a mirror image copy of objects 
•	 Tool Bar: Menu → Modify → Mirror   
•	 Command: MIRROR  
•	 Select objects to mirror: Use an object selection method and press ENTER to finish
•	 Specify first point of mirror line: Specify a point (1)
•	 Specify second point of mirror line : Specify a point (2) (Fig. 6.14 and 6.15)
•	 To control mirroring of text when using the Mirror command do the following before the 

use of Mirror command:
a. Command Line: type mirrtext then press ENTER
b. If you want the text to mirror (reverse reading), type: 1 and ENTER
c. If you do not want the text to mirror, type: 0 and ENTER
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Fig. 6.14: Use of Mirror Command: Mirror Line 
Horizontal

6.9.4 offset 
•	 Duplicates	an	object	parallel	to	the	original	object	at	a	specified	distance.	You	can	offset	lines,	

arcs, circles, ellipses, 2D polylines and splines.

•	 Tool	Bar:	Menu	→	Modify	→	Offset	 	 	
•	 Command:	OFFSET	 	
•	 Specify	offset	distance	of	 [Through]	<current>	Specify	offset	distance	or	enter	 ‘t’	 (Through).

Offset distance option
•	 You can either enter a value or use the pointing device to determine a distance with two 

points. Press ENTER Key
•	 The point needs to be clicked/specified inside or outside of the original object to indicate 

the offset direction

Through option
•	 Specify/Click a point through which the offset object will pass.
•	 Select the object to offset and  press ENTER Key.

Original Object Single Offset Multi Offset

Fig. 6.15: Use of Mirror Command: Mirror Line at 
an Angle

 2nd end of 
Mirror line 

 1st end of 
Mirror line 

 Original 
Object 

 Mirrored 
Object 

 

 2nd end of 
Mirror line  

 1st end of 
Mirror line 

  

 
 

 Mirrored 
Object 

 

 



190  |  Engineer ing Graphics

6.9.5 array
This command facilitates you to create multiple copies in a Rectangular, Polar (Circular) fashion    
and even on a Path (Fig. 6.16).

•	 Tool	Bar:	Menu	→	Modify	→	Array	 	 	
•	 Command:	_ARRAY

Rectangular Array
In this option multiple copies (instances) of selected object(s) are arranged in a rectangular or matrix 
form with rows and column pattern. The user has to provide number of rows and columns followed 
by distance between the rows and distance between the columns. The copies are places at equal  
intervals and once the copies are made the user can edit any instance independently.

•	 Tool Bar: Menu → Modify → Array → Rectangular Array
•	 Command: ARRAY
•	 Select Objects: User has to select the object(s) to be arrayed individually one after another 

or using window selection methods. Press ENTER to stop.
•	 Enter the type of array [Rectangular/Polar]<current> Rectangular Array and press ENTER key.
•	 The Array Creation Tab appears (Fig.6.17) and a 3 x 4 default grid array of the object will 

be displayed on the screen.
•	 On this preview the spacing and number of rows and columns can be adjusted in following 

manner: 
Using first ► or ▲ symbols, the user can change the spacing between the columns or rows. 
Using last ► or ▲ symbols the user can change the total spacing between the base point, 
can add extra columns/rows and can change the axis angle.
Using ■ symbol the total row and column spacing and numbers can be changed simultaneously.
To move the complete array use the Base Point grip ■.

•	 Above changes in the array can also be made directly through Array Creation Tab.
•	 Number of rows (---): Provide a non-zero integer to represent the number of rows. For one 

row more than one column needs to be specified and vice versa. 

Fig. 6.16: Example of types of Array
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•	 Number of columns (|||): Specifies the number of columns.
•	 Distance between rows or specify unit cell: Specifies the distance between rows, including 

the length of the object to be arrayed. To add rows downward, specify a negative value for 
the distance between rows.

•	 Distance between columns (|||): Specifies the distance between columns. A negative distance 
value will add columns to the left.

•	 To display changes in the array press ENTER key.
•	 Click Close Array tab to finalize the array display.

Polar Array
•	 In this option multiple copies (instances) of selected object(s) are arranged in a circular fashion. 
•	 In this option the user has to select the object(s), provide center of the invisible (reference) 

circle on which the instances will be placed after circular arraying, number of instances, 
angle of fill or angle between each copy and angle to fill. User can also have option to rotate/
unrotate the instances after arraying.

•	 Tool Bar: Menu → Modify → Array → Polar Array
•	 Command: ARRAY
•	 Draw the object(s) to be arrayed and it is advisable to draw a circle also with dotted line 

for reference.
•	 Select the object(s) to be arrayed

 

No. of Rows No. of Column 

Original item 

Items 
arrayed 

End the end close Array dialog 
box 

Distance between Column Distance between Column 

Fig. 6.17: Rectangular Array Creation Tab
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 Enter angle to fill Number of Items in the array 

Circle  
(for reference only) 

Original item 

Items arrayed 

End the end close Array dialog 
box 

Fig. 6.18: Polar Array creation tab with 360o fill angle

Items rotated when Polar arrayed Items not rotated when Polar arrayed

Fig. 6.19: Polar Array Creation Tab with 225o fill angle
(a) Items rotated when Polar arrayed (b) Items not rotated when Polar arrayed
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•	 Select Objects: Select more objects or ENTER to stop.
•	 Enter the type of array [Rectangular/Polar]<current> Enter Polar Array and press ENTER key.
•	 Specify center point of array or [Base point / Axis of Rotation]: Specify/Click the center 

point of the reference (invisible) circle. It is always better to draw a circle for reference and 
choose the center of this circle.

•	 The Array Creation Tab appears with default polar array of 6 items (Fig. 6.18). Enter number 
of instances and enter angle between the instances and enter fill angle. If the number of 
instances are 12, angle between items are 300 and angle of fill is 3600 then the 12 items are 
evenly distributed within 3600 as shown in Fig.6.18. In another situation if the number of 
items are say 6, angle between items are 450 and angle of fill is 2250 then the 6 items are 
placed as shown in Fig.6.19.

•	 To display changes in the array press ENTER key.
•	 Click Close Array tab to finalize the array display.

6.9.6 move
•	 Displaces objects at a specified distance in a specified direction.
•	 Tool Bar: Menu → Modify → Move
•	 Command: MOVE
•	 Select objects: Select object(s) individually or using window selection methods and once 

over press ENTER key.
•	 Specify base point or displacement. Specify/Click a point (P1) (base point) (usually on the 

object).
•	 Specify second point of displacement or <use first point as displacement> Specify a point 

(P2) and press the left mouse button or press ENTER key (Fig.6.20)

Fig. 6.20: Move command

Rectangular 
and Polar array
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6.9.7 Rotate 
•	 Rotates objects about a base point (pivot point)
•	 After selecting the objects and the base point, you will enter the rotation angle from its 

current rotation angle or select a reference angle followed by the new angle.
•	 A positive rotation angle revolves the objects Counter-Clockwise and negative rotation angle 

revolves the objects Clockwise.
•	 Tool Bar: Menu → Modify → Rotate
•	 Command: ROTATE
•	 Select object(s) individually or using window selection methods and once over press ENTER 

key.
•	 Specify/Click a point about which the rotation will be done (base point)
•	 Specify rotation angle or [Reference]: Specify an angle, specify a point, or enter ‘r’
•	 Any of the following can be done:

a. Enter the angle of rotation.
b. Drag the object around its base point and specify a point location to which you want 

to rotate the object.
c. Enter ‘c’ to create a copy of the selected objects.
d. Enter ‘r’ to rotate the selected objects from a specified reference angle to an absolute angle.

•	 Reference: Specifies the absolute current rotation angle and desired new rotation angle. The 
Reference option can be used to align or straighten the object with other features in a drawing.

6.9.8 Scale 
•	 Enlarges or reduces selected objects equally in the X, Y and Z directions.
•	 Tool Bar: Menu → Modify → Scale
•	 Command: SCALE
•	 Select object(s) individually or using window selection methods and once over press ENTER 

key.
•	 Specify/Click a point about which the scaling will be done (base point)
•	 Specify scale factor or [Reference]: Specify a scale or press ENTER key
•	 Scale Factor: Multiples the dimensions of the selected objects by the specified scale. A scale 

factor greater than 1 enlarges the objects. A scale factor between 0 and 1 shrinks the objects.

6.9.9 Trim
•	 Trims objects at a cutting edge defined by other objects.
•	 Tool Bar: Menu → Modify → Trim
•	 Command: TRIM
•	 Select a cutting edge or edges and press ENTER key.
•	 Selects the object to be trimmed. The cutting edge can be any line, arc, circle, etc. The selected
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entities beyond the selected cutting edge are trimmed. The position of the selection decides the 
side to be trimmed. If two cutting edges are used then the entity between the two cutting edges 
is trimmed.

6.9.10 Extend
•	 Extend an object to meet another object

•	 Tool Bar: Menu → Modify → Extend
•	 Command: EXTEND
•	 Select boundary edges.
•	 Select objects: Use an object selection method and press ENTER when you finish
•	 Select object to extend or {Project/Edge/Undo]: Select an object or enter an option

6.9.11 Chamfer
•	 Bevels or chamfers the edges of two 2D objects or the adjacent faces of a 3D solid
•	 Tool Bar: Menu → Modify → Chamfer  
•	 Command: CHAMFER 
•	 Select first line or [Polyline/Distance/Angle/Trim/Method]
•	 Select the first of two objects or the first line segment of a 2D polyline to define the chamfer 

(Fig. 6.21).
•	 Select the second object or line segment of a 2D polyline to define the chamfer.
•	 Polyline: Inserts a chamfer line at each vertex of a 2D polyline where two straight line 

segments meet.
•	 Distance: Sets the chamfer distances 

from the intersecting points of the 
first and second objects.

•	 Angle: Sets the chamfer distance 
from the intersecting point of the 
selected objects and the XY angle 
from the first object or line segment.

•	 Trim: Controls whether the selected 
objects are trimmed to meet the 
endpoints of the chamfer line.

•	 Method: Controls how the chamfer 
line is calculated from the intersecting 
point of the selected objects or line 
segments.

Fig. 6.21: Chamfer command
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6.9.12 Fillet
•	 Rounds and fillets the edges of objects.
•	 The objects may or may not touch each other. If two parallel lines are selected, it will 

construct a full radius (Fig.6.22).
•	 Tool Bar: Menu → Modify → Fillet
•	 Command: FILLET
•	 Enter ‘r’ (Radius) at the command prompt.
•	 Enter a new fillet radius value.
•	 Once the fillet radius has been set, select the objects or line segments that define the points   

of tangency for the resulting arc or press ENTER to terminate the command.

6.9.13 Break
•	 Splits an object in two
•	 Tool Bar: Menu → Modify → Break
•	 Command: BREAK
•	 Select the object that user want to break.
•	 By default, the point at which you select the object is the first break point. To select a different 

pair of break points, enter ‘f’ (First) and specify the first break point.
•	 Click/specify the second break point.
•	 To break an object without creating a gap, enter @0,0 to specify the previous point.

 
 1st Object 

 
 Fillet  

 2nd Object 

 

 1st Object 

 

 2nd Object 

 
 1st Object 

 

 1st Object  

 Fillet  
 2nd Object 

Fig. 6.22: Fillet command
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6.9.14 Explode
•	 Breaks a compound object into its component objects

•	 Tool Bar: Menu → Modify → Explode
•	 Command: EXPLODE
•	 Select the objects to be exploded.
•	 Exploding has no visible effect for most of the objects.

6.10 CoNTRollING DRaWING DISPlaY

6.10.1 Redraw
•	 Refreshes the display in the current viewport.
•	 Removes temporary graphics left by VSLIDE and some operations from the current viewport.

To remove stray pixels, use the REGEN command.
•	 Tool Bar: Menu → View → Redraw
•	 Command: REDRAW

6.10.2 Regen
•	 REGEN command directs AutoCAD to re-generate the drawing  to update it. The command 

refines the drawing by smoothing out arcs and circles.
•	 Tool Bar: Menu → View → Regen
•	 Command: REGEN

6.10.3 Zoom
•	 The Zoom command is used to move closer to or farther away from an object. This is called 

Zooming In and Out. Zoom command is useful to work on minute details of a drawing.

•	 Tool Bar: Menu → View → Zoom
•	 Command: ZOOM

6.10.4 Pan
•	 Shifts the view any direction without changing the viewing direction or magnification.
•	 Position the cursor at the start location and press the left mouse button down. Drag the 

cursor to the new location. You can also press the mouse scroll wheel or middle button    
down and drag the cursor to pan.

•	 Tool Bar: Menu → View → Pan
•	 Command: PAN

Illustrative 
Example-2: 

Array
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6.11 TEXT aND DImENSIoNS

6.11.1 Text
•	 Words, messages and numbers can be inserted as required on an engineering drawing. The 

alphanumeric keyboard is used extensively for non-graphical input such as text. The text 
style, height, text angle, aspect ratio, colour, etc. are some of the attributes associated with 
text. These attributes can be changed as per requirements.

•	 Text is used to write tile blocks, write specifications, label parts on a drawing.
•	 Single line text helps to create one or more lines of text independently. Each line behaves 

as an independent object and can be moved, formatted or modified to select options on the 
shortcut menu, user should click right mouse button in the text box.

•	 Tool Bar: Menu → Annotation panel → Single Line Text
•	 Command: TEXT
•	 Specify the insertion point.
•	 On pressing ENTER the program creates  new text just below the last text object.
•	 If you press ENTER, the program inserts the new text immediately below the last text object 

you created, if any.
•	 Enter a height or click to specify the height of the text. If a specific text height is set in the 

current text style, this prompt is skipped.
•	 Enter an angle value or click to specify the rotation angle.
•	 Enter	 the	 text.	While	 typing,	 the	 text	may	be	displayed	horizontally	 and	at	 a	 legible	 size.

 

Text area box 

Drag to adjust Width 
and Height of the of 
paragraph 

Drag to adjust  
Width of paragraph 

Fig. 6.23: Text Editor contextual tab
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•	 To	create	 another	 single-line	 text,	do	one	of	 the	 following:
a. Press ENTER to start another line of text immediately below.
b. Click a location for the next text object.

•	 To	 terminate	 the	 command	press	ENTER	on	 the	blank	 line.

6.11.2 multiline Text
•	 Multiline text consists of any number of text lines or paragraphs that fit within a width you 

specify
•	 Tool Bar: Menu → Annotation panel→ Multiline Text
•	 Command: TEXT
•	 The width of the bounding box for multiline text objects can be defined by clicking or  

specifying opposite corners of the box.
•	 If the ribbon is active, the Text Editor contextual tab displays (Fig.6.23)

6.11.3 Dimensioning
Create linear dimensions with horizontal, vertical and aligned dimension lines. Create baseline or 
chained dimensions. Place dimension lines at an angle to the extension lines, or make extension     
lines oblique.

•	 Tool Bar: Annotate tab → Dimensions panel → Dimension
•	 Under dimensioning you have options like Linear, Aligned, Angular, Arc Length, Radius, 

Diameter, Ordinate, Jogged to dimension different entities.
•	 Command: DIM
•	 Select a line or specify the first and second extension line origin points.
•	 Move your pointing device to the desired position and orientation of the dimension.
•	 Before specifying the dimension line location, you can edit or rotate the text.
•	 Click to place the dimension line.
•	 Repeat steps to continue dimensioning or press ENTER to end dimensioning.
•	 Continued, baseline and ordinate dimensions can be created using the options in this 

command.
•	 To dimension isometric drawing use aligned dimensioning then through command line enter
•	 DIMED (DIMEDIT) command. Select obligue option, select object (dimension you want 

to convert to isometric style) press ENTER and enter obliquing angel 300 and 1500 as the 
case may be.

Create a Linear Dimension
•	 Tool Bar: Annotate tab → Dimensions panel → Linear
•	 Command: DIMLINEAR
•	 Specify the first and second extension line origin.
•	 At the prompt, enter ‘r’ (Rotated).
•	 Enter an angle for the dimension line and Click to place the dimension line (Fig.6.24).

Dimensioning
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Create a Continued or Chain Dimension
•	 Using this option, series of dimensions can be created in-line with an existing dimension. 

There is no need to specify the continue extension origin when this option is used just after 
Linear dimensioning command (Fig.6.25).

•	 Tool Bar: Annotate tab → Dimensions panel → Continue
•	 Command: DIMCONTINUE
•	 If prompted, select the dimension to continue. This prompt is skipped if the first extension 

line origin can be assumed from the origin of the second extension line of the last created 
linear or angular dimension.

•	 To specify the next extension line origin object snap should be used.
•	 To terminate the command press, ENTER twice.

Create a Baseline Dimension
•	 Through Baseline Dimensioning option user can setup a baseline for successive dimensions 

(Fig.6.26).
•	 Tool Bar: Annotate tab → Dimensions panel → Baseline
•	 Command: DIMBASELINE

Fig. 6.24: Linear Dimensioning

Fig. 6.25: Continue Dimensioning

   Angular Continue Dimensioning            Linear Continue Dimensioning
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•	 If prompted, select the base 
dimension. This prompt is skipped 
if the first extension line origin can 
be assumed from the last created 
linear or angular dimension.

•	 Use an object snap to select the 
second extension line origin,  or press  
ENTER to select any dimension as 
the base dimension.

•	 The second dimension line is placed 
by default at the distance mentioned 
in the Dimension Style Manager, 
Lines tab under the Baseline Spacing 
option.

•	 To specify the next extension line origin object snap should be used.
•	 As required go on selecting extension line origins.
•	 To terminate the command press ENTER twice.

Fig. 6.26: Baseline Dimensioning

Angular Baseline dimension 
Dimensioning

Linear Baseline 
dimension

6.12 laYERS
A Layer in AutoCAD is like a transparency on which a drawing is created. In a single drawing 
many layers can be used. This facility is very useful in all engineering disciplines e.g. in Mechanical 
Engineering drawings, component outline may be on one layer, hatching or sectioned views of the 
component may be on another layer, dimensioning may be on another layer, text and part list many   
be on next layer and so on.

Through this command you can create a new layer, delete a layer and rename layers, change their 
properties, set property overrides in layout viewports and add layer descriptions (Fig.6.27).

How to use Layers
•	 First choose a layer and then start drawing on it. It is advisable to draw similar nature 

objects on same layer. For example, in civil/architectural construction drawing, create a 
layer with name ‘Wall’, now make it current and then draw the floor plan on it. Similarly 
create another layer with name 'Electrical', make it current and draw the electrical objects/
wire diagram on it. Finally make third layer, name it Plumbing', make it current and draw 
hot/cold water pipe line layout, pipe fittings, bathroom fittings etc. on it. 

•	 In a drawing once layers are made then they can be controlled individually like visibility 
of objects, properties assignment such as color and linetype, text and dimensioning style, 
making it visible/invisible, editable/non editable, printable/non printable etc.

•	 When an object is drawn on a layer then by default it takes the property of that layer but 
if required then this can be override and properties of an individual object can be changed. 
Suppose, the colour of a layer is red and when any object is drawn on this layer it will 
automatically of red colour as the object’s color property is set to BYLAYER. But if the user 
wants to change the object colour to yellow then that can be done.

•	 Frozen option makes a layer invisible and Thaw makes it visible.
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Fig. 6.27: Layer Property Manager

Create a Layer
•	 Tool Bar: Home → Quick Access Toolbar → Layer  
•	 Command: LAYER
•	 In the layer property manager layers panel will be displayed.
•	 Click New Layer icon  
•	 This will add a layer name space in the layer list.
•	 Type a new layer name in the highlighted space.
•	 For complex drawings with many layers, enter descriptive text in the Description column.
•	 Specify the settings and default properties of the new layer by clicking in each column.

Select a Layer
•	 In the layer property manager layers panel will be displayed.
•	 Select the drop-down arrow. Highlight the desired layer and press the left mouse button.
•	 The selected layer becomes the 'current' layer. All objects will be created on this layer until 

you select a different layer.

Rename a Layer
•	 In	 the	Layer	Properties	Manager,	 click	 to	 select	 a	 layer.
•	 Click	 the	 layer	name	or	press	F2.
•	 Enter	 a	new	name.

Remove a Layer
•	 In the Layer Properties Manager, click to select a layer.
•	 Click Delete Layer .
•	 The	 following	 layers	 cannot	be	deleted:
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•	 Layers 0 and Defpoints
•	 Layers containing objects, including objects in block definitions
•	 The current layer
•	 Layers used in an external reference
•	 To remove all unused layers, use PURGE  

Status of a Layer
The following controls can be accessed using the Layer drop-down arrow.

•	 On or Off: A layer is visible if it is on otherwise invisible. User can edit or plot only those 
layers which are on.

•	 Freeze or Thaw: A frozen layer is invisible while a thawed layer is visible hence they are 
similar to on and off  with extra features like at the time of zooming in and out the frozen 
layers are not regenerated which saves computational time; thawed layers can be edited or 
plotted;  objects of frozen layer cannot be erased.

•	 Lock or Unlock: Locked layers are visible hence will be plotted but cannot be edited.

Modifying a Layer
Using layer properties manager you can modify a layer in following ways:

•	 Changing name of the Layer
•	 Changing Layer Colour
•	 Changing Line weight
•	 Changing Line type
•	 Making it editable/non-editable, printable/non-printable and visible/invisible

6.13 mETHoDS oF SElECTING oBJECTS
Many AutoCAD commands prompt you to “select objects”. This means select the objects that you 
want the command to effect. There are 3 methods.

Method 1
Pick is very easy and should be used if user wants to select 1 or few objects.
To select object(s) using this method just place the mouse cursor on the object without pressing it. 
This will highlight the object and indicates that the object is ready for selection. If it is the same 
object you intended to select click the left mouse button to finally select it otherwise, shift the mouse 
cursor towards left/right or top/bottom to highlight the desired object. This appearance change is 
called “Rollover Highlighting”. To select multiple objects just hover on the next object and click left 
mouse button and so on.

Method 2
Crossing. Select the object(s) by placing the mouse cursor on the top and towards right of the object(s), 
clicking the left mouse button and releasing  it (do not hold the button  in pressed condition) and 
then dragging it to diagonally opposite corner viz. below and towards left of the object(s) and again 
clicking left mouse button. A window with green shade and dotted boundary will be formed and 
anything inside this and crossed by this window will get selected. 

Use of layers
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Window. In this case just do opposite to previous case, that is, place the mouse cursor at the top 
and towards left of the object(s), click the left mouse button and release it (do not hold the button  
in pressed condition) and then drag it to diagonally opposite corner viz. down and towards right of 
the object(s) and again left click the mouse. A window with blue shade and solid boundary will be 
formed and anything inside this window get selected.

Method 3
Lasso Selection, is a little more difficult than Window Crossing Selection.
Place your cursor in the area up and to the right of the objects that you want to select (P1) then      
press and hold the left mouse button (Do not release the mouse button). Then move the cursor in       
an anticlockwise direction until you have crossed the objects you want to select (P2) then release the 
left mouse button. Only the objects that the Lasso Window crosses will be selected.

6.14 UNDo aND REDo
The Undo and Redo tools allow you to cancel out or to do again the previous activities in the drawing. 
Suppose, if an object is deleted by mistake, then the previous “erase” command can be undo and the 
object will reappear. Till closing of the drawing many time undo/redo can be attempted.

6.15 moDEl aND PaPER laYoUT
•	 There are two distinct working environments, called "model space" and "paper space," in 

which you can work with objects in a drawing.
a. By default, you start working in a limitless 3D drawing area called model space (In 

the book we are covering only 2D entities). You begin by deciding whether one unit 
represents one millimeter, one centimeter, one inch, one foot, or whatever unit is most 
convenient. You then draw at 1:1 scale.

b. To prepare your drawing for printing, switch to paper space. Here you can set up 
different layouts with title blocks and notes; and on each layout, you create layout 
viewports that display different views of model space. In the layout viewports, you scale 
the model space views relative to paper space. One unit in paper space represents the 
actual distance on a sheet of paper, either in millimeters or inches, depending on how 
you configure your page setup.

•	 Model space is accessible from the Model tab and paper space is accessible from the layout tabs.
•	 To activate Model space user has to click Model tab places in the lower-left corner of the 

main window (Fig.6.28).
•	 Depending on whether you are in Model Space or Paper Space, the tools in status bar change.
•	 If the Model and Layout tabs are hidden, set the LAYOUTTAB system variable to 1.
•	 By default, a Model tab and several named Layout tabs are displayed at the bottom-left 

corner of the drawing area. Click either MODEL or PAPER on the status bar at the bottom 
of the application window.
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Fig. 6.28: Model and Paper Space

6.16 PloTTING oF DRaWINGS
•	 Plot command gives instructions to a plotter/printer/file for printing of a drawing. 
•	 To print a drawing: Perform Zoom / All to center the drawing within the plot area.
•	 Tool Bar: Quick Access Toolbar → Plot
•	 Command: PLOT
•	 This opens a dialogue box having two pages, namely ‘Plot device and Plot Settings’.
•	 The plotter configuration or its equivalent has to be selected in the Plot Device page and 

the following options to be set in the Plot setting page:
•	 Page Size: A4 (210x297 mm) or A3 or etc. (As per the specifications of Printer)
•	 Units: mm
•	 Drawing Orientation: Portrait / Landscape
•	 Plot Area: In the Plot area tile, below 'What to plot: combo box', click the arrow. Four 

options are displayed: Display, Extents, Limits and Window. The meaning of each is     
as under:

a. Display option plots whatever is displayed on screen.
b. Extents option chooses the entire drawing even if it is outside the specified limits.
c. Limits option plots the drawing falling within specified limits set by LIMIT command.
d. Window option allows choosing a specified area within a window on the screen. The 

Window option is usually chosen. The dialog box disappears and you are guided to 
select the object(s) which you want to plot. Select the drawings by making a window 
across the object(s) by clicking on two diagonal corners. The dialog box appears again.

•	 Plot Scale: In the Plot scale tile, choose a scale. Alternately, you can also click the check 
box Fit to paper if you do not wish the drawing to be plotted on a particular scale. 
AutoCAD recalculates the scale and displays its new value. If you select Fit to paper 
option, Plot scale option will remain gray and you cannot choose.

•	 Centering the Plot: In the 'Plot offset' (origin set to printable area) tile, click in 'Center 
the plot' check box. The offsets in X and Y directions automatically are displayed. If  
you do not want the plot in the center, you can define your own values in the X: and     
Y: offset text boxes.

•	 Drawing Orientation: Click the arrow in the circle on the right bottom corner of 'Plot- 
Model dialog box'. The dialog box opens more options. In Drawing orientation tile, 
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click the radio button Portrait or Landscape. Portrait option keeps longer side of the 
drawing vertical while Landscape keeps longer side horizontal. Click Plot upside-Down 
check box if you want to invert the drawing by 180°

•	 Previewing and Plotting: After all above settings and before plotting, preview the drawing. 
At the bottom of the dialog box, click the Preview button. If satisfied, press ENTER key 
or OK button in the dialog box to get a print of the selected drawing, If not satisfied, 
change the settings.

6.17 EXITING aUToCaD
To close/exit AutoCAD software or to close file(s):
•	 Save all open drawings.
•	 Exit using one of the following:

a. Click Application Menu → Click   
b. Close file using right top corner cross symbol  

•	 If you want to close only current drawing then click application menu, go to close option and 
select 'current drawing'. If you select 'all drawing' option then all the currently open drawings 
will be closed. In both the cases ‘do you want to save the changes ?’ warning message will be 
displayed to remind to save the changes. The option Yes, No or Cancel has to be selected.

SolvED PRoBlEmS (WITH INCREaSING DIFFICUlTY lEvEl)
Example 6.4 Draw following figure in AutoCAD.

Fig. 6.29: Drawing for Example 6.4

Illustrative 
Example 3: 

Flywheel
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Solution
1. Open a new file and create three layers. Let the names be Layer 0, 1, 2 and 3. Specify the 

style for each layer.
2. On the Layers toolbar, click the arrow in the Settings combo box. Click on Layer 0.
3. Draw the outline using RECTANG, LINE, CIRCLE and ARC commands.
4. In the right panel of Layer Property Manager dialog box click on Layer 2.
5. Using OFFSET command draw the inner rectangle of top view. Draw dashed lines of Front 

view also. Notice that the linetype automatically is dashed and is in blue color.
6. In the right panel of Layer Property Manager dialog box click on Layer 3. Draw the center 

lines in both the views. Notice that the linetype automatically is Center and is in cyan color.
7. In the right panel of Layer Property Manager dialog box click on Layer 1.
8. Click on the DIMLINEAR icon. AutoCAD prompts for first extension line origin. Click on 

left corner of the bottom line of top view. Then specify second extension point as the other 
right extreme corner of the same line. Now move the cursor where you want the dimension  
to appear and click there. The dimension 200 appears in red color.

9. Repeat Step 8 for all horizontal and vertical lines.
10. Click on DIMDIAMETER icon. AutoCAD prompts to select an arc or circle. Click on the 

circle in the top view. Now move the cursor where you want the dimension and click.
11. Click on DIMRADIUS icon. AutoCAD prompts to select an arc or circle. Click on the arc 

in the front view. Move the cursor where you want the dimension and click.
12. Repeat Step 11 to dimension the fillets.
13. Save the file with name Ex6.4

Example 6.5 Draw profile of knuckle thread with a pitch of 20 mm as shown in Fig. Show at least 6 
threads.
Solution

1. Using ARC command draw only first 2 arcs of 2.5 mm radius anywhere on the screen.
2. Use ARRAY command. In the Array dialog box, click Rectangular option.
3. Click the Select objects button. The dialog box disappears and the drawing is displayed. 

Click on both the arcs.
4. Specify number for Rows as 1 and columns as 6 in the text boxes.
5. Specify Colum offset as 10. Value of Row offset has no effect here as the number of rows is 

only 1. Let the Angle of array be 0.

Fig. 6.30: Drawing for Example 6.5
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6. Click Preview button on lower right side of the dialog box and then press ENTER Key.
7. Five more thread profiles are copied. Total will be six including the original object.
8. Save the file with name Ex 6.5

Example 6.6 Draw six squares at equal angles between them of 12 mm sides on a pitch circle diameter 
as 120 mm as shown in following figure.
Solution

1. Use LINE command to draw horizontal line O-P of 60 mm length.
2. Use RECTANG command to draw square. For one corner use From object snap. Click at 

point P for base point. Specify Offset 
distance as (@)-6,-6 (Point A from 
point P). Press F3 to put object snap 
Off. For the other corner C specify 
relative coordinates as @12,12. Press 
F3 again to put snap ON.

3. Use ARRAY command. In the Array 
dialog box, click Polar option.

4. Click the Select objects button. Click 
on the square.

5. Click a button against Center point 
Click on the left end of line at the 
point O as center of array.

6. Choose the option “Total number of 
items and angle to fill”.

7. Specify total Number of items as 6.
8. Specify Angle to fill as 360°.
9. Click the check box in Rotate items as they are copied. A tick sign appears. If it is already 

there, ignore this step.
10. Click Preview button on lower right side of the dialog box and then press ENTER Key.
11. Five more squares are copied around the center point. Total will be six including the original 

object.
12. Repeat steps 3 to 9 but at step 8 let the Rotate items as they are copied check box remain 

unchecked. See the effect that all the squares remain horizontal.
13. Save the file with name Ex 6.6

In this unit you have learned about:
1. Commands under Draw and Modify Tool bars.
2. Simple, direct distance entry, absolute & relative coordinate system.
3. Circle (centre-radius-diameter, 2point, 3point, tan-tan-tan-radius).
4. Ellipse (center-axis-end) & Ellipse arc.

A

O
D C

B
P

Fig. 6.31: Drawing for Example 6.6

UNIT SUmmaRY
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5. Rectangle, Dimension style manager.
6. Polygon (Inscribed in circle& circumscribed about circle& edge)
7. Polyline & Pedit.
8. Arc, Spline, Solid, Donut.
9. Fillet, Chamfer, Rotate Scale, Stretch, and  Join.
10. Move, Copy, Zoom, Pan, Offset, Extend, Trim.
11. Mirror, Mirror text, Break, Trim, Erase, Undo, Redo.
12. Function keys and setting.
13. Text (T -Multiple & Dt- single line text & change).
14. Array (rectangular & polar).
15. Block (making & inserting, Attributed definition, dynamic block editor).
16. Point, mpoint, ddptype, Divide, Measure, hatching, gradient, editing, linetype, Ltscale.
17. Template, setting of units, Explode.
18. Layer (making layer & setting), layer tools properly, grip (options), status.

a. multiple Choice questions
6.1 1. Commands given in AutoCAD appear

(a) in the drawing area  (b) on the toolbar of commands
(c) at the command line  (d) at the status line

6.2 Ortho, Snap, Grid, etc. are displayed on the
(a) object snap toolbar  (b) view toolbar
(c) right hand side menu  (d) status bar

6.3 Snap is turned on or off using function key
(a) F4  (b) F6
(c) F7  (d) F9

6.4 Function key F8 is used to toggle
(a) Coordinate display  (b) Grid display  (c) Status bar   (d) Ortho

6.5 Object snap is used to increase
(a) speed, accuracy and ease of drafting (b) speed of drawing
(c) accuracy while drafting    (d) memory utilization

6.6 In 2 point option of CIRCLE command, the two points to be defined are
(a) center and a point on periphery (b) two diametrically opposite points on periphery
(c) any two points on periphery  (d) two diametrically opposite points on a horizontal line

6.7 The Direction option in ARC command is the direction of a
(a) tangential line at the end point 

EXERCISES



210  |  Engineer ing Graphics

(b) tangential line at the start point
(c) radial line between the center and start point 
(d) radial line between the center point and end point

6.8 Rotation option in ELLIPSE command draws an ellipse whose
(a) major axis is oriented by the specified rotation angle
(b) minor axis is oriented by the specified rotation angle
(c) major axis remains in the direction specified by the end points
(d) major/minor axis ratio becomes equal to sine of the rotation angle

6.9 COPY command allows to make
(a) only one copy of a single entity at a time  (b) many copies of many objects
(c) one or many copies of one or many objects  (d) many copies of only one entity

6.10  MIRROR command is used to make
(a) a copy of an object
(b) a mirror copy of an object with or without original object
(c) a mirror copy of an object only about X axis
(d) a mirror copy of an object without original object

6.11  OFFSET command at a time allows offsetting an object
(a) only on one side of object at a fixed distance
(b) on both sides of object at a fixed distance
(c) only on one side of object at a variable distance
(d) on both sides of object at a variable distance

6.12  Rotation angle in TEXT command
(a) inclines the lines of the text by a specified angle
(b) inclines each character by that angle but the line remains horizontal
(c) rotates the text in the form of circular arc
(d) displays the text upside down

6.13  The command to edit text is
(a) TEXT   (b) DDEDIT
(c) ETEXT   (d) MTEXT

6.14  Which of the following options will print the complete drawing
(a) Display   (b) Extents
(c) Limits   (d) Window

6.15  The size of the printout
(a) remains the same as in the drawing   (b) can be increased only while plotting
(c) can be decreased only while plotting   (d) be increased or decreased while plotting

6.16  Insertion base point of a block
(a) should be on the block   (b) can be anywhere on the block or away from the block
(c) has to be at its base   (d) has to be on a flat surface
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6.17  The gap between two adjacent objects in a rectangular array
(a) has to be more than the size of object
(b) can be less or more than the size of object
(c) should be at least 1.5 times the object
(d) depends upon many parameters

6.18  ARRAY with polar option is applicable for objects
(a) which are drawn using polar coordinates
(b) where at least one entity of object is drawn using polar coordinates
(c) where at least two entities of object are drawn using polar coordinates
(d) drawn by any method of coordinates system

6.19  If a block is to be used in another drawing file, the command to save the block is
(a) INSERT  (b) BLOCK  (c) WBLOCK    (d) MINSERT

6.20  WBLOCK command allows to create a file from
(a) a block      (b) selected objects      (c) complete drawing file    (d) any one of above

B. Subjective questions
6.1 Describe the use of LIMITS command.
6.2 Describe the use of Snap and Grid.
6.3 Explain the use of Object Snap. Discuss the different modes of operation.
6.4 List the icons on the Draw Toolbar and discuss any five icons for drawing entities.
6.5 Give the command sequence to make an equilateral triangle using three lines.
6.6 Write any 3 options to draw a circle.
6.7 Describe the method to draw an arc.
6.8 Write steps to draw a polygon with given center and an edge length.
6.9 Explain the difference between Window and Crossing window while selecting an object.
6.10 Explain the difference between COPY and MOVE command? Explain by examples.
6.11 Explain the use of EXPLODE command.
6.12 Explain the utility of SCALE command. Can you have different scales in X and Y directions 

while using this command?
6.13 Write steps to use a CHAMFER command to specify different chamfer distances for each 

side command with zero radius.
6.14 Describe the use of FILLET command. How do you change the fillet radius. What is the 

effect of using this command with zero radius?

answers of multiple Choice questions

6.1 (c); 6.2 (d); 6.3 (d); 6.4 (d); 6.5 (a); 6.6 (b); 6.7 (b); 6.8 (c); 6.9 (c); 6.10 (b); 6.11 (a); 
6.12 (a); 6.13 (b); 6.14 (b); 6.15 (d); 6.16 (b); 6.17 (b); 6.18 (d); 6.19 (c); 6.20 (d)
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As per curriculum the practicals related to Unit-6 are:
1. Draw basic 2D entities like: Rectangle, Rhombus, Polygon using AutoCAD (Print out should 

be a part of progressive assessment).
2. Draw basic 2D entities like: Circles and Arcs using AutoCAD (Printout should be a part of 

progressive assessment).
3. Draw basic 2D entities like: Circular and rectangular array using AutoCAD (Printout should 

be a part of progressive assessment).
4. Draw blocks of 2D entities comprises of Rectangle, Rhombus, Polygon, Circles, Arcs, circular 

and rectangular array, blocks using AutoCAD (Print out should be a part of progressive 
assessment).

5. Draw basic branch specific components in 2D using AutoCAD (Print out should be a part    
of term work).

6. Draw complex branch specific components in 2D using AutoCAD (Print should be a part    
of progressive assessment).

PRaCTICalS



Computer Aided Draft ing |  213 

Practical-1 Draw Rectangle, Rhombus, Polygon using autoCaD

Practical statement
Draw basic 2D entities like Rectangle, Rhombus, Polygon using AutoCAD.

Practical significance
Usually complex digital drawings are created by combining and modifying several different basic 
primitive shapes, such as lines, circles, arcs, polygons etc.

Relevant theory
Refer Section 6.9.2 (Draw Line)
Refer Section 6.9.6 (Draw Polygon)
Refer Section 6.9.7 (Draw Rectangle)
Refer Section 6.12 (Text and Dimension)

Practical outcomes (PrO)
The practical outcomes are derived from the curriculum of this course:

PrO1: Use Draw tool bar commands of AutoCAD to create basic 2D entities. 
PrO2: Dimension the given 2D entity using AutoCAD
PrO3: Write text on the given 2D entity using AutoCAD

Practical setup (Drawing/Sketch/Circuit Diagram/Work Situation)

Resources Required

 

b 

a 

a a 

a=100 mm and b=300 mm

Sr. 
No

Suggested Resources 
required

machines/Tools/ 
Instruments with vital 

specifications

qty

actual Resources used 
machines/Tools/Instruments with 

broad specifications
(to be filled by the student)

Remarks 
(if any)

1
AutoCAD 2020 

software Student Edition
1

User

AutoCAD 2020 
software student 

edition
1 User

Or any 
Licensed 
version of 
AutoCAD
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Precautions
1. Save the drawing at regular interval to avoid data loss.
2. When not in use shut down the computer system.
3. Use Antivirus software in the computer system

Suggested Procedure
Preliminary Steps:

•	 It is presumed in this book that AutoCAD software is installed on the computer and the 
user has a basic knowledge of computers.

•	 Make the computer system ON.
•	 Click the AutoCAD icon on the desktop or 
•	 Click the START button at the lower left corner of the screen, followed by PROGRAM and 

then clicking AutoCAD 2020 in the list. Wait for few seconds to get the software completely 
launched and till the main AutoCAD software window is displayed on the screen.

•	 Open New drawing with institute specific template.
•	 Set limits to 230 mm x 310 mm (A4 size).
•	 Set units to metric.
•	 Make grid ON and Snap ON with snap setting at 5mm.

To draw Rectangle in AutoCAD:
1. Tool Bar: Menu → Draw → Rectangle    
2. Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: Enter an option or 

specify a point (P1) anywhere on the screen.
3. Specify other corner point : Specify a point (P2) as per given sides ‘a’ and ‘b’.
4. Dimensioning of the rectangle:
5. Tool Bar: Annotate tab → Dimensions panel → Linear    
6. Specify the first and second extension line origin.
7. Click to place the dimension line on the width of the rectangle.
8. Repeat step 10 to 12 to place dimension on length side of the rectangle.
9. Save the drawing as: Pr-12.

To draw Rhombus in AutoCAD:
1. Tool Bar: Menu → Draw → Rectangle    
2. Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: Enter an option 

or specify a point (P1) anywhere on the screen with sufficient distance from the previously 
drawn entity.

2

Computer System PC/
Laptop loaded with 

Window and Anti-Virus 
software

1
As per 
section 
5.4.1
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3. Specify other corner point : Specify a point (P2) just vertically below then P1 such that 
distance between P1 and P2 is a√2.

4. The output is a Rhombus.
5. Dimensioning the Rhombus:
6. Tool Bar: Annotate tab → Dimensions panel → Aligned    
7. Specify the first and second extension line origin.
8. Click to place the dimension line on any one side of the Rhombus.
9. Save the drawing..

To draw Polygon in AutoCAD: Say a Pentagon:

1. Tool Bar: Menu → Draw → Polygon    
2. Click first point on the screen with sufficient distance from the previously drawn entities.
3. Enter number of sides <current> : 100 mm and  press. ENTER. 
4. Specify center of polygon or [Edge]: edge and press ENTER.
5. Specify edge length as 50 and press ENTER. 
6. Pentagon completed
7. Dimensioning of the Pentagon.
8. Tool Bar: Annotate tab → Dimensions panel → Aligned    
9. Specify the first and second extension line origin.
10. Click to place the dimension line on any one side of the Pentagon.
11. Write the text on all the three entities using the procedure outlined in 6.12.1
12. Save the drawing.

Observations

Figure: AutoCAD Drawings of Rectangle, Rhombus, Polygon

Practical related questions
1. Can we draw these figures using line command ? How?
2. If circumscribed circle radius ‘r’ is given how a pentagon of ‘a’ side will be drawn?

 

RECTANGLE RHOMBUS PENTAGON 

100 300 

100 
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Suggested Learning Resources
Refer Unit-6

Suggested Assessment Scheme
(to be filled by teacher)
The given performance indicators should serve as a guideline for assessment regarding process and 
product related marks.

Performance indicators Weightage/
marks

marks 
awarded

Process related: 10 marks* (66%)

1
Setting parameters for new drawing and using 
institute specific template

2

2
Type of command (s) used to create the 
desired drawing

2

3
Ease of using keyboard and mouse to create 
the drawing

2

4 Time taken 2

5 Response to practical viva questions 2

Product related: 5 marks* (33%)

6 Dimensional accuracy of the output 3

7 Dimensioning and text writing 2

Total 100%

* Marks and percentage weightages for product and process assessment will be decided by the teacher.

Name of the Student: ……………………………………….. 
marks awarded

Signature of Teacher 
with date

Process Related Product Related Total
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Practical-2 Draw Circles and arcs using autoCaD

Practical statement
Draw basic 2D entities like Circles and Arcs using AutoCAD.

Practical significance
Usually complex digital drawings are created by combining and modifying several different basic 
primitive shapes, such as lines, circles, arcs, polygons etc.

Relevant theory
Refer Section 6.9.8 (Draw Circle)
Refer Section 6.9.9 (Draw Arc)
Refer Section 6.12 (Text and Dimension)

Practical outcomes (PrO)
The practical outcomes are derived from the curriculum of this course:

PrO1: Use Draw tool bar commands of AutoCAD to create basic 2D entities.
PrO2: Dimension the given 2D entity using AutoCAD
PrO3: Write text on the given 2D entity using AutoCAD

Practical setup (Drawing/Sketch/Circuit Diagram/Work Situation)

Resources required
Same as mentioned in Practical-1 of Unit-6.

Precautions
Same as mentioned in Practical-1 of Unit-6.

Suggested procedure
Preliminary Steps: Same as mentioned in Practical-1 of Unit-6.
To draw Circle in AutoCAD: with Center-Radius option

1. Follow the procedure for drawing a circle with center and radius option as detailed out in 

 

50 R 

(100,100) 

(50,50) 

B A 

C 

All dimensions are in mm and in case of Arc the included angle ABC is 75o



218  |  Engineer ing Graphics

section 6.9.8 with coordinates of center point as (50, 50) and radius 50 mm given in this 
practical.

2. Dimensioning the Circle:
3. Tool Bar: Annotate tab → Dimensions panel → linear → Radius
4. Select the circle and positions the dimension.
5. Save the drawing as: Pr-13.

To draw Arc in AutoCAD: with Center-Start-Angle option
1. Tool Bar: Menu → Draw → Arc    
2. Specify center point of the arc: specify point at (0,100)
3. Specify start point of the Arc: specify point at (100,100)
4. Specify included angle: 75. 
5. Arc completed
6. Dimensioning of the Arc:
7. Tool Bar: Annotate tab → Dimensions panel → Radius  
8. Select the Arc and positions the dimension.
9. Write the text on the two entities using the procedure outlined in 6.12.1
10.  Save the drawing.

Observations

Practical related questions
1. Can we draw given Arc using Center-Start-Radius option? How?
2. What are the other ways of drawing a circle in AutoCAD?

Suggested learning resources
Refer Unit-6

Suggested assessment scheme
Same as mentioned in Practical-1 of Unit-6.

 

(100,100) 

50 R 
50 R 

(50,50) 

B A 

C 

CIRCLE ARC 
AutoCAD Drawings of Circle and Arc
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Practical-3 Draw Circular and Rectangular array using autoCaD

Practical statement
Draw basic 2D entities like: Circular and rectangular array using AutoCAD.

Practical significance
Polar and Rectangular arrays are required to develop complex digital drawings of components with 
repeated pattern like placement of rivets in riveted joint; circular/square/rectangular perforations in 
computer cabinets/motor cases; different treads on screw/nut/not/screw jack/lead screw etc.; window 
patterns; holes on the periphery of circular plates/flanges/ buttons on key board, regular shaped pattern 
on various house hold/industrial components.

Relevant theory
Refer Section 6.10.5 (Polar and Rectangular Arrays) Refer Section 6.12 (Text and Dimension)

Practical outcomes (PrO)
The practical outcomes are derived from the curriculum of this course:

PrO1: Use Draw tool bar commands of AutoCAD to create Polar and Rectangular arrays.
PrO2: Dimension the given 2D entity using AutoCAD
PrO3: Write text on the given 2D entity using AutoCAD

Practical setup (Drawing/Sketch/Circuit Diagram/Work Situation)

Polar array: Fill angle 3600; Number of items in array: 12; Included angle: 750

Rectangular array: Column: 5; Column distance: 20mm; Row:4; Row distance: 15mm

 

35mm 
Line length 
75 mm 

Polygon 
side  

12 mm 

20mm 

5mm 
12 mm

Resources required
Same as mentioned in Practical-1 of Unit-6.

Precautions
Same as mentioned in Practical-1 of Unit-6.
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Suggested procedure
Preliminary Steps: Same as mentioned in Practical-1 of Unit-6.

To draw Polar array:

Draw a line of 75 mm length using line command:
1. Click line command.
2. Specify first point: 100,150.
3. Click next point: @0,75 and pres Esc from keyboard.
4. Line completed.

Draw a polygon with radius 12mm and 3 sides:
1. Enter number of sides:3
2. Specify center point or [edge]:top end point of previously drawn line.
3. Specify radius of circumcircle:12
4. Polygon completed.

Polar array:
1. Select the Polar Array command: Home Tab → Modify Panel → Array
2. Select Polar Array.
3. Select Objects: select the object to be arrayed (Polygon).
4. Select Objects: select more objects or <Enter> to stop.
5. Specify center point of array or [Base point / Axis of Rotation]: select lower end point of 

the line.
6. The Array Creation Tab appears and the default polar array with 6 items is displayed.
7. Enter items: 12
8. Enter Fill: 360
9. Press <Enter> to display the selections.
10. Select Close Array if display is correct.
11. Polar Array completed.
12. Dimensioning the Array: side of the polygon, length of the line and included angle between 

two polygons.
13. Save the drawing as: Pr-14a.

Repeat the same procedure with different values:
1. Make a copy of line and polygon and place it at reasonable distance from previous polar 

array on the screen.
2. Repeat the steps 9 to 14
3. Enter items: 6
4. Enter Between: 45
5. Enter Fill: 360
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6. Select Close Array if display is correct.
7. New Polar array completed.
8. Save the drawing.

To draw Rectangular array:
Draw square of size 5mm side

1. Start a new drawing with same parameters.
2. Click Rectangle command
3. Specify first point: specify point at (35,20)
4. Specify second point[Area/Dimensions/Rotations]: enter d press ENTER
5. Specify length for rectangle: 5
6. Specify width for rectangle: 5
7. Rectangle completed

Rectangular array:
1. Select the Rectangular Array command: Home Tab → Modify Panel → Array
2. Select Rectangular Array.
3. Select Objects: select the object to be arrayed (Square) and press ENTER.
4. The Array Creation Tab appears with a 3 row and 4 column default rectangular array.
5. Enter Columns: 5
6. Between distance: 20
7. Enter Rows: 4
8. Between distance: 15
9. Press <Enter> to display the selections.
10. Rectangular Array completed.
11. Dimensioning the Array: side of the original square, Column distance, Row distance, 

horizontal and vertical distance of one corner of the original square from UCS.
12. Save the drawing as P-14b.
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Observations

Practical related questions
1. Can we select more than 1 entity for array? How?
2. Can we edit array after its creation? How?

Suggested learning resources
Refer Unit-6

Suggested assessment scheme
Same as mentioned in Practical-1 of Unit-6.

  

20mm 35mm 

20mm 

15mm 

5mm 
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Practical-4 Draw Blocks of 2D Entities using autoCaD

Practical statement
Draw blocks of 2D entities comprises of Rectangle, Rhombus, Polygon, Circles, Arcs, circular and 
rectangular array, blocks using AutoCAD

Practical significance
Blocks are used to use same entity or combination of 2D entities several times. Generally, in cases 
where same subassembly or components are used again and again with same or different orientation/ 
scale then those entity or group entities are converted into block and saved with a name/identification 
so that whenever required can be inserted to save time and efforts. For example, various types of nut- 
bolts, bearings, gears, bets, sprockets, screws, chairs, doors, windows, resistors, capacitors, battery etc.

Relevant theory
Refer Section 6.9 and 6.10 (Draw and Modify Tool bars)
Refer Section 6.9.13 (Blocks)
Refer Section 6.10.5 (Polar and Rectangular Arrays)
Refer Section 6.12 (Text and Dimension)

Practical outcomes (PrO)
The practical outcomes are derived from the curriculum of this course:

PrO1: Use Draw tool bar commands of AutoCAD to create Polar and Rectangular arrays.
PrO2: Dimension the given 2D entity using AutoCAD
PrO3: Write text on the given 2D entity using AutoCAD

Practical setup (Drawing/Sketch/Circuit Diagram/Work Situation)
•	 Draw objects as shown in Fig.(A)
•	 Draw a Polar Array to create a Block as depicted in Fig.(B)
•	 Polar array parameters: Fill angle 3600 and number of items in array is 8.
•	 Draw a Rectangular array as depicted in Fig.(B)
•	 Rectangular array parameters: Column: 4; Column distance: 40mm; Row:4; Row distance: 

30mm

 

(A) OBJECTS 

8mm 

5D 

 

(B) POLAR ARRAY CONVERTED TO BLOCK  
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Resources required
Same as mentioned in Practical-1 of Unit-6.

Precautions
Same as mentioned in Practical-1 of Unit-6.

Suggested procedure
Preliminary Steps: Same as mentioned in Practical-1 of Unit-6.
Draw the Circle

1. Click circle command.
2. Specify center: 80, 80.
3. Enter radius: 2.5
4. Circle completed.

Draw the Rectangle
1. Click Rectangle command
2. Specify first point: specify point at (50,50)
3. Specify second point[Area/Dimensions/Rotations]: enter d press ENTER
4. Specify length for rectangle: 180
5. Specify width for rectangle: 150
6. Rectangle completed

Draw the elliptical slot:
1. Click line command
2. Specify first point: specify point at (78,85)

(C) RECTANGULAR ARRAY
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3. Specify second point: @0,8
4. Click offset command
5. Select object and press enter
6. Specify offset distance: 4
7. Specify side: Right side
8. Click fillet command
9. Click fillet command
10. Enter fillet radius: 2
11. Select first object: select first line on the upper side.
12. Select second object: select second line on the upper side.
13. Full fillet will be created.
14. Repeat fillet command for lower side of the two line also.
15. Elliptical slot is completed.

Draw the Polar array:
1. Select the Polar Array command: Home Tab → Modify Panel → Array
2. Select Polar Array.
3. Select Objects: select the object to be arrayed (elliptical slot).
4. Select Objects: select more objects or <Enter> to stop.
5. Specify center point of array or [Base point / Axis of Rotation]: select center of the circle.
6. The Array Creation Tab appears and the default polar array with 6 items is displayed.
7. Enter items: 8
8. Enter Fill: 360
9. Press <Enter> to display the  selections.
10. Select Close Array if display is correct.
11. Polar Array completed.
12. Save the drawing.

Create Block of the Polar array.
1. Click Menu → Draw → Block
2. AutoCAD displays the Block Definition dialog box (Fig. 6.11).
3. Enter the New Block name in the Name box: xyz
4. Select the Pick point button. The Block Definition box will disappear and you will return 

temporarily to the drawing.
5. Select the insertion point for the Block: select the center of the circle.
6. Select convert to block. Click the Select objects button.
7. The Block Definition box will disappear and you will return temporarily to the drawing.
8. Select the objects: middle circle and eight elliptical slots, then press ENTER.
9. Select the OK button.
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10. The new block is now stored in the drawing’s block definition table.
11. Block created.
12. Save the drawing.

Draw Rectangular array:
1. Select the Rectangular Array command: Home Tab → Modify Panel → Array
2. Select Rectangular Array.
3. Select Objects: select the complete block.
4. The Array Creation Tab appears with a 3 row and 4 column default rectangular array.
5. Enter Columns: 4
6. Between distance: 40
7. Enter Rows: 4
8. Between distance: 30
9. Press <Enter> to display the selections.
10. Rectangular Array completed.
11. Save the drawing.

Observations
Output drawing as shown in Fig(C)

Practical related questions
1. Can we select more than 1 entity for array? How?
2. Can we edit array after its creation? How?

Suggested learning resources
Refer Unit-6

Suggested assessment scheme
Same as mentioned in Practical-1 of Unit-6.
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Practical-5 Draw Basic Branch Specific Components in 2D using autoCaD

Practical statement
Draw basic branch specific 2D components like Nut in Mechanical and other engineering disciplines
using AutoCAD.

Practical significance
Usually digital drawings of simple Mechanical components, Electrical components, Computer and 
Electronics components, chemical and process components are created by combining and modifying 
several different basic primitive shapes, such as lines, circles, arcs, polygons etc.

Relevant theory
Refer Section 6.9 (Draw Tool bar)
Refer Section 6.10 (Modify Tool bar)
Refer Section 6.12 (Text and Dimension)

Practical outcomes (PrO)
The practical outcomes are derived from the curriculum of this course:

PrO1: Use Draw and Modify tool bar commands of AutoCAD to create simple components 
related to various engineering disciplines.

Practical Setup (Drawing/Sketch/Circuit Diagram/Work Situation)

Resources required
Same as mentioned in Practical-1 of Unit-6.

Precautions
Same as mentioned in Practical-1 of Unit-6.
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Suggested procedure
Preliminary Steps: Same as mentioned in Practical-1 of Unit-6.

To draw Rectangle in AutoCAD:
1. Start with Top view of the given Nut.
2. Draw horizontal line A-B of 15-mm length from the origin (50,50) using LINE command.
3. At its midpoint draw two circles of 5 mm and 7.5 mm radius using CIRCLE command.
4. With same center draw a hexagon with circumscribed option and radius 7.5 mm using 

POLYGON command.
5. Top view of Nut completed.
6. To draw Front view set ORTHO ON by pressing F8 and copy line A-B, vertically above at 

a suitable height as line C-D (the base line of front view).
7. Draw line E-F using OFFSET command: specify offset distance 10, select object to offset as 

line C-D and for side click above line C-D.
8. Draw vertical center line from point G with the help of MID object snap.
9. Draw vertical lines from the corners of the hexagon up to line E-F.
10. Use TRIM command to delete the vertical lines below the line C-D.
11. Draw a circle with 2P option. Specify first point as point G and other @0, –30 (Radius 15 

mm, hence diameter 30).
12. Use TRIM command to delete the circle outside the points H and I.
13. Draw horizontal lines H-K passing through the points H and I and then line H-J.
14. The distance between points H and J is 4.28. It can be found either by dimensioning or by 

DIST command.
15. Use OFFSET command to get vertical lines from point L and M. Specify offset distance as 

2.14 (half of 4.28).
16. Using ARC command with 3 points option, draw arcs J-L-H and I-M-K.
17. Use TRIM command to remove vertical lines between horizontal lines E-F and J-K.
18. Draw inclined line of any length, say 5 mm, and angle 30° at point J and angle 150° at point K.
19. Use FILLET command with 0 radius to fillet the inclined lines and the top horizontal line L-M.
20. Use DDLTYPE command to load center line.
21. Click Modify on Menu bar and choose Modify to change the center lines from continuous 

lines to center lines. Save the drawing as P-16.
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Observations

Practical related questions
1. What is the diameter of Nut?
2. Write the relations between diameter and height/ width of a standard Nut.

Suggested learning resources
Refer Unit-6

Suggested assessment scheme
Same as mentioned in Practical-1 of Unit-6.
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Practical-6 Draw Complex Branch Specific Components in 2D using 
autoCaD

Practical statement
Draw complex branch specific 2D components like Square Thread Lead Screw of Lath in Mechanical 
and other engineering disciplines using AutoCAD.

Practical significance
Usually digital drawings of complex Mechanical components, Electrical components, Computer and 
Electronics components, chemical and process components are created by combining and modifying 
several different basic primitive shapes, such as lines, circles, arcs, polygons etc.

Relevant theory
Refer Section 6.9 (Draw Tool bar)
Refer Section6.10 (Modify Tool bar)
Refer Section 6.12 (Text and Dimension)

Practical outcomes (PrO)
The practical outcomes are derived from the curriculum of this course:

PrO1: Use Draw and Modify tool bar commands of AutoCAD to create simple components    
     related to various engineering disciplines.

Practical Setup (Drawing/Sketch/Circuit Diagram/Work Situation)
Draw square threads with core diameter 40 mm, nominal  dia 60  mm  and  the pitch  20 mm and  
eight threads as shown in Fig.

Resources required
Same as mentioned in Practical-1 of Unit-6.

Precautions
Same as mentioned in Practical-1 of Unit-6.
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Suggested procedure
Preliminary Steps: Same as mentioned in Practical-1 of Unit-6.
To draw Rectangle in AutoCAD:

1. Draw vertical line 1-2 of 100 mm length 
using LINE command. Draw lines 3-4 
and 5-6 with offset distance 10 mm using 
LINE command as shown in the adjoining 
figure.

2. Join points 2-6 and 1-5 using LINE 
command. Using OFFSET command with 
offset 10 draw lines 7-8 and 9-10.

3. Draw the center line in the middle of the 
lines.

4. Join point 2 to 3 and 4 to 5 to get inclined 
lines 2-3 and 4-5.

5. Use MIRROR command: select object to 
mirror line 2-3 and mirror axis as line 1-2 
to get line 2-11. Similarly use MIRROR 
command to mirror line 4-5 with mirror 
axis as 5-6 to get line 5-12.
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6. Use EXTEND and TRIM commands to 
trim lines 2-11 and 5-12 to get lines 2-13 
and 5-14 respectively.

7. Copy line 2-13 at point 1 to get point 17. 
Copy small horizontal line from point 9 
up to inclined line and paste it from upper 
inclined line to get point 18.

8. Draw lines from points 7 to 15 and 10 to 
16.

9. Delete all the unwanted lines and leave 
only the lines as shown in adjoining figure. 
Set the line weight of these lines as 0.5 by 
Modify-Properties.

10. Use ARRAY command. Select all objects for array as shown in step 9 by making a window 
across them. Specify number for Rows as 1 and columns as 8 in the text boxes. Specify 
Column offset as 20. Let the Angle of array be 0.

11. Click Preview button on lower right side of the dialog box and then press Enter Key.
12. Save the drawing as P-17.
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Observation

Practical related questions
1. Is it possible to create only upper half portion of the object shown in step 9 and then use 

MIRROR/COPY/SYMMETRY commands(s) to get the full object shown in step 9? How?

Suggested learning resources
Refer Unit-6

Suggested assessment scheme
Same as mentioned in Practical-1 of Unit-6.

KNoW moRE

•	 Teacher should download the command reference guide of AutoCAD 2020.
•	 During the input sessions the teacher must give examples related to the relevant branch viz. 

Mechanical and allied disciplines/ Electrical and allied disciplines/Electronics etc.
•	 Teacher should demonstrate all above commands through AutoCAD software and guide 

students in Hands-on sessions.
•	 Show video/animation films to explain mentioned concepts.
•	 Guide student(s) in preparing Institute Template drawing work.
•	 Use videos/spoken tutorials to teach AutoCAD software.
•	 Teachers should ask students to use url/qr codes available in the book for further 

understanding/practicing of the concepts.
•	 Teacher should take more sessions on commands like Block, Layers, Text writing, 

Dimensioning, Array and Hatching.
•	 Teacher must know 3D modeling also using AutoCAD 2020.
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applications (Real life / Industrial)
1. Usually digital drawings are created by combining and modifying several different basic 

primitive shapes, such as lines, circles, and arcs detailed out in this unit to create more 
complex engineering disciplined based shapes like gears, springs, joints, couplings, armature, 
nut-bolts, bearings, sprockets, cams, rotors, turbine/compressor blades, pumps, motors, IC 
engine parts, automobile components, medical instruments, mechanical components, plastic 
components, electronic components, house hold items, artifacts, etc. AutoCAD is widely  
used design and drafting software to create these digital drawings in almost all industries.

2. Digital Production drawings are used in mechanical and allied industries from a very small 
component to a big assembly.

3. Digital drawings are also used as construction drawings by civil engineers and architects  
for houses, buildings, hospitals, hotels, malls, airports, overhead tanks, bridges, roads etc.

4. Digital electrical and electronics drawings are used for electrical machines, transformers, 
drives, actuators, insulators, circuits, circuit bords, electrical and electronic components, 
computer cabinets, computer monitor cases, keybord-mouse drawings, pannels, electronic 
hardware etc.

5. Digital drawings are also used in piping, textile, oil and refinery and food processing industries 
by chemical engineers, pharma engineers and process engineers etc.

Inquisitiveness and Curiosity
1. As engineering graphics is a skill oriented course and requires continuous practice to 

understand and develop competence on use of various commands and techniques mentioned 
in the unit, therefore, students are advised to draw and practice little complex 2D geometry 
of industrial components to horn the skills further. Pick any component of your engineering 
discipline and try it out in AutoCAD using mentioned steps.

2. Students should collect Production drawings, Building Drawings, Layouts from nearby 
workshops/industries/builders/contractors and should attempt to redraw the same using 
AutoCAD software using commands mentioned in this unit.

Design Innovative Practical / Projects / activities
Student shall form a group of 5 - 6 students and undertake one or two micro project(s) /activity(ies) 
under the guidance of faculty and present it as group with individual participation as well. A sample 
list is given below:
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1. Develop Drawing Template of your institute with following dimensions and details.

 

A1/A2 Drawing Sheet size 

20 mm 

20 mm 

20 mm 

Drawing Area 

Title Block (150 x 50) 

Border 

Institute Drawing Template

 

Date: 

Projection: 

Institute 
Logo 

Institute Name: 

Sheet No: 

Title: 

Class: 

Roll No.: 

Name: 

Description : 

Title Block with institute Logo
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2. Draw following view of a typical Connecting rod.
 For dimensions in mm please refer same figure on cover page of the book.

REFERENCES & SUGGESTED REaDINGS

1. Machine Design Includes AutoCAD Second Edition, Ajeet Singh, Tata McGraw Hill Education 
Private Limited, New Delhi, 2018.

2. AutoCAD 2020: A Problem-Solving Approach, Basic and Intermediate, 26th Edition, Sham 
Tickoo, CADCIM Technologies, 2019.

3. AutoCAD 2013, Command Reference Guide, Autodesk Inc.
4. AutoCAD Shortcuts Guide, Autodesk Inc.
5. Autodesk knowledge network, tutorials, documentation, downloads, troubleshooting articles, 

https://knowledge.autodesk.com/support



APPENDICES

APPENDIX-A: Records for Practical

Sl 
No

Page No Name of the 
Experiment

Date Marks Signature
Actual Repeat Record

1 Draw horizontal, Vertical, 
30 degree, 45 degree, 
60 and 75 degrees lines, 
different types of lines, 
dimensioning styles using 
Tee and Set squares/ 
drafter. 

2 Write alphabets and 
numerical (Vertical only) 

3 Draw regular geometric 
constructions and redraw 
the given figure Part I

4 Draw regular geometric 
construction and redraw the 
given figure Part II

5 Draw a problem on 
orthographic projections 
using first angle method 
of projection having plain 
surfaces and slanting. 

6 Draw another problem on 
orthographic projections 
using first angle method of 
projection having slanting 
surfaces with slots. 

7 Draw two problems on 
orthographic projections 
using first angle method 
of projection having 
cylindrical surfaces, ribs.

8 Draw two problems on 
isometric view of simple 
objects having plain and 
slanting surface by using 
natural scale.
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9 Draw some problems 
on isometric projection 
of simple objects having 
cylindrical surface by using 
isometric scale. 

10 Draw free hand sketches/ 
conventional representation 
of machine elements in 
sketch book such as thread 
profiles, nuts, bolts, studs, 
set screws, washers, locking 
arrangements.

11 Problem based Learning: 
Given the orthographic 
views of at least three 
objects with few missing 
lines, the student will try to 
imagine the corresponding 
objects, complete the views 
and draw these views in 
sketch book. 

12 Draw basic 2D entities 
like: Rectangle, Rhombus, 
Polygon using AutoCAD.

13 Draw basic 2D entities like: 
Circles, Arcs, circular using 
AutoCAD.

14 Draw basic 2D entities like: 
Circular and rectangular 
array using AutoCAD.

15 Draw blocks of 2D entities 
comprises of Rectangle, 
Rhombus, Polygon, 
Circles, Arcs, circular and 
rectangular array, blocks 
using AutoCAD.

16 Draw basic branch specific 
components in 2D using 
AutoCAD.

17 Draw complex branch 
specific components in 2D 
using AutoCAD.



ANNEXURES

Annexure-I General and Specific Instructions when working in the 
Drawing hall/ Computer aided drafting software lab

General Instructions

1. It is a fact that the objective of the practical sessions is learning and also a verification of 
the knowledge that you have gathered. The practical are designed in such a way so as to 
support and reinforce the concepts learned in theory.

2. By doing the practical with your own interest only it is possible to be familiar with all the 
fine points and to expose you to drawing instruments and computer aided drafting software. 

3. Always perform the practical with an attitude of learning and with your interest to verify 
the theoretical knowledge that you have gathered.

4. Be very particular to arrive in time in the drawing hall/laboratory and always with proper 
preparation with a clear knowledge about the practical.

Specific Instructions

1. When working in the drawing hall to prepare drawings as per list of practical and assignment 
it is mandatory to come with drawing sheet, sketch book, pencils, eraser, sharpener, napkin,  
and all required drawing instruments as listed in the corresponding practical. 

2. The completed work on the drawing sheet or in sketch book has to be shown to your teacher/
instructor before leaving the drawing hall.

3. All the students have to maintain individual copy of the completed drawing sheets/sketch book.
4. Dimensioning and other annotations activities should always be done with proper units for 

each drawing practice problem.
5. Try to use drawing sheet in optimum manner by proper planning of space required for 

each practice problem and use both sides of the drawing sheet to complete the assigned 
practice problems.

6. During the working hours in the practical sessions you are supposed to fully utilize the 
duration and do not leave the drawing hall before the completion of the working hours. 
If you finish early, you may spend the remaining time to complete similar extra practice 
problems in the drawing sheet/sketch book.   

7. In case of practical related to computer aided drafting software lab, save the work done at 
regular interval and shut down the computer properly after the completion of practical. Save 
the completed work on pen drive or email or submit it to the digital submission box/drive.

8. Try to practice more drawing problems to horn the skills.



REFERENCES FOR FURTHER LEARNING

Lists of some of the books are given below which may be used for further learning of the subject 
(both theory and practical) by the interested students:

1. Bureau of Indian Standards, Engineering Drawing Practice for Schools and Colleges IS: SP-
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Packt Publishing, 1st edition, 2020.

14. B.V.R. Gupta, M. Raja Roy, Engineering Drawing With AutoCAD, Third Edition, Dreamtech 
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to AutoCAD (R) 2015, I K International Publishing House Pvt. Ltd, 2015.
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CO AND PO ATTAINMENT TABLE

Course outcomes (COs) for this course can be mapped with the programme outcomes (POs) after 
the completion of the course and a correlation can be made for the attainment of POs to analyze 
the gap. After proper analysis of the gap in the attainment of POs necessary measures can be taken 
to overcome the gaps.

Table for CO and PO attainment

The data filled in the above table can be used for gap analysis.

Course
Outcome

Attainment of Programme Outcomes
(1- Weak Correlation; 2- Medium correlation; 3- Strong Correlation)

PO-1 PO-2 PO-3 PO-4 PO-5 PO-6 PO-7

CO-1

CO-2

CO-3

CO-4

CO-5

CO-6
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